


I
I WAS IN Boston, in a Mac store, buying myself a
Macbook. At approximately the same time, not
very far away, Steve Jobs pulled out the world’s
slimmest laptop from an envelope and revealed it
to the world. 

The reason I was out shopping for a new laptop
was because I was tired of lugging my aging Lenovo
around, and my shoulders were pleading for some
respite. Apart from just looking cool, the smallest
laptops are just extremely convenient.

While out shopping, I was quite taken by the
Sony Vaio TZ series and the ASUS Eee. I remem-
bered what Agent001 told me before I left: “There
is only that much you can fit into this space, you
know.” Just a few days later, the guys at Apple
seemed to disagree, and packed in so much more
into so much less! 

However, while most of the world ooh-ed and
aah-ed over the Air’s design elements, a select few
shook their heads in disgust.  A tech savvy Ryer-
sons student said, “How could Apple have for-
gotten to add mobile broadband to it? I have no
real reason to trade in my Macbook. It makes the
whole Air thing pointless.”

Other power users are miffed about the inbuilt
battery. “I can’t even pack an extra battery for long-
haul flights back to India,” says Anita Sharma, a stu-
dent of Massachusetts Institute of Technology.  The
claimed five hour battery backup with WiFi turned
on is something that remains to be seen.

Another enthusiast said, “Stuff like this is
meant for the connected. There is a lack of func-
tionality here. The product seems to be a proto-
type, what with no 3G functionalities built in.”

Now, I am not the kind of user who goes by
looks alone. I need  functionality—Firewire, Eth-
ernet, replaceable battery, etc. The choice was
obvious for me: rather than spending USD 1,799
on a cool looking Air, I decided to get myself a
normal Macbook. 

With Steve Jobs himself admitting that the Air
lacked features, not much is left to be said in this
matter. However, I can’t help but wonder what the

future holds for the Air. Will the killer looks of the
Air impress the masses and silence its critics, or
will the lack of functionality be its undoing?

What I find curious is that despite knowing all
they knew, and saying all they said, when I asked
the dissenters whether they’d get the Air if I just
gave them $1,800, most said “Sure!”
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more—and it’s about time you got your official
site up and running. What, where, how? Here’s
a simple walk-through of what you need to do

Smart Business
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to this story: firstly, you can get an insight
into who visits your site and when and so
on; but second, you need to be able to use
that information. Here’s about Web
Analytics
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and how they’ll lead to a more secure future. So
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including a pair of headphones touted as the
world’s best!
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Any two semi-techies can
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whether Windows or Linux
is better, though most
agree that the latter is
more secure. So, well,
which is better, and if
Linux is more secure, why?
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DIGIT FEBRUARY 2008 For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the subject. If the subject is not
mentioned, your mail might not reach the right person.

MOVIES
Steal This Film II

These are strange times indeed. While they
continue to command so much attention in
the mainstream media, the ‘battles’
between old and new modes of
distribution, between the pirate and the
institution of copyright, seem to many of
us already lost and won. We know who the
victors are. Why then say any more?

THEMES
Vista Themes
Vista Theme For Windows XP. This theme
pack includes two VistaVG Themes: VistaVG
Ultimate & VistaVG Blue. Both of these
were created by Digit Forum member and
Microsoft MVP—Vishal Gupta.

TRAILERS
SimCity Societies ‘Evolution’
Trailer

This trailer for SimCity Societies shows how
you will have the freedom to build the city
of your choice. A giant range of options
and ideas are available, all the power is in
your hands.

GTA IV—Trailer III—Move Up
Ladies
Rockstar has released the third official
trailer to the much anticipated, and
delayed, Grand Theft Auto IV. The trailer,
titled “Move Up, Ladies”, comes in the
satisfying and detailed HD variety and
showcases much of the storyline and
action players should expect from the
new title.

Duke Nukem Forever Teaser
Trailer
As promised, 3D Realms has released a
teaser trailer from Duke Nukem Forever

MULTIMEDIA
Soundbase 2008.01.01

Soundbase was created to fill a gap in the
large amount of free and commercial
players/taggers. We do not pretend to
have the ultimate audio solution, but
Soundbase will most likely fit somewhere
into your playing or tagging experience—it
will always give you a quick way of doing
common tasks.

Jajuk
Do you love music? Do you need a place
to get your collection together? Are you

interested in getting an
advanced jukebox FREE!

Try Jajuk, it is a Java
technology-enabled
music organizer for all
platforms. It can organize

the largest, most scattered
music collections and was

designed to be intuitive and fast.

� Adobe Photoshop CS3 for
Windows 10.0.1 Update

� foobar2000 0.9.5 Final
� GenieTexter 0.83
� Xilisoft Video Converter
� CDrtfe 1.3 Final
� 3D Canvas 7.1.1.2
� PhotoFiltre Studio 9.1.0
� Songbird 0.4

SYSTEM
Bootzilla 4.2.0
BootZilla is a toolkit designed with the
intent of creating a simple toolkit that can

help the computer user or technician in
removing pesky virus and malware
infections. It can also help in the diagnosis
of severe hardware failure, such as
memory or hard drive failures. The entire
toolkit offers a BootCD functionality, built
up off of the Ultimate Boot CD.

� Google Desktop for Windows
5.7.712.18632

� EasyBoot 5.1.0.566
� Fresh UI 7.98
� System Explorer 1.2.1.540
� The 2007 Microsoft Office Suite Service

Pack 1
� Magical Glass 2.0.0.2 Beta
� Kaspersky Internet Security 8.0.0.148

Beta

INTERNET
WordPress (2.3.2)
WordPress started in 2003 with a single

bit of code to enhance
the typography of

everyday writing and
with fewer users
than you can count
on your fingers and

toes. Since then it
has grown to be the

largest self-hosted
blogging tool in the world, used on
hundreds of thousands of sites and seen
by tens of millions of people every day.

Transfz 1.15 Beta

Transfz (pronounced transfuse) is a
integrated search agent in the form of a
context menu that allows the user to
launch online searches from any
document or application on both the
desktop and the web. Supports powerful
extensions: Search and Replace, UPPER
case, HTML insert..etc. Use the build-in

Plugin Creator to easily allow your
favorite search engine to become a
omnipresent standard in your
desktop/web experience. Finally, Transfz
also contains a clipboard list of the last
5-30 items copied.

� Halite 0.3 RC
� IE7pro 2.0 Beta 5
� Spiceworks IT Desktop
� Chyrp 1.0.3
� save2pc 3.23
� FlashGot 0.7.2
� Cabos 0.7.6

LINUX STUFF
� Damn Small Linux 4.2.2
� OLPC updates for Fedora 8
� Desktop-Multiplier-Ubuntu.zip
� Pingus v0.7.2

WORDPRESS PLUGINS
� Yahoo! Shortcuts 0.962
� Google XML Sitemaps 3.0.3
� Akismet 2.1.3
� All in One SEO Pack 1.4.3.9
� WordPress.com Stats 1.1.1
� NextGEN Gallery 0.74
� Subscribe to Comments 2.1.2
� WP-Cache 2.1.2
� WPG2 3.0.2
� WP-Polls 2.21
� IM Online 4.4
� Dashboard Editor 0.2
� Real WYSIWYG 0.0.2
� Ultimate Tag Warrior 3
� Exec-PHP 4.3
� PXS Mail Form 2.6
� Extended Live Archive 0.10beta R18
� Lightbox 2.0
� WP-Forum 1.7.4
� fQuick v. 1.2
� flickrRSS 3.2
� Get Recent Comments 2.0.2
� wpPaginate 2.2
� WP-Notable 1.15
� AdSense-Deluxe 0.8
� PodPress 8.8
� Related Posts 2.04
� WordPress Mobile Edition
� Landing sites 1.3
� Custom Query String 2.6
� WP-EMail 2.20

FREE
Sauerbraten: Assassin Edition

Sauerbraten is now available for
download, allowing you to play this free
multiplayer/singleplayer first person
shooter, built as a major redesign of the
Cube FPS. Much like the original Cube,
the aim of this game is not necessarily to
produce the most features & eyecandy
possible, but rather to allow
map/geometry editing to be done
dynamically in-game, to create fun
gameplay and an elegant engine.

FlightGear v1.0
“With FlightGear it is possible to choose
between three primary Flight Dynamics
Models. It is possible to add new
dynamics models or even interface to
external “”proprietary”” flight dynamics
models:JSBSim: JSBSim is a generic,

6DoF flight dynamics model for
simulating the motion of flight vehicles.
It is written in C++. JSBSim can be run in
a standalone mode for batch runs, or it
can be the driver for a larger simulation
program that includes a visuals
subsystem (such as FlightGear.) In both
cases, aircraft are modeled in an XML
configuration file, where the mass
properties, aerodynamic and flight
control properties are all defined.”

DEMOS
The Witcher
Set in a world created by best-selling
Polish author Andrzej Sapkowski, The
Witcher combines spectacular action and
an intriguing storyline. You are a
Witcher, a warrior who has been trained
to fight since childhood, subjected to
mutations and trials that have
transformed you. You earn a living killing
monsters, and are a member of a
brotherhood founded long ago to protect
people from werewolves, the undead,
and a host of other beasts.

PERSONAL
OpenJudis RTI

A free database of Right To
Information Act cases, created by
Digit reader Prashant Iyengar.

DEVELOPERS
VirtualBox 1.5.4

InnoTek VirtualBox is a general-
purpose full virtualizer for x86
hardware. Targeted at server,
desktop and embedded use, it is
now the only professional-quality
virtualization solution that is also
Open Source Software. Not only is
VirtualBox an extremely feature
rich, high performance product for
enterprise customers, it is also the
only professional solution that is
freely available as Open Source
Software under the terms of the
GNU Public License (GPL). Presently,
VirtualBox runs on Windows and
Linux 32-bit hosts and supports a
large number of guest operating
systems including but not limited to
Windows (NT 4.0, 2000, XP, Server
2003, Vista), DOS/Windows 3.x,
Linux (2.4 and 2.6), and OpenBSD.

� VMware Player 2.0.2

� Java SE Development Kit (JDK) for
Windows 7 Build b24

� Notepad++ 4.7
� Android SDK

Productivity

Entertainment

Tools

GamingF
8,700 MB Of Quality Content!

DUAL LAYER

FREE
Vivid Conceptions

Vivid Conceptions is a platform game
unlike anything you’ve seen before. In
it, you play the role of the last surviving
Bantam, a creature that predated even
the dinosaurs but was almost invisible
to the naked eye. It’s your job to
journey across the underground in
search of the last refuge on the planet...

MULTIMEDIA
emTube
emTube is an
application for
Symbian S60 3rd
edition phones that
allows you to:
Search and browse
videos on YouTube.
Download selected
videos onto your

phone. Stream FlashVideo files directly
from YouTube. Play local FlashVideo
files.

PhotoFiltre
6.3.0
PhotoFiltre is a
complete image
retouching
program. It allows

you to do simple or advanced
adjustments to an image and apply a
vast range of filters on it. It is simple
and intuitive to use, and has an easy
learning curve. The toolbar, giving you
access to the standard filters with just a
few clicks, gives it a robust look.

� Mp3tag 2.39l Beta
� WinUAE 1.4.5

SYSTEM
TestDisk for Windows 6.9
Beta

TestDisk is a powerful free data recovery
software. It was primarily designed to
help recover lost partitions and/or make
non-booting disks bootable again when

these symptoms are caused by faulty
software, certain types of viruses or
human error (such as accidentally
deleting your Partition Table).
� NVIDIA BIOS Editor (NiBiTor) 3.7
� 7-Zip 4.57
� Locate 3.0.7.12310 Beta
� SpeedFan 4.34 Beta 37
� System Explorer 1.2.1.540
� Vista4Experts 1.0.0.1

LINUX APPS
XMIND 2008 Pro
XMIND, with a clean and kind interface,
is a revolutionary Mind
Mapping/Brainstorming software tool.
XMIND 2008 Pro enables users to work
efficient and carry out various ideas
easily by the revolutionary way they
capture and manage information.
� Avidemux 2.4 Final
� Flock 0.9.1.2
� Phatch 0.0.bzr157
� Tibia 8.00

DEVELOPERS
FreeBASIC for Windows
0.18.3b
FreeBASIC is an open source, 32-bit
BASIC compiler with the syntax the
most compatible possible with MS-
QuickBASIC that adds new features
such as pointers, unsigned data types,
inline-assembly and many others.

Nullsoft Install System
(NSIS) 2.34
Nullsoft Install System (NSIS) is a small,
efficient, capable installation system
for win32. It is completely free and
open source.
� AgPad 0.1
MinGW-5.1.3

PERSONAL
BrowseControl
BrowseControl is an easy-to-use
Internet management software that can
readily be utilized by non-technical
users. BrowseControl can totally deny
access to the Internet.

ArchiveIT 1.0.7
ArchiveIT is an application used for
scanning and archiving documents—
stored in subject-based folders or
binders which correspond to traditional
archives. E-archive is far more secure,
less effected by the consequences of
chance events and finding documents is
much easier.

Recipe4win 1.1
Recipe4win lets you navigate through
thousands of recipes from the
Recipe4all.com database with a neat
interface. It allows you to search
recipes by keywords, by ingredients, or
by geography. Recipe4win also has
direct access to the glossary. With a
single click you can see the same recipe
or listing in your default web browser.

� Back2zip
� Baraha 7.0 Build 6
� DAEMON Tools 4.10
� HTML Optimizer
� Jabref for Windows 2.3.1
� JustZIPit
� My Pictures 3D Album ver. 0.96
� Outclass v1.2.4.1
� PinNotes 1.2
� Polyglot 3000 2.8
� PopFile 0.22.5
� wikidPad 1.9 Beta 13

PRODUCTIVITY

TOOLS

GAMING

Fedora 8 DVD
Fedora is a Linux-based
operating system that
showcases the latest in
free and open source
software. Fedora is always
free for anyone to use, modify, and
distribute. It is built by people across
the globe who work together as a
community: the Fedora Project. The
Fedora Project is open and anyone is
welcome to join. Boot from this DVD
to begin installing Fedora. The folder
contains the ISO for the Fedora
Rescue CD.

Movie
of the
Month

GAMING

BROWSERS
� Firefox
� Flock 1.0
� Internet Explorer 7
� Maxthon 2.0
� SeaMonkey 1.1.7

DOWNLOAD MANAGERS
� Download Accelerator Plus
� FlashGet
� Orbit Downloader 2.5.1
� Retriever Download Manager

1.08
� Internet Download Manager

FILE SHARING
� Azureus
� BitComet 0.97
� BitTorrent 6.0
� BitTyrant
� eMule Plus 1.2b

IM AND VOIP
� Adium 1.1.4

(Mac OS X)
� Google Talk
� Miranda IM v0.7.3
� mIRC v6.31
� Pidgin 2.3.1
� Skype 3.6
� Trillian 3.1.9.0
� Windows Live

Messenger
� Yahoo Messenger 9

Beta

SECURITY
� Ad-Aware SE

Personal
� AVG Anti-Spyware

Free 7.5.1.43-3339
� Microsoft Windows

Defender 1.1.1593
� Spyware Doctor

5.5.0.176
� Spyware

Terminator
2.0.1.224

� SpywareBlaster
3.5.1

E-MAIL CLIENTS
� Incredimail 5.68

build 3315
� Thunderbird 2
� The Bat!

RSS READERS
� BlogExpress 1.56.2
� RSSOwl 2.0

Milestone 7
� Easy RSS Content

Generator
� FeedDemon

FILE TRANSFERS
� AceFTP 3
� PuTTY 0.60
� WinSCP 4.0.5
� Cute FTP Home
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Frets On Fire
Frets on Fire is a game of musical
skill and fast fingers. The aim of
the game is to play guitar with the
keyboard as accurately as possible. Featuredon ThisMonth’sFast Track



Digit Reader Poll

By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Fedora 8
Size: 3.3 GB

OpenJudis 
Size: 347 MB

taste technology at www.thinkdigit.com

This Month’s Question                                                 Vote at www.thinkdigit.com

Your thoughts about Fast Track:

It's perfect, leave it the way it is!
A little colour and better paper would go a long way
Make it a Colour, Interactive PDF on the DVD
Replace it with a comprehensive multimedia tutorial on the DVD
Just end it, I hate it.

Subscribe
No more snail-mail! No need to visit
post offices! All you have to do is log
on to www.thinkdigit.com/subscribe
and use your Credit Card to make
sure you never miss another issue of
your favourite magazine!

Web Special
The Red Brick Road
October 2007
(Log on to www.thinkdigit.com)

Last Month’s Question

You just can't beat the
feel of paper 36.8%

I only read small articles online; it's still
print for me 29.07%

I'd rather read the electronic version than not read at all 6.8%

Dump paper! Save the trees! Make
Digit an e-mag! 27.33%

Online

FEATURED TUTORIAL FROM THE DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month we feature a member tutorial from the forum here.

When you buy a domain at a registrar like Yahoo Small
Business or Godaddy, you usually get only one email
account. Some provide two or three ids depending
upon the price. If you want to get more than that, you
will have to buy them. Now, one email account is too
less. You might want to have addresses like
support@yourdomain.com, or sales@yourdomain.com
or anything@yourdomain.com simultaneously. Now I
will show you how to create up to 100 email accounts
at your own domain, for free. All you need is a domain
name and the ability to modify DNS records.

We will use Google Apps for doing this. Go to
Google Apps and click on ~'Get Started'~. You will be
presented with three different editions of Google Apps
- Standard (free), Premier (paid) and education (free).
Sign up for the Standard edition and provide your
domain name to proceed. You will be asked to create
an account for administrating the domain. After the
account is created, you will be automatically logged
into your account and into the dashboard.

On the dashboard, you can see the options 'Create
new user' from where you can add new user accounts

to your domain. Before you can do that, you have to
set up your email. Under the 'email' section, you will
find 'Activate', click on it. Now you will be asked to
configure your domain MX records.

Log into your domain registrar's account and head
to DNS record management. What you have to do is
this:

Create a CNAME record:
mail.yourdomain.com (you can use anything

instead of mail) and enter hostname as
ghs.google.com. Instructions on how to do this for
various registrars are located at
http://tinyurl.com/295p9f.

Create these MX records: 
MailServer Hostname:..............Priority
ASPMX.L.GOOGLE.COM. --------- 10
ALT1.ASPMX.L.GOOGLE.COM. ---- 20
ALT2.ASPMX.L.GOOGLE.COM. ---- 30
ASPMX2.GOOGLEMAIL.COM. ---- 40

For more visit:
http://www.thinkdigit.com/forum/showthread.p
hp?t=77806

09-01-2008,
01:01 PM

blackpearl

The Devil
Join Date: Feb
2006
Location:
0x02AE88C6FF
Posts: 833

MMyy RReevviieeww ooff CCrreeaattiivvee EEPP--663300

What are your views on electronic publications

To
ta

l: 
3,

34
1
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The project has solid
backing, with Google alone
having invested $5 million
(Rs 20 crore). It has also
received investments from
the Rockefeller Foundation
for $1 million (Rs 4 crore)
and is expected to receive
another six-figure
investment from John
Doerr, a well-known
venture capitalist.

COME SP3...

Microsoft
Drops
Support—
Again

With the arrival of
Service Pack 3
(SP3) for Office

2003, Microsoft has decided
to stop support for older file
formats—Word 4.x and
below for Windows and 5.x
for Mac. What this means is
that if your company has
any Office document
backups from before 1992,
they will not be readable
with this update. Apart
from that, this update also
removes compatibility for
older spreadsheet products
that compete with

Microsoft’s—like Corel Draw,
Lotus, and Quattro.

Microsoft claims to have
dropped support due to the
formats being “less secure”
than the current-generation
Office 2003 and 2007
formats. Though this may
be true, many users are one
again pointing fingers at
Microsoft for being the
bully and forcing newer
products on them. As
companies and individuals
alike back up more and
more data, Microsoft’s
planned obsolescence of
older file formats is
worrying. Not only that, SP3
is reportedly riddled with
bugs, with many users
reporting frequent crashes
and instability of Office
after the upgrade. Even a
complete re-install of the
program does not seem to
solve the problem.

The company does offer
workarounds to fix the
problem, and in an effort
to wave the olive flag, has
described two ways of
doing so. One method
involves downloading the
Office 2003 Service Pack 3
Administrative Template
and set templates for users
across a domain—
something not for the end
user. Another method
involves editing Registry

entries manually—
something potentially very
dangerous for end-users!
The misery doesn’t end
there: those Registry
entries are different for
different versions and
language settings of Word,
which means that if
someone has backups from
Word 2 and Word 3 French,
he will have to edit entries
for both those versions in
separate places in the
Registry; find detailed

WiMax
The broadband
technology that will
connect us all.
We’ve witnessed
WiMax trials

throughout 2007, even getting
Internet access out in the
middle of the sea! And now,
Reliance has even started
providing WiMax Internet in
some parts of the country...

It Sucks!
...well, the service
does, to be fair. In
a Google search for
“reliance wimax”,
the first result is a
Web page that tells you
loudly, “Reliance Wi-max
services—don't go for it!”
Sounds like the broadband
bitching is never going to
end for us...
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HCL Infosystems Ltd, the
pioneers behind India’s first
microcomputer, first Desktop PC
and first home PC, recently
launched a range of ultra-
portable laptops: the MiLeap X &
Y series. We had a quick round of
questions with Ajai Chowdhry,
Founder of HCL and Chairman
and CEO of HCL Infosystems Ltd.

How different are computing
habits and environments in
India from those in the rest of
the world?
Not very different. The external
physical environment, however,
in which Indians operate is very
different; laptops here are sub-
jected to a lot of dust, pollution,
and climatic extremes. The
MiLeap series is very rugged and
designed to sustain normal wear
and tear; the MiLeap model in
the X-Series comes with a leather
casing, giving it the appearance
of a leather-bound diary. 

What usage scenarios and
application areas do you plan
to target with future products
in this category?
The ultraportable form factor,
full functionality, and the 
fiercely competitive price are
the USPs of the MiLeap range.
The convenience factor has
opened up limitless possibilities
in new usage scenarios.

Having introducing the
MiLeap series, do you believe
that the near future of
personal computing in India is
ultra-portable?
Targeted at consumers who need
to stay connected, informed,
entertained, and productive
anytime and anywhere, these
laptops’ weight and size makes it
so convenient that a user need
not think twice about carrying it
to the office, home, gym, or park,
or using it in a train, bus, plane,
or metro. This revolution in
personal computing in India will
be sustained by four critical
factors: price, size, features, and
most importantly, availability of
high-speed broadband.

Yahoo! Goes OpenID
Internet giant Yahoo! Recently announced that it would now
be possible to use Yahoo! user IDs on Web sites that support
the OpenID system, a decentralised sign-on system that
authenticates a user based on a URL assigned to that user by
an OpenID provider.

Netscape Navigator Retires
The most popular browser during much of the 1990s—
Netscape Navigator—has retired, with parent company AOL
announcing that it would stop security updates and
technical support beginning this month. It will, however,
allow nostalgic users to download archived versions.

Here’s more reason to
take the social
networking

phenomenon seriously.
Google.org’s executive
director Dr Larry Brilliant is
running a project called
Innovative Support to
Emergencies,
Diseases and
Disaster (InSTEDD;
talk about silly-
sounding
acronyms), which
will leverage the
use of existing
social networking
technologies like
Facebook Mini-Feeds
and Twitter updates
to reach out to
individuals in
distress.

Here’s how it
works. As a patient,
you can text-
message the
InSTEDD number
asking for help.
InSTEDD
volunteers, who
can locate your
exact position via
Google Earth, receive this
message. Once your position
is located, they search for
UN or other humanitarian
aid volunteers in the region
and forward your query to
them. The volunteers reply
to you with a description of
what medicines you should
take, or with their address.
Once the conversation is
complete, software
automatically links your
mobile number with the
group that last assisted you,
so that when you send a
message next time, it

directly reaches the
volunteer group closest to
you. If you send a text
message from a different
location, the software will
detect the change and the
process will repeat.

As a patient, you also
have the option of
subscribing to updates
from the closest volunteer
group in your area. This
helps spread warning
messages quickly to a large
number of people. There is
talk of improving response
time by having volunteers
from all around the world
subscribe to GeoRSS feeds
(feeds delivered to users
based on the geographical
location of their contact

number). The software can
send out these feeds based
on the geographical
location of the patient and
of the volunteer.

Since the project works
using existing free

technologies and
software like
Google Earth, Live
Maps, Geo-coding
Web services, and
applications built
on ASP.NET, they

can be built and
deployed quickly
and inexpensively
over a large,
populous area.
Twitter is being used

as the worldwide SMS
gateway, while
Facebook is being used
to geo-tag incoming
requests with its Mini-
Feed feature, and send
out requests for help
to volunteers in the
region. 

Brilliant is also
considering the

expansion of a Web
crawler (software that

indexes information
from Web pages) used by
the Canadian Government
called the Global Public
Health Intelligence
Network. This will monitor
20,000 Web sites in seven
languages, which could
search for keywords used
on Web pages from a
specific location, and based
on the time difference
between these, can actually
warn of a possible outbreak
of either a disease or an act
of terrorism to volunteers
in the area!

Enter

Security Watch

HUMANS FOR HUMANITY

Helping, The SN Way

17
n Microsoft’s Project Shiksha trains 200,000 Computer Teachers in India over 5 years ending 2007 n Polish teen hacks train network, derails tram n n Gamer uses medic training from America’s Army to help save a life n NASA requests freelance game developers to create America’s Army clone n

Ajai Chowdhry
Founder, Chairman and CEO, 

HCL Infosystems Ltd

Excel Under Attack
The Problem
A vulnerability—rated as
“Extremely Critical” by security
firm Secunia—has been
reported in Microsoft Excel. As
you’d expect, it can be exploited
by Men With Malicious Minds to
compromise a system.

It has something to do
with how Excel handles files,
but what exactly it is has not
yet been specified. The
vulnerability can be exploited
if an attacker uses a specially-
crafted Excel file with
malformed header
information.

Successful exploitation, as
you’ve come to expect by now
when something is rated Highly
Critical, allows execution of
arbitrary code on the victim’s
computer. According to
Microsoft, this is currently
being actively exploited.

The Solution
There isn’t any—at least, there
wasn’t at the time of writing. If
you get an e-mail with an Excel
attachment, don’t open the
attachment unless you’ve
spoken with the sender
beforehand, or unless you’re
expecting it. Check
http://tinyurl.com/yotn2k
when you read this to see if a
patch has been released.

What are your views on electronic publications?
(You, too, can participate in this poll—at www.thinkdigit.com)

You just can’t beat the feel of paper I only read small articles online; it’s still print for me

I’d rather read the electronic version than not read at all Dump paper! Save the trees! Make Digit an e-mag!DC

BA

(You, too, can participate in this poll—at www.thinkdigit.com)

Opinion Poll

I’d choose B. The current e-publication
methods are not conducive to sustain read-
ing them over an extended
period of time. It is possible to
read them if the articles are
short and concise. Nothing
beats the convenience of read-
ing a book on your couch.
Shubhankar Dattagupta
Pune

I’ll take C; I do prefer reading a book, but I
like to have e-books for them as well. It’s
the best way to save the books
as well as space.
Naveed Patel
Pune

I’ve chosen B because I’m introduced to
topics or articles at the computer, so I
don’t mind reading small
articles on the monitor. But
it strains the eyes more.
Hence nothing beats paper
for me.
Antonio Anastasio Bruto da Costa
Margao, Goa

I’ll go with option B. Small articles may be
read in e-media, but it’s painful to read a
whole magazine like Digit and
its Fast Track in electronic
media. Don’t convert the mag-
azine into an e-mag!
Sujit Kumar Ghosh
Digboi (Assam)

I vote for option A. Electronic reading
puts a stress on the eyes. I have tried
reading e-books of my engi-
neering-related e-books... but I
never completed them—I had
to buy printed books for
those topics.
Ravi Shekhar
Delhi

Reading magazines on a computer is defi-
nitely not tiring. E-mags have some nice,
useful features like Web links
and search features, which
you can’t get with a paper
magazine. So I choose D.
Milind Alvares
Goa Parra

Illustrations Harsho Mohan Chattoraj
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instructions at
http://tinyurl.com/3apmna. 

Users are complaining
that the least that Microsoft
could have done would be
to set up a tutorial for
circumventing the blocks
on third-party file formats—
as they did with their own
products—or directed users
to the correct source on 
the Internet.

IT’S IN THE EULA

My Spyware
Community

More and more
companies are
monitoring user

activity following an
installation of their
software. Reporting
anonymous user statistics is
considered all right if the
user opts for the
programme, but some
companies want the user to
opt for various programmes
without knowing.

Sears, an American
chain of departmental
stores, recently launched a
customer relationship

program called “My SHC
Community.” When
customers provided their e-
mail address to the
company Web site or at the
store, they would receive an
e-mail inviting them to join
the SHC community. The
mail discloses that
participants would have to
download software on the
computer that would track
their surfing habits
anonymously. What it does
not mention, however, is
that the program will log all
the Web sites a user visits,
along with the items he
buys, will store all the data
he enters on any Web site
and track his online
personal and health records.

There is no mention of
this anywhere in the invite
e-mail, and only a reference
to this can be found when
reading carefully through
the End User Licence
Agreement of the software
to be installed; it occurs
mid-way through a
paragraph, without a
heading or any bold
lettering to inform users of
the extent of monitoring.

When this was reported
to Sears, vice president Rob

Harles claimed that SHC
“goes to great lengths to
describe the tracking
aspect”. Spyware expert
Benjamin Edelman
strongly disagrees. 

In another such
incident, Dan Moren, a
blogger, found out that
every time he used any
Adobe CS3 product, an
outside connection was
made to 92.168.112.2O7.net.
What’s so strange about
this is that though this
looks like an internal IP
address, it ends with
“.net”—something no
internal IP address does. If
you look closely, the last
group has the letter “O”
instead of a zero. What this
means is that your usage
statistics might be reported
to Adobe when you use any
of the CS3 line of products.
When this address is
followed in a browser, it
leads to Omniture, a large
user statistics and 
analytics firm.

There is, however, a
namesake opt-out
procedure you can follow;
to do so, you’ll need to visit
http://tinyurl.com/29z3r8. This
page will install the opt-out

cookie on your computer. If
you delete your cookies or
use CS3 products from
other accounts on your
computer, you will have to
repeat the opt-out process.

Users are not
impressed, with many of
them complaining that it
would be much better if
Adobe had mentioned to
them that they were being
monitored. As for Sears,
most participants who
came to know—from online
reports—of this activity
quickly uninstalled the
software. Spy if you must—
but with a little more
class, please!

ALL IN ONE PLACE

Copy And
Paste...

It could get annoying to
set up a profile every
time you create a new

account on the Web. For
example, social networking
sites: you create an
account, add friends, add
photos, add interests, etc.
and then you sign up at

A Round-up Of Technology News From Across The GlobeThe Digital World

CHINA
Officials admit that they are losing the
war on Internet piracy and plead for
international help in making an
ongoing crackdown more effective.
About 40,000 porn sites have been
shut down in the crackdown.

BRAZIL
Popular games like Counter-
Strike and EverQuest blamed
in Brazil for ruining health of
players and inciting violence.

AFGHANISTAN
Journalist student sentenced
to death for violating Islamic
tenets by downloading a
document from the Internet
and printing it.    

CANADA
High tech driving licenses
with embedded RFID chips to
be introduced which will
work as passports for entry
into US via sea and land

PANAMA
Hackers deface the Website of
Panama’s National Assembly and
put up an American flag as revenge
for electing a legislator accused of
murdering a US soldier as president.

SOUTH KOREA 
Google launches a
localised Korean
version of YouTube to
take advantage of local
content.

n Buggy KDE 4 releases to much disappointment from fans n India’s first Digital Entertainment City sets up shop in Hyderabad n 
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Photograph Deepak Verma Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

Road Rash, anyone?

another site and do the
same all over again...

A group of companies
that believe in securely
sharing predefined user
data across the Internet is
promising to change all
that. Their Web site,
www.DataPortability.org,
encourages online
companies to leverage
existing technologies to
share user data across
other Web sites. What this
means is that you won’t
have to re-enter details (like
interests) or upload
photographs all over again
on that new Web site you
just signed on to. 

Leading developers
from Google and Facebook,
among many others, have
recently agreed to take
part in this path-
breaking project. 

For you, the end user,
this means an Internet
that is completely
personalised to your
interests and tastes, with
all your data and
relationships seamlessly
accessible, while saying
bye-bye to your privacy. If
the industry pundits can

put aside their differences
and work with
participating members, the
privacy angle can be sorted
out, though.

These are, of course,
early days, with companies
only just having signed on.
We’ll keep our eyes and ears
open on this one.

NIGERIAN SCAM?

OLPC Sued In
Nigeria

LANCOR, a Nigerian
manufacturer of
lingual keyboards, has

accused the OLPC
Foundation of infringing on
intellectual proprietary
rights from two of its
products. It claims that the
OLPC purchased two of
LANCOR’s keyboards—and
reverse-engineered its XO
keyboards to be more like
the KB-201s. Although the
company shows no proof, it
expects the OLPC to pay $20
million (Rs 80 crore). 

The company’s lawyers
responded swiftly to the

charges, asking for
clarifications on details of
the keyboard that LANCOR
claimed had been infringed
upon. Instead of
communicating with the
lawyers, LANCOR filed a
Motion on Notice in the
federal high court of Lagos,
which stopped the OLPC
Foundation from donating
its laptops in the country.
The court has slapped a
temporary injunction on
LANCOR, and this stops the
company from closing a $1
million (Rs 2 crore) order
with the Nigerian
government.

Some believe there is
actually an Intel
(under)hand in all this.
They believe that the
Motion of Notice allows
Intel enough time to
convince the Nigerian
government to choose the
Classmate PC, a small PC
similar to the OLPC’s XO
and designed for kids,
instead of the OLPC laptops.
These rumours have
gathered more ground with
Intel recently having
distanced itself from the
OLPC foundation.

SCIENTIFIC SORTING

Google Gets
Science-y

Search (and other things)
giant Google is all set to
store the world’s open

source scientific data at
domain http://research.google
.com. The project has been
dubbed Palimpsest. Since the
data will be open source, it
will be accessible by all—
scientists and non-
professionals alike. The
project was set to be
showcased at the Science Foo
Camp—a science fair at the
Google campus in August
last year, but missed its
deadline and is scheduled to
be launched soon.

Since the amount of
data it will host is vast,
there are technological
challenges like being able to
transfer large volumes of
data quickly to the end user.
The company will leverage
the data visualisation
technology it acquired from
Trendalyzer, and will offer
algorithms on the site for

Last Month’s Winner!
Abdul Khader J, Hyderabad 
“That’s what Crysis did to my
laptop”

n Dish TV In Talks For DTH Services With Indian Railways n Sify announnces plans to enter thin client market in India; talks on with Microsoft n 

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

1 Hour Web Site
by Utvich, Milhous 
and Beylinson

Published by
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examining and probing the
data. The site will also
include YouTube-style
commenting and
annotating features, which
will allow for quicker
sorting of information. This
will allow for making
massive data sets—like all
the images from the Hubble
Space Telescope—accessible
to the public.

So how will all this data
be uploaded to Google? In a
post by a Science Foo
attendee, the collection plan
was described thus: “(They)
are providing a 3 TB drive
array (Linux RAID5). The
array is provided in ‘suitcase’
and shipped to anyone who

wants to send they data to
Google. Anyone interested
gives Google the file tree,
and they SLURP the data off
the drive. I believe they can
extend this to a larger array
(my memory says 20 TB).”

GEOGRAPHY WITH A CAUSE

Geotagging
Adds Value
To Images

Did you imagine it
possible to find the
location, altitude,

latitude, and longitude of a

picture just by looking at
it? It is, now. The act of
entering this metadata is
called geotagging; it is
becoming increasingly
popular as more and more
users start to upload their
photos online.

When users upload
their photos to Flickr or
Picasa, they have an option
to enter the name of the
place where the photos
were taken. When you run
a search with that location
name, your uploaded
photos will also be
displayed. Thanks to
geotagging, it is now
possible to search for
almost anything accurately.
Recently, mountaineers
have been using geotagging
to enter the altitude at
which photos were taken
with the help of GPS
receivers. These
photographs allow other
mountaineers to determine
the mountain surface at
various altitudes.

This is just one of the
examples of the advantages
of geotagging; there have
been reports of
professional bird-watchers
using it to keep track of
the migratory paths of
birds and drawing a path
based on the location of
the geotagged images.

The only hindrance to
more detailed geotagging
currently is that it involves
fiddling with another
device like a GPS receiver
or a computer after the
photographs are taken.
Flickr estimates that only 5
per cent of their photos
have simple geotags on
them. However, camera
makers are toying with the

idea of including GPS
receivers in the cameras,
which will automatically
geotag every image with
details like latitude,
longitude, and altitude.

GOOGLE WHAT?

“Google
Generation”
Not Too
Good At It

Anew study conducted
by the British Library
and the Joint

Information Systems
Committee dispels the myth
that those born after 1993
are capable of using the
Internet much more
effectively and that they are
generally better at
gathering information from
the medium.

Based on log analysis
from British Library Web
sites and search tools, the
committee studies the
books rented out by kids
based on search engines as
their referring links. The
study claims that this new
generation is neither better
nor worse than those in the
last 30 years. However, it
does note some serious
changes in today’s
knowledge culture. 

The study notes that
since knowledge is
primarily sought from
Wikipedia or Google, there
is no real “expert” these
days. The only knowledge
that exists is peer
knowledge, found mostly on
online communities. It also

One of Apple’s best-kept secrets thus far, the
company says the MacBook Air is the “world’s
thinnest notebook” at 1.93 centimetres. The
standard-configuration MacBook Air sports a 14-inch
LED screen, an 80 GB PATA drive, a 1.6 GHz Intel
Core 2 Duo, 2 GB of DDR2 SDRAM soldered to the
logic board, 802.11 a/n, inbuilt camera, microphone,
and speaker, and Bluetooth. The battery life is
around five hours.

There is no Ethernet port, but users can purchase
a USB-to-Gigabit Ethernet converter. This is the first

MacBook since the PowerBook 2400—which was
released in May 2007—to ship without a CD/DVD
drive. However, users can use share the disc drive off
other computers wirelessly, or buy the external USB
SuperDrive from Apple.

The notebook’s aluminium case engages a
magnetic latch when being closed. The trackpad on
the keyboard includes multi-touch features, which is
an advancement over other models.
The MacBook Air ships for $1,799 (Rs 72,000), but
will not be available in India anytime soon.

One in six British
pounds is now
spent online.

Internet shopping
in the UK in 2007
was 50% higher

than in 2006

As of January
2008, 48% of
internet users

had been to
video-sharing
sites. Traffic
to such sites

has doubled in
the past year

The average Internet user is
46.6 years old. 71% of senior
(above 65) Internet users
have received a video link,
and 50% of them have
forwarded links.

End of 2007, traffic from
Macs accounted for 8 per cent
of Web traffic. Windows use
fell in the past year.

n Wikipedia starts allowing videos in wikis n Blu-Ray crushing HD-DVD in Japan n Orkut profiles to now be added to Google Search results
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MacBook Air

On a typical day (over 2006 and 2007; source: Pew
Internet), percentage of users who did the following:
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Enter

Psiphon
Interesting name. What is
Psiphon?
It’s a system that allows people
in countries where the Internet
is censored (like China and Iran)
to view any Web page they’d like
to. Say you’re in China, and the
government has blocked access
to Wikipedia. You have the
address of a Psiphon node (a
Psiphonode)—a computer
running the Psiphon software in
a free country—and an account
there. You log on to that node,
then type in the Web page
address. The request is routed
through the Psiphonode and
your browser displays the page.

So who sets up Psiphonodes?
People and institutions willing
to help. Anyone can install the
Psiphon software on his
computer, and it becomes a Web
proxy for Psiphonites (those
whose access is censored) to
connect to.

Where do Psiphonites get the
address of a Psiphonode?
People post requests for server
addresses on forums, or call
friends and family. If you run a
Psiphonode and see a request
from someone, you might send
him your server address, and
create an account for him.

Why can’t censoring
governments block Psiphon?
The Psiphonite connects to
Psiphonodes whose addresses
only a few people know. (To
block access to a site, you
need the IP...) Still, the forums
where Psiphonites make
requests for Psiphonode
addresses have been known to
be blocked.

When did the system go live?
In December of 2006. Forums
are active, though we don’t
know how many people are
using the system.

How does the whole thing
remain legal?
It doesn’t. In some countries,
bypassing censorship is illegal.
But a Higher Law would say
censorship is illegal, that’s why
people are trying to help out.

notes that the “Google
generation” prefers visual
over textual information,
but that text is still
important—and visual
media can lose its appeal
very quickly. The study also
notes that this generation
has scant regard for
copyright laws, and that
plagiarism is rampant.

Interestingly, this
generation is multitasking
almost all the time, and
the demand for instant
gratification is constant;
however, there is no hard
evidence that young people
are more impatient.

In spite of the results,
the study warns libraries
from trying to be more
tech-savvy by, say, opening
communities on Orkut,
suggesting that this may
result in the younger
generation seeing it as
“invading their space.”

MORE OLPC WOES

Two’s A
Crowd, Says
Microsoft

Just when news about
the OLPC Project started
slacking, there came

another bit to trouble the

organisation. Nicholas
Negroponte recently
reported that the OLPC
Foundation was working in
collaboration with
Microsoft to create a dual-
boot version of its laptops
meant for children, the
XO. This was, however,
quickly squashed by a
statement made by a
Microsoft representative,
who went on to say, “While
we have investigated the
possibility in the past,
Microsoft is not developing
dual-boot Windows XP
support for One Laptop Per
Child’s XO laptop.”

Though this might
seem a flat-out denial from
Microsoft, there seems to
be some confusion in the
statement here. It is true
that Microsoft is working
with the OLPC Foundation
to bring Windows XP to
the XO. This will, however,
be done in a different
manner. Microsoft’s plan is
to load the OS onto a 2 GB
SD Flash memory card,
which can then be used to
run on the XO. This is
because the Windows
environment requires at
least 1 GB of space to run
even a stripped-down
version of Windows XP,
along with any other
program on the XO. To

revert to the XO’s Sugar
interface—its

OS—one needs
to shut down
the XO,
remove the
SD Flash
card, and

reboot.
Since this is

different from a
traditional dual-

boot system, this
is where—we
believe—
Negroponte was
confused.
Taking a pot-
shot at the
OLPC
chairman,
Microsoft
also
suggested
that they be

contacted for

further updates on the
Windows-run XO, rather
than any other source.

ONLINE COMMUNITIES SCARY!

What
Parents
Think

Arecent survey by the
Center for the
Digital Future at the

USC Annenberg School for
Communication—for
parents with children who
regularly logged on to the
Internet—found that two-
thirds of parents are
uncomfortable with their
children participating in
online communities, and
half of them think online
predators are a threat.
However, 80 per cent
agreed that the Internet is
a valuable source of
information, and ranked it
higher than newspapers,
television, radio, and 
even books.

The survey has been on
for the last seven years,
and trends have emerged.
Logging on to the Internet
is no more considered by
parents as a distraction—
naturally. Thirteen per
cent of the parents felt
their wards spent too
much time online—a figure
that has increased since
last year, an not
surprisingly. Another trend
that has emerged is that
more and more parents are
finding it worrying that
their kids are involved in
online communities, but
they don’t deem chatting
and e-mailing as harmful
or potentially dangerous.

Obviously, the next
generation’s voice is the
exact opposite—most kids
polled report being avid
users of community Web
sites, with 71 per cent
claiming that their social
membership was
“extremely important,” and
54 per cent logging in to
their online communities
every day. 

n Microsoft plans standards compatability mode in IE8 n AOL/ICQ develop technology to help the blind use instant messengers n 
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Nimish Chandiramani

If there were no Windows vs. Linux battles, the
geek life would have been notably duller.
Technology forums would inevitably get

boring, and life would generally never be the
same. The most contentious issue, of course, is
security—Windows is notorious for not having
much in that department. However, Vista is
loaded with a bunch of new security measures,
and claims to be able to thwart malicious soft-
ware better. 

What makes an operating system more
secure? The way it’s built, of course. And that is
the question we’re asking. But
first, some myth-busting. 

Popularity Contest
The favourite theory to
explain the low number of
viruses (or Trojans, or other such
malicious code, for that matter)
that exist for Linux is that it’s
not popular enough—they say

Any Linux geek would tell you Linux thrashes Windows in more ways
than one. But does it? And why? What makes a system better than
another? At this stage, are they even different at all?

chaitanya surpur 

DIFFERENCESDIFFERENCES
that if you turned the tables and made Linux
the world’s most used OS, you’d find just as
many malicious programs for it as you do for
Windows now.

There is some logic to both the statements,
but here’s what the Linux community usually
comes back with: nearly half of the world’s
Web sites run on Apache, either on Linux or a
BSD. Since this is obviously the most popular
platform, there’s plenty of incentive for hack-
ers to spend their time taking it down—and
yet, you don’t see Apache’s vulnerabilities in
the news as much as you see those of
Microsoft’s IIS. Not that the hackers aren’t

trying to take down Apache servers—
they’re just not having as much

success with it as they are
with IIS servers.
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grated into the core of the system, even though
they don’t need to—IE and Outlook Express
immediately spring to mind. Remember the
Windows 98 + IE4 combination, when you could-
n’t tell where the OS ended and the browser
began? 

The upside to this approach is a smooth,
hassle-free user experience—all these programs
get a little extra love from the OS kernel, so
they’ll inevitably perform better than third-
party programs. The downside—which we see
often enough—is that any vulnerability in these
programs can potentially bring down the
entire system. This is why you hear of vulnera-
bilities in IE and Office letting hackers gain
control over Windows PCs. In fact, in Windows
XP, even the graphics engine that draws
windows on your screen runs in this privileged
space, so if your graphics freeze, your only
option is to reset your system. 

Linux, on the other hand, is designed to be
modular. Only the most essential components
of the operating system are integrated into its
core—the rest are loaded only when needed,
and don’t have access to critical system files. A
vulnerability in Apache, for example, stays in
Apache. The Linux we’re talking about here is
the core OS, and not the Desktop Environ-
ments, mind you. GNOME and KDE may not
integrate with the Linux kernel, but within
themselves, they are quite integrated. The disad-
vantage is the same as for Windows—if one
component of GNOME fails, the Desktop Envi-
ronment fails, taking all the applications
running in it down. However, the OS kernel
isn’t affected, so all you have to do is a simple
[Ctrl] + [Alt] + [Backspace], which
ends your GNOME / KDE session and lets you log
in to your system again. 

This is where Linux (and UNIX, and the BSDs)
clearly take the lead in terms of security. It may
not feel as nice as Windows while you’re using
it, but it won’t let something silly like a flaw in
a text editor take it down, either.

Endgame
So really, which is better? Let’s look at it step
by step, starting with the potential for mali-
cious software to enter your PC. Both systems
are on equal footing here—malicious software
getting into your PC is usually your fault
(assuming you don’t have security software
installed). Step two: malicious software does
get into your PC; what is the scope of the
damage it can do? Again, with both Linux and
Vista, damage caused by malware is restricted
to the service it exploits, and the files that the
service can access. So far, so good. Finally, step
three: what happens when the malware goes
about its dirty deed? With Vista, if a critical
service—like the Remote Procedure Call (RPC)
service—is compromised, all manners of chaos
may ensue. Every application under Windows
needs to use RPC, so you’re sunk without it.
With Linux, services aren’t as tightly inte-
grated with the OS, so while your Linux PC can
be crippled—some applications won’t run, you
may not have network access and so on—the
kernel is still safe, which means that with a

little root wizardry, it can be brought back to
life again. 

Bottom line: for daily desktop use, both
systems are equally secure—but if things do go
wrong, they go more wrong with Windows. 

nimish_chandiramani@thinkdigit.com

Only the most
essential
components of
the operating
system are 
integrated into
the Linux core

Windows’ Remote Procedure Call (RPC) service has
many things working against it—nearly every applica-
tion on your PC needs it, so it’s a favourite target for
hackers, and even a moderately resourceful amateur
will stumble upon neat little GUI tools like this to
exploit the service

All this is very leading, but it really doesn’t
say anything. IIS servers are often taken down by
exploiting vulnerabilities in Windows (an unfor-
tunate side-effect of Windows’ integration with
its software; more on this later), and not neces-
sarily in IIS itself. Secondly, while the Netcraft
list of sites with the longest uptime is domi-
nated by Apache servers, there’s no information
on the actual availability of the servers—they
could have been under a DDoS attack for half
that uptime, but as long as they haven’t
rebooted, they’re on the list. 

Bottom line: there is no bottom line. For
every (seemingly) logical statement, there
exists an equally logical retort. We could write
the arguments and counter-arguments for
twenty pages if we felt like it, and you still
won’t walk away with a definite conclusion.
Let’s just move on.

Your OS And You
The biggest security breaches occur when
malware is allowed to run with on your system
with elevated privileges—which means that it
has access to critical programs and data that
only your system’s kernel should have. Once it’s
reached that level, your PC becomes its humble
servant, and can be brought down at the slight-
est whim. Who gives this malware its privileges?
Well, you do.

With Windows XP, the person who installs
the operating system becomes the Administra-
tor, so if you’re the only one using your PC,
you’ve got the privileges to wreak all sorts of
havoc, should you choose to. Consequently, any
application you install and run is also accorded
the same royal treatment, no questions asked.
Now add to that the fact that Windows’ system
services run under a user account called SYSTEM
(you can check this out in the Task Manager)—
the most powerful account on your system, with
access to everything critical—and that the first
processes that malicious programs hijack are
system services. You’ll be drawing pretty accu-
rate conclusions by now...

Vista, thankfully, changes this. The user who
installs Vista is still part of the Administrators
group, but even this administrator runs with
regular, limited privileges. When administrative
tasks—including installing new programs—need
performing, User Account Control (UAC) kicks
in, telling you that you need to give the task a
go-ahead before it, well, goes ahead. If you read
the UAC prompt and don’t know the program
it’s warning you about, you can prevent it from
running. But what if you’ve blindly allowed the
task to continue?

Unlike XP, malware has little or nothing to
gain from hijacking a system service in Vista—
instead of giving services unlimited rights like
before, Vista runs them with low privileges,
giving them access only to critical files and
Registry entries that they need; each service is
given a Security ID (SID), which it uses to request
permission to these objects. Consider this
scenario in XP: a virus has hijacked your system’s
innocuous Plug-and-Play service and has
acquired its privileges. One of the first things
viruses do is disable the anti-virus so they can

continue their reign of terror uninterrupted.
Since the virus can now do anything to your
system, it’ll be allowed to kill the anti-virus serv-
ice, corrupt the virus definitions, modify its
Registry entries and much more. In Vista, if this
same virus manages to attack the service, all
damage is restricted to the service and its
domain—you won’t necessarily be happy, but you
won’t be feeling silly, either.

Windows Vista basically accomplishes what
Linux has been doing for a long time—ensure
that regular users don’t have access to critical
operating system files and services; they don’t
even have access to files owned by each other!
The all-powerful root account is never used, and
in Ubuntu, it’s actually disabled: you’re
expected to use the “sudo” command (or gksu
for GNOME applications) and enter your pass-
word to execute commands that affect the
system in general. Unless you deliberately use
these commands to run a suspicious executable,
the worst it can do is affect the files you have
access to. Even if, for whatever inexplicable
reason, you do decide to run a malicious script
with sudo, your services are still safe...

Services in Linux run as separate users,
with access only to files that they own; more
often than not, they don’t even have the rights
to use the terminal, so they can’t run
commands or start other services. This is where
the multi-user approach comes handy again—
since users are isolated from each other, serv-
ices can’t access the data used by other
services. The Apache server, for instance, runs
as a user called www-data, which only has
access to the Web pages it serves. If a hacker
exploits an Apache vulnerability to get into the
www-data user account, he can’t really do
much to the other services, because www-data
doesn’t own those files. He can, however, mess
with Web pages, so while this isn’t a doomsday
scenario, it’s certainly not ideal. 

You’ve probably noticed the parallels
between the two operating systems by now—for
your use at home, both systems are quite
secure. Unfortunately, they both have one crit-
ical flaw: PEBKAC—Problem Exists Between
Keyboard And Chair. No operating system can
plan for human ignorance—Vista, unfortu-
nately, allows you to disable UAC (and it’s
annoying enough for you to want to), and even
then, it can’t guard against people who click OK
without realising what they’re doing. Linux
developers do all they can to ensure that you
never feel the need to use the root account, but
there’s always the daredevil who can’t resist. If
you keep your head on your shoulders and read
what’s on your screen, your PC will be as secure
as you want it to be. 

True, there are more people working on
Windows viruses than Linux, but popularity
isn’t all that makes Windows popular with the
hacker community...

Package Deal
Unfortunately, the thing we love about Windows
is also its undoing. Windows is designed as a
single unit, so a lot of features (or modules,
depending on what you’re looking at) are inte-

Windows Vista
basically 
accomplishes
what Linux has
been doing for a
long time—
ensure that
regular users
don’t have
access to critical
operating
system files and
services
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Day 1: Change the World—Eric ClaptonThe package’s nice—USB cable for data andcharging, typical Apple earbuds and transparentplastic stand—all accessories present. Still noiTunes bundled. The Touch is rather heavy for aPMP, courtesy the steel back. The chromefinished rear looks hot, but scratches easy.
Day 2: Many Rivers to Cross—UB40I upgraded the firmware to version 1.1.3; syncinganything still requires iTunes (sigh), though youcan interrupt the process with the swipe of afinger. Unlike the Nano or the Video models, youdon’t have to disconnect the device from iTunesto interface with it (play music, watch videosetc)—a serious plus for me, since I listen to musicwhile my device is connected.

Day 4: The Look—Roxette
I ripped my copy of Beowulf to the Touch. Syncingmovies is painful—iTunes creates another copy ofthe movie in the relevant format, and then thesyncing occurs. Video playback is good—nearly asgood as on the PSP (PlayStation Portable)—highpraise indeed!

Day 6: Can I touch you there—Michael BoltonPlayed with the touchscreen some more; it workswell, for the most part. Very gimmicky, and oncethe initial glamour dies down, it’s just anotherPMP. I love the finger-swipe browsing and the two-finger stretch to enlarge photos—nifty and ultracool! Browse through albums, tracks, and videoswith just a finger—and the Touch works muchbetter than most touch devices I’ve worked with.
Day 9: Meadows of Heaven—NightwishA few favourites have been playing—Jim Morrison(The Doors), Eric Clapton, Dire Straits and U2, andI’ve caught myself unabashedly tapping my feet.Music is spot on, vocals have a very naturaltimbre, Jim Morrison sounds rustic, andClapton’s guitar in Layla and She’s Waitingcomes to life with realistic mids. Apple’s

default earplugs are crap as usual, and you’rebetter off dumping them straight away thanpunishing your ears.

Day 14: Another day in Paradise—Phil CollinsThanks to the gorgeous screen, all photos lookgood on the Touch; just don’t zoom in—graininess and loss of detail will greet you. Itseems they’re optimised for full screen viewing,and that’s it. Battery life nosedives when youfiddle around with the screen. I got 8 hours ofMP3 playback with moderate touchscreen use—mostly around albums, playlists and such. Thenew firmware (1.1.3) was supposed to add 3 hoursto music playback—I got 1.5 hours; not too bad.
Day 19: Life in the fast lane—The EaglesSafari—the Web browser—is a little slow. WiFitransfers work well, and the Touch makes for agreat companion at congested airports with openWiFi access. For me, this puts the Touch into aleague of its own.

Day 22: Feels Like Heaven- Peter CeteraThis is a great PMP, good video playback, a verygood music player, and a functional and funkytouchscreen that will get you envious glares on thestreet, trains and buses. What’s not to like? Theprice, for one—Rs 14,500 is a littleexpensive for my tastes. Besides,the Touch is a little heavy to jogor work out with. That’s it;no more complaints.
michael_browne@ thinkdigit.com

Michael Browne
Having played around with my Nano 3G for a couple of months and loving it, I was totally unprepared for the

sudden pang of regret followed by a flash of good old jealousy when the iPod Touch was palmed on to me for a

long term review. While PMP shopping, I had told myself I could do without the allure of the large touchscreen;

was I fooling myself?

iPod Touch 8GB
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he Olive OPUS N°5 is in a class of its own
when it comes to high-end music players. It
comes in flavours of 400, 500 and 750 GB,

which translates to weeks of non-stop, non-
repeating, high quality music. The creators have
ensured perfect audio quality by choosing the best

DACs (digital to analog converter) and sophisticated
power supply components to isolate any
disturbances. It’s not lacking in features either—it
can be controlled through a PC or a mobile phone
thanks to wired and wireless connectivity. This also
means you can also stream music from over the
Internet. There’s even provision for plugging in USB
devices and you can use it to burn CDs as well. The
price for the 400 GB model is $2,999 (Rs 1,22,000),
$100 (Rs 4,100) more gets you the 500 GB model,
and another $100 for the 750 GB. 

VRX Mach4

he Mach4 is a Quad-Xbox360
chained together to power the three
gigantic 37-inch Sharp 1080p

screens. A Microsoft Force Feedback
Steering wheel is used to steer. The fourth
Xbox360 powers the smaller 7-inch screen
that is your rear-view mirror. There’s a
Sparco racing seat and a 1900-Watt
vibration system to ensure you feel every
bit of unevenness on the track, and two
fans to help you feel the wind in your hair.
The price? £12,500 (Rs 10,50,000)—much
more sensible to buy a real car, isn’t it?

T

LG HT762TT

ome Theatre systems are
generally all about quality, power
and detail, but LG thinks design

can’t be ignored. Presenting the all new
HT762TT—it’s got 5 speakers and a
subwoofer that total up to 700W of
power that should be enough to blow the
windows off the walls. While it may all
be about aggressive power and chaos,
its design is elegant and soothing and
blends in well with your designer room.
To take it beyond being just another
fancy speaker set, they have put in VSM
(Virtual Sound Matrix) which delivers a
sensation of surround sound like you
would get from 10 satellite speakers
instead of 5. Plug in your USB devices to
the system and you can playback MP3s,
WMAs, DivX videos or even photos from
your outings.

H

Ultrasone Edition9

DIGIT FEBRUARY 200832

f there’s anything more desirable than a set of ultra-high quality head-
phones, we don’t really want to know. The Ultrasone limited head-
phones that cost $1,500 (Rs 63,000) are touted as the world’s best,

and many audiophiles would agree! The ‘phones use 40mm Titanium plated
Mylar drivers, and they can play frequencies from 8 to 35000 Hz—well beyond
the human ear’s capacity. Ultrasone’s S-Logic technology gives a great sound
stage performance to the Edition 9. To keep your head pampered, exotic
Ethiopian sheep leather has been used on the earpads and headband. 

I

Droolmaal The good stuff   l Stuff to lust after  l Stuff for the well-moneyed

Olive OPUS N°5

T

Axiotron ModBook
he iPhone isn’t the only Apple gadget to get cloned by companies from our side of the world. There have been talks of
ASUS apparently working alongside Apple on a “Mac-tablet” for some time now, but a company called Axiotron has
already beaten them to it. Yes, there is, in fact, an Apple tablet that isn’t made by Apple. The Modbook, as it’s called, is

based on the Macbook. A quick search on Google reveals 2 models of the Modbook—both between the price of $2,279 (Rs 94,000)
and $2,479 (Rs 1,02,000). This isn’t some handicapped version of the Macbook, it’s the whole shebang—a Core 2 Duo processor, a
80 / 160 GB hard drive, a 13.3-inch touchscreen (obviously), a stylus powered by WACOM’s Penabled technology, WiFi, and even a
inbuilt GPS! All this runs on the OS X Tiger operating system. It’s not like they were running out of space to stuff in more things
either. They even give you the option to put in 4 GB of memory and up to 570 GB of disk space!

T

Digital Passion l DroolmaalDigital Passion l Droolmaal

Droolmaal_Feb_08.qxd  5/12/2008  5:36 PM  Page 34



39DIGIT FEBRUARY 2008

Digital Passion l Tomorrow

current bus transfers data rates simply can’t keep
up. If we have to go with current architecture,
that would mean that most of the cores would be
starved of data, and instead of speeding up indi-
vidual applications, they would slow down.

To get around the inter-chip networking
bottlenecks, companies like Intel and Rambus
have been working on prototypes of newer archi-
tectural models. Rambus has a program called
Terabyte Bandwidth Initiative (TBI), while Intel’s
programme is called Terascale Computing
Research Program. Last February, Intel has
released an 80-core chip that delivers supercom-
puter-grade speeds on desktop computers. The
fingernail-sized Teraflops Research Chip’s
performance metric is 1.81 Teraflops (trillion
floating point operations per second) at speeds of
5.7 GHz while data transfer rates peak at 2.92
Terabits per second. Rambus has also unveiled
new data transfer models that could easily go up
to 1 Terabyte per second—about 20 times the intra-
chip data transfer rates in the PlayStation 3.

How is this being implemented? In Intel’s
case, each core has a 5-port message passing
router which is connected in a two dimensional
mesh network with other cores that implements
message passing—an efficient LAN on a chip;
cores will communicate with each other better,
and the router will ensure that the right data
goes to the right chip. This architecture is much
more scalable than present day multi-core chip
interconnects in terms of speed and perform-
ance. On the Rambus side, we see new techniques
like Full Differential Memory Architecture
(which means in plain English, sending electrical
signals across different wires at the same time,
instead of across only one wire), 32x signalling
(transferring data at 32 bits per I/O operation per
clock cycle, compared to DDR’s 2 bits per I/O oper-
ation per clock cycle) and FlexLink for command
/ address routing (using the same type of high
speed signals which are in the data lines on the
command / address line).

These technologies are going to be in the
market by 2010, the companies say. In this
context, we had talked about IBM’s technology
where multi-core chips use light rays to transfer
data from one core to another, eliminating phys-
ical connections altogether. If and when the
technology is perfected, such chips are likely to
be first used in servers and high-end computers,
especially for gaming and specialised tasks like
video editing and scientific modelling that

demand a lot of processing power. However, by
2015, your 10-year old kid’s computer will have
these beasts sitting inside it. And quad core
would look so, well, last decade.

Smart Wires
Back to life-sized scales. Networks of the future
will be worlds apart from today’s relatively dumb
ones that simply carry packets from one end to
the other. With the explosion of P2P, high defini-
tion video streaming and ubiquitous computing-
projects like Internet 0 are looking at a scenario
where even light bulbs and toasters would have IP
addresses and will be hooked into the Internet—
networks as we understand them today may be
overwhelmed by the load of data. Already, doom-
sayers have been predicting how the “exaflood”
of data is going to clog the pipes, and there have
been quite a few apocalyptic predictions. Those
on the other side of the fence are less sure, and
many believe that Judgement Day, when
networks will just give up, is not far off.

That said, networks of the future will look
different, and will possibly work on different
protocols. Such networks will not need full time
chaperoning which is the job of today’s system
administrators. Called adaptive networks, they
would provide a personalised experience for
every user, with minimum maintenance.
Adaptive networks would also seamlessly
support different applications like VoIP, video
conferencing, video surveillance, wireless appli-
cations, computing on demand or any other new
application that users throw at them. Currently,
most networks have a one-size-fits-all philosophy
when it comes to applications, and when newer
demands arise on the network, it starts to show
its cracks. Security is also an important aspect,
and future networks will be able to detect secu-
rity attacks and take steps to fight back. Almost
like what the immune system does for our body.

This scenario seems to be a bit too Utopian,
but already companies have started work on
plans that would make this a reality. ProCurve,
the networking arm of HP has a neat solution
that would make networks of the future “think”
they way they’re supposed to. Each port on the
router and switch on the network will have indi-
vidual silicon chips that would monitor the traf-
fic flow in the network. These mini-processors
would have software installed that could be opti-
mised to run different applications like VoIP,
video streaming, P2P file sharing, virus scanning,
et al. Because the software is programmable,
ports can easily switch data types from, say, VoIP
to video in the event of heavy demand. 

Such architecture would ensure that the
available capacity is optimised for all these band-
width-hungry applications. Another big draw for
this decentralised architecture is that there will
be no single choke point in the network, there-
fore ensuring that even in the case of a disaster,
some part of the network would always be up
and running. Contrast this with today’s scenario,
where networks are only as strong as the weakest
link—hubs, routers, switches. For naysayers who
forsee difficulties like keeping the network soft-
ware patched and updated in absence of any
centralisation, ProCurve has a solution—use a

Security is an
important
aspect, and
adaptive
networks will be
able to detect
security attacks
and to fight
back—almost like
what the immune
system does for
our body
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Communication depends on networks.
Period.  While networks can mean many
things in many contexts, it’s the physical

networks, the wires and the waves that enable it
all. As the technological revolution proceeds at
breakneck speed, more and more digital data is
created than ever before. And this data isn’t
created by huge corporations, universities and
governments—each one of us, when we send an
SMS, click a picture or shoot off an e-mail, create
data which will invariably be added to the repos-
itory of global digital data. In fact, IDC—a
research body—estimates that 70 per cent of the
988 exabytes of data (one exabyte is equal to
50,000 hours of DVD quality video)—projected to
be the global digital output by 2010—will be
created by individuals.

Even by conservative estimates, that number
is huge. The thing to note is that most of that
data is not going to be static. It will exist in the
Cloud—a term recently much in use and which
roughly means the Internet. Everyday, as

humans upload more and more data from their
gadzillion devices, the networks that support
these data transfers will need to get more robust,
both in quantity and quality. 

Inside The Chip
Before talking about megascales, let’s focus a bit
on nanoscales. Inside the processor, we have
been seeing an increased concentration of cores.
The latest processors have four cores, though
manufacturers like Intel and AMD have released
roadmaps for octal core processors by 2009. And
then the stage will be set for 12, 15, 25…..

With all these cores in a tiny sliver of silicon,
networking and data transfers between cores in
the die will need to have a quantum change.
Unlike today’s processor architecture where
running different applications means that the
processor switches rapidly between them, future
designs with say, 100 cores will have separate
cores devoted to individual processes. This
means that encryption would get the attention
of one core, video encoding would be the
domain of another one, gaming will be handled
by the third…you get the drift. In such a scenario,

Hurrying Data Along
The society of
the future will
depend on fast
networks more
than ever before.
Here is a look at
that future

A comparison between the data flow rates in DDR2 and TBI

Chaitanya Surpur 
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Can a human
body live
24/7/365 in a
state where
strong wireless
fields blast
through every
mitochondrion in
living cells?

smart console to manage all these intelligent
ports and regulate bandwidth. This is still in the
planning stage, but there is a working prototype
expected in about three years.   

Personal Networks
Networks in the future will get more personal.
Not the kind of personal as in Bluetooth or PAN
(Personal Area Networks), but personal as in data
packets getting exchanged between different
organs in a living body. Some researchers have
suggested that future human beings could have
tiny chips implanted inside their bodies which
would be linked to the Internet. Consider:
patients with heart conditions would have
Internet-enabled pace makers implanted in their
hearts. No matter where these people are, the
pacemakers would keep sending data to a central
server where doctors would monitor the condi-
tion of the heart in a real time. In the future, we
would be cyborgs, our bodies carrying tiny sili-
con chips that would keep a constant touch with
chips in other people. This has already been
attempted by Kevin Warwick—a professor of
Cybernetics at University of Reading—who has
implanted a chip in his hand. It was connected to
the Internet, and the purported aim was to move
the hand using commands sent online. Though
the experiment failed—Warwick had to take the
chip out after two months—it is a picture of what
could be. 

Even if we manage to wire our bodies up to
the Internet and exchange data packets with
each other, there are several moral dilemmas
that have to be overcome. One of them is obvi-
ously privacy: already the proposal to implant
RFID chips on criminals and sex offenders in the
US have been met with strict opposition from
civil rights activists, who fear the technology
could be misused for other, less ethical
purposes—think about dictatorships implanting
these chips on dissidents. Apart from that, there
are other technical problems to sort out—can a
human body, for instance, live 24/7/365 in a state
where strong wireless fields blast through every
mitochondrion in living cells? Would we see new
diseases, or newer tumours? And what about the
strain on routers and servers who would see an
incremental jump in data transfers? That’s
where newer protocols come in. 

The Infrastructure
We’ve talked about all the forms and functions of
the networks of the future, but what about the
basic architecture behind it? That has to change if
networks are to wow us with this ubiquity. Since
networks are made up of protocols, these proto-
cols have to change for evolution to take place.
IPv4, the current Internet Protocol which
governs, among others how IP addresses are
distributed will pave way for newer generation
IPv6 with a much larger address space. This
address space will be sorely needed when we start
giving pacemakers and toasters IP addresses. 

Some of the newer research activities are
aimed at finding a replacement for the venerable
TCP and UDP protocols. One of TCP’s major limi-
tations is that if a packet is lost on its way to you,
the protocol prevents you from receiving any
more packets till the lost packet is re-transmit-
ted. This is quite nice for sequential data, but
awful for video and voice, where the benefit of
continuous transmission outweighs the draw-
back of a lost frame or a skip in audio. This is
where UDP came in, but it’s not as reliable, so it
isn’t good for anything but video.

Some probable candidates and complements
are TCP/UDP with Bigger Addresses (TUBA),
Simple Internet Protocol (SIP), Internet Protocol
Next Generation (IPNG), Connectionless Network
Protocol (CLNP) and CIDR (Classless Inter Domain
Routing).  Some of these are on paper, others are
being tested in a restricted environment. 

Future Shock?
From the domains of science fiction to being
tantalisingly within our grasp, ubiquitous
computing and networking has come a long
way. Most of its promises are way off the mark
even today, and early visionaries were being a
tad too hasty when they were predicting the
rise of machines that would do everything from
talking out the trash to driving buses. We are,
however inching slowly towards that, and
maybe will arrive in such a world in a century
and half. Until then, it’s only fair to hope that
we get that broadband connection deliver on its
promised speeds so that there are no coffee
breaks in the middle of the YouTube video. Not
too much to ask, is it? 

bhaskar_sarma@thinkdigit.com  

Pandora’s Box

With the entire hullabaloo over networks, security is going to be one of the biggest
headaches. Network security has always been a game of cops and robbers, with

security applications needing to play catch up to threats. A Denial of Service (DoS)
attack will no longer mean that you would be unable to access the effected Website;
in the future such attacks might even cost lives. Just take the case of hackers messing
up the server in a hospital which monitors signals from pacemakers and tweaks the
electric signals depending on the cardiac activity: depending on how malicious the
attack is, lots of people are going to have anything from heartache (literally!) to
cardiac arrests. How about computer viruses that affect our implanted gadgets? That
would be like any natural viruses. This will make hackers from being tolerated as
nuisances to becoming as feared and despised as terrorists and gangsters. Apart
from this admittedly extreme scenario we could see networked cars breaking down in
the middle of the road, supermarkets not accepting credit cards or light bulbs
refusing to switch on. Not to mention us living in a world where we could not
communicate with gadgets, or even with each other. Scary thoughts.

The world’s first cyborg, Kevin Warwick implanted a
chip into himself that could connect to the Internet
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Asfaq Tapia

“Inbox” has a meaning: it’s a place where mails have come into, waiting to be read and processed, then 
either discarded or kept in an appropriate place. The 

Inbox was never meant to be a heap of hundreds or even thou-
sands of mails.

It’s not an idle matter of perfection. Consider this. If your 
Inbox is too large, you could spend too much time finding a 
mail you’re looking for – if you know it exists. Second, if there 
are too many mails there, there are probably some important 
ones whose existence you’ve forgotten about – and no appro-
priate action has been taken. Third, if you’re struggling to 
“catch up on your e-mailing,” you’d tend to begin at the begin-
ning – of that huge Inbox, and two things could happen: (a) 
Looking at that heap, you might never start; and (b) If you do, 
your attention would be divided as you juggle between per-
sonal and official mails, less important ones and more impor-
tant ones.

There’s more: if you only use the standard mail folders in 
Outlook (we’re assuming, keeping numbers in mind, that Out-
look is your mail client), and you have too many mails, the file 
could get corrupt (meaning you could lose all of them).

To get to the point, it is this: that it’s desirable to have a trim 
Inbox, well-organised folders, and a ready backup for when 
things go wrong. While talking about all this, we can’t avoid 
the subject of spam, either. And so, while there are many phi-
losophies one can subscribe to on one’s journey to becoming a 
good e-mailer, we’ll keep what follows to the essentials.

A Few Obvious Things
Almost all of e-mail wisdom can be put in three concise lines:
Keep unwanted stuff from getting in.
�What gets in, classify into what needs action and what 
doesn’t.

Enhance

Getting mails in order and cutting that Inbox 
down to size will have a positive impact on your 
life… take it from us!

In 
Place

 Digital Tools l Jumpstart

00
Tools
Digital

Technology For Personal And SoHo Productivity 
10600 Xxxxxx xxxx Xxxxx Xxxxxxx 

xxxxxxx



66 DIGIT January 2008

Digital Tools l Enhance

�For the items that do need action, have a con-
sistent plan; those that don’t, put them where 
they should be.

Perhaps we should add a fourth concise line:
Back up often.
You should formulate a policy for yourself to 

keep things in order, but we’ll tell you a couple 
of things just so you’re aware that you don’t 
have a proper policy in place!

First off, constantly being alerted of new 
mail is a distraction. We’ve gotten used to it, but 
ask yourself if you really need Outlook to check 
for mail every five minutes – and whether you 
need to be notified each and every time. Chances 
are you don’t. You’ll deal better with e-mail if 
you give it a time and a time-slot. (Only you can 
decide whether you need that to be twice a day 
or six times.) It’s a generalised suggestion, but 
how about choosing to only be alerted to impor-
tant mail – that is, mails from a certain sender, 
or those with a certain subject line?

Now, for when you do sit down to “deal” with 
your mail, you can reduce some of the clutter 
immediately: look at the list of unread e-mails 
and quickly respond to those that demand just a 
couple of lines. Let those not remain on the list 
– and in your head. To reduce the clutter a little 
more, delete what you’re not never going to deal 
with. Accept it: you’ve got a hoard of e-mails that 
you’re never, ever going to respond to or take 
some action upon, but they’re there. Learn to 
decide what items belong in this category, and 
delete them when they arrive.

Well, here’s a gentle way out (because we 
know it hurts): spend some time right now and 
move all such items to a newly-created folder 
(more on this later), take a backup (more on this 
later), then delete them forever. Three months 
down the line, look back on whether you needed 
them! Cases in point: forwards you’re not going 
to read. Newsletters you’re not going to read. 
Social networking requests you’re not going to 
respond to…

Of course, keeping spam out is rather more 
than half the story. We’ll come to that in a 
while.

Folders And Files
If you’ve never bothered to organise your 
Outlook folders and have left them at the 
default, you probably have one very large file 
that contains all your mails. This .PST file (like 
we said) could get corrupted, and Outlook 
could take longer to open. Then there’s the 
matter of good organisation: if you split your 
mail into multiple .PST files, you can choose to 
open only the one(s) you want – and you’ll see 
them listed separately in the folder list on the 
left. If you have sub-folders, you’ll get smaller 
lists when you expand a particular folder than 
if you had one, large folder.

Let’s take a typical scenario and say you 
have three kinds of mails – Work, Personal, and 
Newsletters. Right now, they’re all in one .PST 
file (unless you’ve archived some of them). What 
you need to do is create two more. Go to File > 
New > Outlook Data File. Supply a filename, and 
you’ll get the options to set a password for it, 
and to name it. This name – say “Personal” - is 

what will show up in Outlook. To avoid confu-
sion, you might want to keep the filename and 
this name the same.

The newly-created file will open up immedi-
ately in Outlook, unpopulated, of course. Move 
your “personal” messages into this one by drag-
ging and dropping. (Before that, if you’d like, 
you can create sub-folders by right-clicking on 
the name and choosing the appropriate option.) 
Then, you can choose to close it (again, by right-
clicking on the name). Whenever you need to 
open it, you just do File > Open > Outlook Data 
File.

When you try to open an Outlook Data File as 
above, Outlook will look for files in the default 
location – note that path. Later, in Explorer, 
look under that folder, and you’ll see all your 
.PST files. Back these up on a regular basis, very 
preferably to a different hard disk or to DVD. 
You’ll be able to use them after you re-install 
Windows or Office – or on a different com-
puter. Restoring the files to a new installation 
of Outlook is as simple as it gets: choose File > 
Import and Export..., then select Import from 
another program or file. Click Next. Highlight 
Personal Folder File (PST) and click Next again. 
Say Browse, and select the .PST files you want 
to recover. (Make sure you’ve selected Replace 
duplicates with items imported.) Then click Next 
and Finish.

The Clean Inbox, #1
The straightforward way to make every incom-
ing message go where it should – the appropri-
ate folder, that is – is to use Rules in Outlook. 
Thankfully, there’s a Rules Wizard.

If you’re hearing the term “Mail Rules” for 

Caption
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the first time, it’s like this: say you want mails 
from your (two) siblings to go into a folder called 
Family. Y ou tell Outlook that if an incoming 
mail has either of their e-mail addresses in the 
“Sender” field, it should automatically divert 
it into the Family folder instead of sending it 
to the Inbox. That becomes a Rule for Outlook. 
Similarly, if you want to be alerted with a sound 
when there’s a mail from your boss, you could 
tell Outlook about that, too. Moreover, it’s not 
limited to the “From” field – R ules could be 
based on a whole bunch of parameters, such as 
what time they arrive, whether they have attach-
ments, whether there are certain words in the 
subject line, and so on.

To use the Wizard, go to Tools > Rules and 
Alerts, and in the E-mail Rules tab, click New 
Rule. You’ll then have the option of going with 
the provided Templates or to “Start from a blank 
rule”. Let’s look at what happens when you start 
from a blank rule and choose to “Check mes-

sages when they arrive” (which is the first thing 
you’ll need to select).

It’s pretty intuitive. As you select your con-
ditions in the top part of the R ules Wizard 
window, your Rule gets “built up” in the bottom 
part. So if you select “with specific words in the 
subject”, those words will appear below – and 
you click on the words “specific words” to define 
those words.

Be sure to go through all the options you’re 
provided with under the conditions to be 
checked for – for example, all mail where your 
name is not in the “To” box could be sent to a 
special folder, which you might want to examine 
only once a day. Then, when you’re done cre-
ating the rule, you could choose to run it on all 
messages in your Inbox right then – do that and 
watch all your mails make their way to the right 
place! (Assuming, of course, that you’ve set up 
the appropriate folders.)

The Clean Inbox, #2
POPFile, many have been saying for years, is the 
best spam filter there is. It needs to be trained 
to recognise spam, but it gets trained pretty 
quickly (if you receive a respectable number 
of e-mails). Now POPFile as it is can be a little 
off-putting in terms of the user interface, but 
there’s Outclass, a little program (which works 
when POPFile is installed) that integrates with 
Outlook as a toolbar.

Space doesn’t permit a complete discussion 
of how to use the Outclass toolbar. We’ll point out 
and clarify a few things here; the easy-to-follow 
(with screenshots) documentation is at www.
vargonsoft.com/Outclass/release-1.2.4.1.aspx. 
Outclass hasn’t been tested by the developers to 
work with Outlook 2007, but it does, it seems.

Outclass isn’t just for spam filtering – the 
idea is called “buckets,” which you can think 
of as imaginary folders. Say you define three 
buckets – Work, Personal, and Spam. Outclass 
doesn’t know that “Spam” is some kind of evil 
thing; when it “reads” a message, it decides 
what bucket it belongs in, depending on how 
it’s been trained. It can then route the contents 
of the buckets to appropriate folders as you’ve 
defined.

In case you’re wondering what “training” is 
about: just after Outclass has been installed and 
a mail comes in, it’s marked as “Unclassified”. 
You use the buttons on the toolbar to classify it 
as Personal, Work, or Spam. The act of doing this 
for many messages is called training... simple 
enough.

There’s a useful feature on the default 
toolbar, called “Safe View”. Some spam contains 
“Web bugs,” which means that if you open it by 
mistake, you could send out a confirmation to 
the spammer that yours is an operational e-mail 
address. When you choose to view a potential 
spam message using the “Safe View” button, 
you’ll view it without triggering the “Web bug.”

At the left of the Outclass toolbar is the Out-
class Options button; in the options dialog, the 
first tab is Buckets and Inboxes. “Inboxes” refers 
to the Outlook folders to be monitored; refer to 
the documentation for this. The Buckets are the 
categories. You can define as many buckets as 
you want, choose whether the button (to clas-
sify mail into a certain bucket) should be on the 
toolbar, and what its name should be.

When you click on the Inbox and then on 
Edit, you’ll get a dialog where you can specify 
what should be done to a message depending on 
which Bucket Outclass puts it into.

Remember...
You could go with R ules, or you could let 
Outclass automatically classify mails for you. 
You might want to do the latter if there are too 
many unspecified people who send you mail. If 
you have a large network of connections, you’ll 
often get mail from people you don’t know, 
and if the only classification you need is, say, 
into Personal, Work, and N ewsletters (apart 
from Spam), Outclass will do the job well. Also 
remember that you could set rules in Outlook 
first, then install Outclass to work only as a 
spam filter.   

Define actions here
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With prices falling and media becoming more readily available, almost everyone can
afford a dual-layer DVD writer. But which one to buy? That’s where we come in...
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Burning Up
FEATURES
Supported Speeds
In our last test, we saw one DVD writer domi-
nate the rest with a maximum write speed for
DVD-Rs of a whopping 20x. This time around,
almost all the drives support 20x writes, with
none going faster, because we seem to have
reached the maximum speeds for DVDs. Only
the ASUS DRW-1814BLT supported a maximum
write speed of 18x, which shoul still be fast
enough for most. What’s funny here is that its
reading speed tops out at 16x—giving us a DVD
writer that can write faster than it reads!

When it comes to DVD-RW and DVD+RW
speeds, all the drives support 8x and 6x respec-
tively. All the speed changes seem to have
occurred in the dual-layer race, and although
all the drives can write to DVD+R DL media at
an acceptable 8x, the Sony DRU-845S is capable
of 12x and the Samsung SH-S203 manages a
whopping 16x! That’s the fastest we’ve seen for
dual-layer burning, ever.

With DVD+R DL media available for as little
as Rs 100, and prices only seeming to fall more,
there’s never been a better time to invest in a
dual-layer burner.

All the drives also feature the ability to
write to DVD-RAM at 12x. The exception was
the ASUS, which claims 14X DVD-RAM write
speeds. DVD-RAM is great for video profession-
als, because you can treat your DVD-RAM drive
as a hard drive—make folders, create files, even
edit them from within the disc, etc.

Jayesh Limaye

It’s that time of the year again, and we set out
in search for all the optical drives we could get
our hands on. Surprisingly, variety doesn’t

seem to be sought after when it comes to DVD
writers, as we only found eight drives to be the
popular choice amongst retailers. In addition, we
also got our hands on a couple of Blu-ray drives to
see what the near future has in store for us.

The Drives
We got DVD Writers from different manufac-
turers. Some drives came from the old warhors-

es such as ASUS, Samsung and Sony, and some
from newer entrants such as Moser Baer and
Philips. In fact, Moser Baer makes its DVD
Writers in collaboration with Lite-On—a famous
brand of DVD Writers. Philips DVD Writers have
been around abroad for many years, and are
now available across India. 

Interestingly, most optical drives are now
SATA drives, and IDE seems to be dying of old
age. The drives we got with the SATA interface
were ASUS DRW-1814BLT, ASUS DRW-2014L1T,
Philips SPD2514T, Samsung SH-S203, and Sony
DRU-845S, while those with the IDE interface
were Moser Baer DH-20A4P23C, Philips
SPD2414T, and Sony DRU-190A.

Availability of media, however, is a rather large
thorn in the format’s side.

Additional Features
The two Philips drives are the only ones to not
allow setting the BookType of DVD+R media
when burning. Setting the BookType allows you
to set the DVD you create to appear as a stamped
DVD-ROM to standalone DVD players. This is
helpful if your DVD player acts finicky when
playing DVD-Video discs that are burnt on PCs.

Just like DVD-RAM, LightScribe is a feature
that is fast losing ground due to waning inter-
ests. Again, expensive and hard to find media
is the cause for this. LightScribe basically
allows you to burn a CD/DVD label on to the
disc, using the same drive that you’re using to
burn data on to it. You can create your own
labels using text, images or both, and this cus-
tom label is burnt to the DVD/CD face using an
additional laser. Only the ASUS drives—the
DRW-1814BLT and DRW-2014L1T—support
LightScribe this time. 

Build Quality
When we talk about the build quality of an
optical drive, it is the tray that we are talking
about. We have no complaints about any of the
trays this time, unlike a couple of years ago,
when this was a serious issue with quite a few
drives. The ASUS, Samsung and the Sony DRU-
845S seem to have the best trays and load/eject
mechanisms. Another thing to note here is that
the ASUS, Moser Baer, and Samsung drives were

We have no 
complaints
about any of the
trays this time,
unlike a couple
of years ago

The drives were connected to the second SATA port or set as
master and connected to the primary IDE channel, according

to the type of the drive. The test process consisted of two
sections: writing to and reading from different types of media.  

The Reading Tests
Nero CD-DVD Speed was used to note the data transfer rates,
access/seek times, CPU utilisation, burst rate, etc, for CDs as
well as DVDs. This comes bundled with Nero 8 Ultra.

SiSoft Sandra Pro Business 2007, which is a system-wide
performance benchmark as well as diagnostic utility, was used
to measure the DVD read speeds and access times.

dbPowerAmp, an audio format conversion and CD ripping tool
was used to rip three audio tracks of our test audio CD, located
at different positions on the CD. The tracks were ripped to 44
KHz MP3 format at 128 Kbps, and the time was logged.

DVD Decrypter is a tool used to rip DVD video files to the hard
drive. This was used to rip a select chapter (a .VOB file, 1 GB

located towards the middle of the media) of our test DVD to the
hard drive, and the time taken for this was noted.

The Writing Tests
These included logging the time taken to write to CD-R, CD-RW,
DVD-R, DVD+R, DVD-RW and DVD+RW. An assorted data of 700
MB—the latest Digit CD—was used to write to CD-R, CD-RW and
DVD-RW and the time was logged. Sequential data consisting of
a 700 MB file—the same Digit CD zipped without compression—
was used to write to a CD-R. Similarly assorted and sequential
data of 4.38 GB was used to write to DVD-R and DVD+R media
and the time taken for this was noted.

The Media
The media used were 52x CD-R from Moser Baer, 10x CD-RW
from HP, 16x DVD-R from Sony, 16x DVD+R from Sony and 4x
DVD-RW from HP. A point to note is that most of the DVD-
Writers can burn DVDs at speeds in excess of 16x, but since
such media is unavailable, the 16x media was burnt at the
highest supported speed. We used Moser Baer DVD+R DL for
dual layer media write test and an assorted data of 8.5 GB was
burnt to these at their certified speeds of 8x where possible.

Other Features
Other features such as support for various DVD types,
LightScribe capability, capability to set Book Type, tray build
quality, silent operation and bundled accessories such as data
cable, media, bezels, etc., were also noted and rated to derive
the final score. Please note that the specified read and write
speeds were not rated, instead we rated the read and write
speeds in real world tests.

How We Tested

47

Processor
RAM
Motherboard
Graphics Card
Hard Drive
Power Supply
OS
Burning software

Intel Pentium 4 540 3.2 GHz
1 GB of 667 MHz DDR2
ECS PF5 Extreme
NVIDIA GeForce 7300GS
Western Digital 80 GB SATA-II
Antec Neo480 480 Watt
Windows XP Professional SP2
Nero 8 Ultra Edition

Test Rig
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the quietest when burning, which makes them
better suited for HTPCs.

Bundled Accessories
With attempts to make optical drives dirt
cheap, this is one area where all manufactur-
ers are cutting costs, and as a result, the bun-
dles are miserable. Samsung drives are the
only drives that come with SATA and power
cables, the rest expect you to buy these your-
self. The ASUS DRW-1814BLT comes with two
LightScribe discs, so you can try out the tech-
nology before deciding to buy any more
media—which isn’t exactly cheap.

Sony DRU-845S
Fancy looker

SiSoft Sandra Pro Business 2007
The SiSoft Sandra file transfer index reconfirmed our pre-
vious test, with most of the drives scoring between 12 and
13 MBps, with the ASUS drives lagging with just 10 MBps. 

Audio CD And DVD Ripping
Finally, one of the ASUS drives decided to put up a fight!
The ASUS DRW-1814BLT was the fastest at ripping the
audio CD—taking just 39 seconds—miles ahead of the rest.
There was no conclusive winner in the DVD ripping test,
with most drives completing the task in around a minute.
The ASUS DRW-2014LT was the slowest—it took just under
two minutes to rip the DVD file.

Writing
Media Compatibility
We faced certain media compatibility issues with some of
the drives, despite using certified media that is commonly
available and popular.

As far as rewriteable media is concerned, there were no
issues with any of the drives. CD-Rs did have some issues—
while most drives supported 48x and recognised the 52x
certified media at this (48x) speed, some such as the Sony
DRU-845S and ASUS DRW-1816BLT could only recognise the
media as 40x and 24x respectively.

Only the Moser Baer drive could recognise the DVD-R as
20x, while both the ASUS drives recognised it as 16x, and
this affected their performances. The rest of the drives
could recognise the DVD-R as 18x. When it comes to our
DVD+R media, most drives correctly recognised it as 16x—
except for the Moser Baer and Sony DRU-190A, which
reported the media to be 18x.

On the software front, Nero 7 Essentials is
the burning software of choice for all manufac-
turers, while only Samsung bundles Nero
Express 7. There is no separate DVD playback
software bundled anymore because Nero
Showtime is a part of the Nero package and can
play even HD movies. Samsung’s decision to
bundle Nero Express 7 gets it some brownie
points here because you also get Nero BackItUp
(backup utility) and ReCode (video encoding) in
addition to all the regulars that Nero 7
Essentials contains. Only the ASUS DRW-
2014L1T and the Sony DRU-845S come with
extra bezels to let you change the colour of the
drive to match your cabinet. 

PERFORMANCE
Reading
Nero CD/DVD Speed
All the drives performed well in this test and
did not show any abnormal drop in read
speeds during any part of the test. Most of the
drives lingered around average speeds of
about 12x for DVDs, but the ASUS drives
underperformed with 9x. In the CD speed
tests, the Moser Baer drive and Sony’s DRU-
190A ruled the roost with 37 MBps. The rest of
the drives managed around 30 MBps. A burst
rate of over 60 MBps for DVDs was typical for
all the SATA drives.

Moser Baer DH-20A4P23C
Almost a winner

Philips SPD2515T
Expensive performer

Blu-ray Newcomers

Next-gen optical drives featuring blue lasers have been
launched in India well over a year ago, but have found it hard

to get a footing. The reason is the excessive price and
inaccessibility of the media. Our test labs received just one Blu-
ray drive last year and no HD-DVD drive. This year too, the
picture did not change much. We received two Blu-ray drives—
ASUS BC-1205PT and Sony BWU-200S. While the Sony can read
as well as write to Blu-ray media, the ASUS is a combo drive and
its capabilities are limited to only reading from such media.
Nevertheless, both drives are completely backward compatible
and can write DVDs as well as CDs.

Both drives sport attractive-looking black bezels with the
Blu-ray logo. We found that the tray mechanisms of these
drives was noticeably different from conventional DVD writers
that we tested—it seemed more rugged and slid precisely and
smoothly. They come with a SATA interface and feature an 8
MB buffer, necessary for smooth HD playback.

The Sony BWU-200S can write to BD-R and BD-RE media at
4x and 2x respectively. While the Sony sports a DVD writing
speed of 16x, the ASUS can do just 12x—too slow when you

consider that 20x is the
norm today. It

took the Sony around six minutes to write to a DVD, which is
par for the course, while the ASUS was understandably slower
and took over seven minutes and ten seconds. In the Nero
DVD Speed read test, the Sony clocked 12.29x, which is a good
score, while the ASUS lagged behind with just 9.44x.
Unfortunately, we could not test these with BD media—none
are available.

Both these Blu-ray drives come with CyberLink BD Solution
suite—a full-fledged suite of applications that consist of
CD/DVD/BD burning application, HD playback software,
backup tools, as well as video authoring and editing
application PowerProducer. The ASUS BC-1205PT is priced at
Rs 15,500, while the Sony BWU-200S costs a whopping Rs
38,000, making both this drives out of reach of most mortals.
We fail to justify the absurdly high price tag and just cannot
recommend any of these. We suggest that you wait and watch
as the prices are slated to plummet in the next few months.

Asus BC-1205PT
‘Combo’ is the keyword

Sony BWU-200S
As expensive as a high-end PC!
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BRAND 
MODEL

Price (Rupees)
Comments

Total (Out of 100)
Features (Out of 35)
Performance (Out of 65)
Features
Drive Specifications
Write Speeds

DVD+R/-R (X)
DVD+RW/-RW (X)
DVD+R DL/-R DL/-RAM (X)
CD-R/RW (X)

LightScribe/BookType (Y/N)
Interface (IDE/SATA)
Data Buffer Size (MB)
Tray Build Quality (Scale of 10)
Silent Operation (Scale of 10)
Package Contents
Data Cable (Y/N)
Manual/Quick Setup Guide (Y/N)
Media—CD/DVD (Y/N)
Software—Burning
Software—DVD Playback
Software—Other
Miscellaneous (Extra Bezels, Etc,)
Performance
READING TESTS
Nero CD/DVD Speed (DVD)
Avg. Transfer Rate (x)
Random Access/Seek Time (s)
CPU Utilisation (4X)
Burst Rate (MBps)
Spin Up/Down Time (s)
Eject/Load Time (s)
Recognition Time (s)
Nero CD/DVD Speed (CD)
Avg. Transfer Rate (x)
Random Access/Seek Time (s)
CPU Utilisation (8X)
Burst Rate (MBps)
Spin Up/Down Time (s)
Eject/Load Time (s)
Recognition Time (s)
SiSoft Sandra Pro Business 2007 (DVD)
Drive Index (MBps)
Access Time (ms)
Audio CD Ripping—dbPowerAmp (s)
DVD Video Ripping—DVD Decrypter (s)
WRITING TESTS
CD-R Assorted/Sequential (s)
DVD-R Assorted/Sequential (s)
DVD+R Assorted/Sequential (s)
DVD-RW 700 MB Assorted (s)
DVD+R DL (s)

Scoreboard                      DVD Writers
ASUS

DRW-2014L1T

Rs 2,100
+ None in particular

– Media compatibility

62.54
21.49
41.05

20 / 20
8 / 6
8 / 8 / 14
48 / 32
Y / Y
SATA
2
8
8

N
Y
N / N
Nero 7 Essentials
Nero ShowTime
None
Black bezel

9.07
19
14 %
60
1.1 / 2.11
1.56 / 1.74
17.74 s

30.93
16
3 %
43
5.69 / 1.77
1.6 / 1.03
14.97 s

10 
83 
47.5
113.9

235 / 236
368 / 369
364 / 366
152.7
1146

ASUS
DRW-1814BLT

Rs 1,850
+ Good bundle

– Media compatibility

65.04
22.33
42.71

18 / 18
8 / 6
8 / 8 / 14
48 / 32
Y / Y
SATA
2
8
8

N
Y
2 LightScribe CDs
Nero 7 Essentials
Nero ShowTime
None
Leather CD Pouch

9.08
19
16 %
61
4.02 / 2.8
2.28 / 1.05
17.9 s

30.93
16
3 %
44 
2.91 / 2.9
2.15 / 1.04
15.27

10
93
39.1
78.1

230.2 / 231.5
439.8 / 444.3
363 / 371.8
151.4
1147

Moser Baer
DH-20A4P23C

Rs 1,350
+ Performance, inexpensive

– None in particular

67.41
17.64
49.77

20 / 20
8 / 6
8 / 8 / 12
48 / 32
N / Y
IDE
2
7
8

N
Y
N / N
Nero 7 Essentials
Nero ShowTime
None
N

12.17
3
33 %
26
1.81 / 3.34
1.49 / 1.43
15.19

37.16
3
12 %
22
5.5 / 4.88
1.49 / 1.35
11.07

13
115
44
65.1

163.8 / 167
326.8 / 307
339.4 / 325.6
141.4
1144

Philips
SPD2414T

Rs 2,990
+ Good performance

– Too expensive

66.42
16.03
50.39

20 / 20
8 / 6
8 / 8 / 12
48 / 32
N / N
IDE
2
7
7

N
Y
N / N
Nero 7 Essentials
Nero ShowTime
None
N

12.11
3
24 %
26
1.66 / 3.33
1.58 / 1.02
13.44

31.46
3
7 %
17 
1.76 / 2.68
1.58 / 1.03
9.35

12
85
51
57.5

175.3 / 173.8
312.9 / 310.6
346.8 / 339.3
136.8
903

Philips
SPD2514T

Rs 3,190
+ Good performance

– Too expensive

67.60
17.15
50.45

20 / 20
8 / 6
8 / 8 / 12
48 / 32
N / N
SATA
2
7
7

N
Y
N / N
Nero 7 Essentials
Nero ShowTime
None
N

12.16
3
13 %
66
1.65 / 3.25
1.63 / 1.02
12.88

31.55
3
4 %
27
1.74 / 2.67
1.64 / 1.02
9.45

12
106
49.9
59.4

181.2 / 178.7
310 / 309.7
345 / 345
148.9
906

Samsung
SH-S203

Rs 1,200
+ Performance, inexpensive

– None in particular

76.64
24.64
52.00

20 / 20
8 / 6
16 / 12 / 12
48 / 32
N / Y
SATA
2
8
8

Data, Power
Y
N / N
Nero Express 7
Nero ShowTime
BackItUp, ReCode
N

12.14
3
11 %
68
1.61 / 3.15
1.63 / 1.01
13.26

31.55
3
4 %
29
1.76 / 2.56
1.63 / 1.01
10.15

12 
124
49.5
59.2

169.9 / 169.7
312 / 311.3
310 / 308.2
137.9
903

Sony
DRU-190A

Rs 1,600
+ 20x DVD write speed

– Slower performance

67.21
17.43
49.78

20 / 20
8 / 6
8 / 8 / 12
48 / 32
N / Y
IDE
2
7
7

N
Y
N / N
Nero 7 Essential
Nero Showtime
None
N

12.12
3
26 %
25
7.88 / 4.26
1.57 / 1.66
15.38

36.91
3 
12 %
17
2.48 / 2
1.51 / 1.62
12.02

13
114
51
60.4

168.2 / 167.9
312.5 / 311.5
330.2 / 323.4
140
1018

Sony
DRU-845S

Rs 1,750
+ Good performance

– A bit slower in DVD+R

71.00
19.88
51.12

20 / 20
8 / 6
12 / 12 / 12
48 / 32
N / Y
SATA
2
8
7

N
Y
N / N
Nero 7 Essential
Nero Showtime
None
Black bezel

12.14
2
13 %
68
1.52 / 3.13
1.69 / 1.05
12.68

31.43
3
4 %
30
1.74 / 1.29
1.68 / 1.05
9.09

13
119
50
60.3

183 / 182
311.6 / 307
343.6 / 349
138.7
904
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is the reason why they ended up at the bot-
tom end of the chart.

Closing Thoughts
As we have seen, there is not too much that sets
these DVD Writers apart, especially in terms of
writing speeds. What does differ is the prices
and the warranty and service offered. Now we
can’t test how long these drives will last, but
warranty is something you should keep your
eyes open for. 

With falling prices, combo drives (DVD-
ROM/CD writer) have all but disappeared, and
you should refrain from buying one—stick to
DVD writers. Also, because optical drive read
and write speeds are a lot slower than hard
drives, the performance difference between
writers based on interface—SATA or IDE—is
negligible. Most newer motherboards will
have enough SATA ports, so you can safely opt
for a SATA DVD writer—the difference lies not
in the performance, but in the cable clutter.
SATA cables being thinner, your cabinet can
do without wide IDE cables getting in the way
of everything.

The optical drive market is in turmoil
because of the stalemate between the Blu-ray
and HD-DVD camps. With more movie studios
preferring Blu-ray, it could be the format of
the future. This will be good for us con-
sumers, because finally manufacturers will
pick a side and prices will start to plummet.
Only time will tell though, and unfortunate-
ly, for now, Blu-ray drives remain a rarity, and
quite expensive. 

jayesh_limaye@thinkdigit.com

CD Writing
The Moser Baer drive was the quickest in the
CD-R write test, followed closely by the Sony
DRU-190A and Samsung. ASUS drives were the
slowest and this is attributed largely due to
the media compatibility issues that they face.
Sony, Samsung and Philips drives were quick-
er in writing to CD-RW media.

DVD Writing
The Philips SPD2514T was the found to be the
fastest in assorted DVD-R writes, though not
by an especially large margin; it was closely
trailed by the Sony and Samsung drives. The
Moser Baer and Sony DRU-845S were the
fastest in sequential DVD-R write test, taking
just seven seconds over five minutes. The
Philips and Samsung were close behind.
Media compatibility issues dogged the ASUS
drives as they delivered considerably slower
performance. Coming to DVD+R writing, we
found that it was the Samsung drive that out-
performed all the other drives this time, and
by a commanding margin. The slowest drives
were yet again the ASUS drives, but the per-
formance difference was not as much as in
the case of DVD-R writing. Writing to dual
layer media did not change the picture, the
only difference was that the Moser Baer drive
could not keep up with its earlier perform-
ance. But in general, there was not a huge dif-
ference between the performance of the
drives in this case, the leaders here were
Philips, Samsung, and Sony drives.

Winners
If we took a look at raw performance, most of
the drives did fairly well. We took a final call
by taking into consideration, the price. There
was a huge difference between the prices of
DVD Writers—some were priced at a high of
around Rs 3,000, while some were priced 
as low as Rs 1,200. The price was therefore, 
the decider.

Trailing behind the Samsung, the Sony
DRU-845S misses out from topping the per-
formance chart by just a whisker. It comes
with a decent bundle of Nero 7 Essential and
also a black bezel that lets you match its
appearance with your PC cabinet. Boasting of
dual layer DVD write speeds of 12x and priced
at just Rs 1,600, this drive deserves a special
mention here.

Moser Baer was next in line, along with
the Sony DRU-190A—both these drives per-
formed well and were priced well too.
Although the Philips drives performed well—
better than the other drives in some tests—
their prices are unreasonably high, and that

Phone Web siteCompany E-mailBrand

Contact Sheet DVD Writers

ASUS
Moser Baer
Philips

Samsung
Sony

ASUS Technology Pvt. Ltd. 
Moser Baer India Ltd
Philips Electronics India Ltd

Samsung India Electronics Pvt. Ltd. 
Rashi Peripherals Pvt. Ltd.

+91-22-67668800
+91-11-40594500
+91-22-66912325

+91-11-41511234
+91-22-67090909

media_india@asus.com
itsales@moserbaer.net
vishal.d.jamdar@philips
.com
c.serrao@samsung.com 
sony@rptechindia.com

in.asus.com
www.moserbaer.com
www.india.philips.com

www.samsung.com/in
www.sony.com

Editor’s Pick

The award for
the Editor’s Pick as

well as the Best Performer
were swept up by the Samsung
SH-S203. It sports 20x writing speeds for DVD+R and DVD-R and we
were surprised to see that it can write to dual layer DVD+Rs at 16x!
Without any exceptions, this drive delivers top-notch performance and
tops the chart in all the writing and reading tests with all kinds of
media. It took just over five minutes to burn 4.38 GB data to the DVDs,
in both the assorted and sequential test. It completes burning a 700 MB
CD in less than 170 seconds. It excels in the reading tests too, with a
score of 12.14x in Nero DVD Speed. The price of this drive is the lowest
amongst the lot—just Rs.1,200 and yet it comes with a great bundle that
includes SATA data and power cable as well as Nero Express 7 suite,
which includes DVD playback, data backup as well as video encoding
software. We were left with no choice but to award all the awards to the
Samsung SH-S203.

Samsung SH-S203
The best of all!
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The Y series from Lenovo
is touted as the home

entertainment series—the
good speakers and a few
additional multimedia but-
tons are a step in the right
direction; the plain décor
isn’t! The Y410 is a good-
looking notebook overall,
though—the outer body

panels have a quality
finish, and this 14.1-inch
unit feels sturdy.

The glossy, 1280 x 800
display is clear, crisp and
vibrant, with good contrast
ratio. The keypad offers
good feedback, but it’s a
little squishy. The shortcut
keys are well-laid-out, and

you’ll have no issues
with using the nifty
little add-on keys like
the volume adjust-
ment, mute, or even
the “Novo” key,

which switches between
power modes to optimise
battery or performance.
There is a neat array of
multimedia keys that
allows you to listen to
music without logging in to
Windows (after inserting an
audio CD). 

The Y410 is available in
configurations including a
speedy Core 2 Duo T7100
(1.8 GHz) and an NVIDIA
GeForce 8400M GS with
128 MB of video RAM.

The one we received
had a Core 2 Duo T5450
and Intel’s GMA 950
graphics solution, which is
good enough for most mul-
timedia work, including
HD movie playback; just
don’t expect to game
without a graphics card.

With an overall PC Mark
2005 score of 3251, a 3D
Mark 2005 score of 673 and
a SiSoft Sandra 2007 drive
Index of 39 MBps, the Y410
doesn’t really excite as a
“high-end” product—at
Rs 38,500, it makes sense as
an excellent value solution.
It’s got loads of pre-
installed software; we’d
have liked to see Windows
Vista Home Premium
instead of Basic, though.
Whether you’re looking at a
multimedia notebook, or
something to use in college
or in office—the Y410 has
both your needs and your
wallet covered.

Specifications
Core 2 Duo T5250; 1 GB RAM;
Graphics: Intel GMA 950; 1280 x
800; 14.1 inches; 160 GB HDD,
5400 rpm; Weight: 2.4 kg

The Buffalo MiniStation
TurboUSB 80 GB

portable hard drive is in a
new class of high-
performance external hard
drives featuring the
TurboUSB function that
claims to increase speed.
It’s a laptop SATA hard
drive housed in a tough
black plastic casing
surrounded by cushioning
material that absorbs
shock. One of its major
drawbacks is that it
requires an extra USB cable
for power.

TurboUSB dramatically
increases the drive’s speed;
by default, this is disabled,
but you can enable it using
the accompanying
software. It took 56 seconds
to write 1 GB of assorted
files to the drive in the
normal mode; it could

achieve the same in
TurboUSB mode in just 43
seconds flat—an increase of
23 per cent! TurboUSB isn’t
a drive “mode” as such—it’s
a software implementation,
so you need to install the
utility and enable this
feature on any PC that you
wish to use this drive with,
to get the extra
performance.

The bundled
SecureLockWare software
uses the powerful AES
encryption algorithm to
safeguard your data from
prying eyes. It can not only

encrypt files and
folders, but also
has an option
that lets you
encrypt the
entire drive,
making it
virtually
impossible to access
the contents without
entering the password.
Memeo Backup is yet
another useful tool that
comes with the drive—it
lets you take automatic
and manual backups of
your data on the drive.

The Buffalo MiniStation
TurboUSB 80 GB impresses
with its performance, costs
Rs 3,960, and comes with a
two-year warranty. For just
a little more, you can get a
portable drive with twice
that capacity and a year
more of warranty—that’s

what stops us from
recommending this drive.

Specifications
80 GB 5400 rpm SATA;
Interface: USB 2.0 High-speed;
Dimensions: 12.7 (W) x 2 (D) x
8.4 (H) cm; Weight: 190 gm

Contact: Lenovo India 
Phone: NA
E-mail: directlenovo@in.lenovo.com
Web site: www.lenovo.com/in 
Price: Rs 38,500

We test the latest hardware
and software products 
available in the market

Feature  
Performance
Value for Money
Build Quality
Overall 

RATINGS

Buffalo MiniStation TurboUSB 80 GB
Portability With God Speed

Lenovo Y410 
Y So Plain Looking?

BazaarBazaar

Contact: Advent Infotech Pvt Ltd
Phone: +91-011-41436751
E-mail: anjan@adventelectronics.com
Web site: www.buffalo-asia.com
Price: Rs 3,960

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Genius’ iTempo 800CD is
a product aimed at iPod

users, but it does a lot more
than just playing music
from your ‘pod. There is an
SD / MMC slot and space for
a USB drive as well, so you
don’t have to own an iPod
to use this. Dump some
music on your USB drive or
pop in a CD, plug it in, and
you’re ready to go. It’s also
an AM / FM radio receiver.
The slot-loading optical disc
reader only reads CDs,
though. The drive has no
foam padding to prevent
dust from getting into the
player, and the mechanism
that pulls the disc in is a
little crude.

For a product that will
end up in people’s living
rooms, the iTempo is not
exactly attractive. The body
is heavy and sturdy, but has
a plasticky feel. The blue
backlit screen on the front
looks decent, and the panel
surrounding it has a glossy

finish. The
quality of
buttons and
volume dial is
poor, and the
mesh on the
speakers looks
cheap.

The remote
control has the
same set of
buttons as on the
player, and it
resembles
remotes that came with
some early CD ROM drive
kits—thin, light and very
clunky buttons.

Sound quality isn’t
impressive. The speakers
are a total of 20 W RMS,
which isn’t a lot, but

adequate for the size. You
can use the auxiliary out to
connect to better speakers.
There are a few equaliser
settings, and the only
manual changes you can
make are to the amount of
bass and treble. The menus
and the working of the
iTempo 800CD need some
time getting used to. 

We aren’t impressed by
this product, especially
since it retails at Rs 13,500.
It’s an average performer
and doesn’t make a great

fashion accessory for your
living room either.

Specifications
2.1 Speakers, 20W RMS, AM /
FM Radio Tuner, SD/MMC and
USB supported, Antenna and
remote control supplied.

Genius iTempo 800CD 
A Costly iPod Dock That Fails To Impress

Contact: KYE Systems Corp  
Phone: 011-41580611
E-mail: sales_india@geniusnet.
com.tw
Web site: www.geniusnet.com
Price: Rs 13,500

Feature  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Based on NVIDIA’s new
MCP 73 platform, the

P6NGM is a mid-sized PCB. It
supports all Core 2 Duo and
Core 2 Quad processors;
there are 2 PCI slots, 1 PCIe
x16 slot for a discrete card, 2
memory slots, and 4 SATA

ports. The P6NGM supports
1333 MHz FSB (officially) so
all Penryn dual- and quad-
cores should work fine. A
4-pin CPU power connector
defies the new 8-pin stan-
dard. The onboard graphics is
a GeForce 7050 solution—

D-Sub and HDMI connects
have been provided as well. 

Specifications
NVIDIA MCP 73 chipset; 1 x16
PCIe, 2 x PCI, 1 x PCI X1 slots; 4 x
SATA 2.0, 1 x IDE ports, 1 x D-
Sub, 1 x HDMI connect

MSI P6NGM
Another HTPC Candidate!

Features  
Performance 
Ease of Use
Value for Money
Overall 

RATINGS

Contact: Micro-Star International
Phone: 011-41758808
E-mail: sanyam@msi-india.com
Web site: www.msi-india.com  
Price: Rs 8,500
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The first time we saw the
1 GB badge on the Palit

8500GT, we did a double-
take to make sure—this is a
lot of memory to waste on a
core that has 16 stream
processors (half the number
on the 8600GT). We figure
half this memory will just
be sitting around doing
nothing—after all, we’ve

seen most 8600GTs with 256
MB of memory working fine
with huge textures. 

The card does with a
minimal cooling setup—
circular heatsink with an
embedded fan—but then the
8500GT is a very cool
customer. Benchmarking
the Palit 8500GT showed us
that our initial reactions

were right. The Core doesn’t
really have enough
horsepower to keep all that
memory busy. However, at
higher resolutions we were
able to get a couple of extra
frames compared to other
8500GT cards.

Rs 5,250 doesn’t seem
much for a 1 GB card, but
an 8600GT will outperform
the Palit 8500GT Super+ by
around 200 percent and

cost just Rs 1,500 more. We
wouldn’t recommend this
card to a gamer, and
neither to someone looking
for an HTPC. Look for 256
MB of RAM—its all you’ll
need in this category.

Specifications
GF 8500GT chipset; 16 Shader
Units; Core: 450 MHz; Memory:
800 MHz; 1 GB video memory

Palit 8500GT Super+ 1GB
1 Gig Too Much?

Contact: Mediaman Infotech Pvt Ltd 
Phone: 022-23828100 / 23823100 /
011-26293001 / 3002
E-mail: dinesh@mediamangroup.
com / himanshu@
amigointernational.biz
Web site: www.palit.biz/en/
Price: Rs 5,250

Features  
Performance 
Bundle
Value for Money
Overall 

RATINGS

BrowseControl is an
Internet management

tool with an easy to use
interface that gives you real-
time control over multiple
computers on a network.
The installation is rather
simple—you first need to
install the package on the
machine that will be the
main machine. The client
installer can be installed
over the network or manu-
ally by installing the pro-
gram on every client
machine.

Client machines are
assigned to groups, and per-
missions for groups can be
set, which will affect all the
machines in that group.
This way, you can allot all
members of a team in one
group and give suitable per-
missions to each group
depending on requirements.
Most of the features and
permissions are (obviously)
to do with the access to
Internet sites. Access to sites
and permissions to down-

loading certain file formats
can be denied. Other than
that, external storage
devices like CD/DVD drives
and USB drives can be dis-
abled by a couple of clicks.
Machines can also be
forcibly shut down. 

An interesting thing
with BrowseControl is that
there are no traces of the
software running, so users
on the client machine will
find it a bit difficult to
bypass the software. The
other good thing with
BrowseControl is that it
allows you to set multiple
time schedules for pretty
much everything—you can
even ensure that certain
programs cannot be run
during the day, for example.

This software is fairly
easy to use and the
Windows help file is there
for those who still need it.
It has a good explanation
of all the features along
with screenshots making it
even easier.

BrowseControl would be
perfectly fine for cyber-cafés
or smaller educational insti-
tutions. It can also be imple-
mented in bigger offices

where strict Internet access
permissions need to be
implemented.

Specifications
Requires Windows 2000 /
2003 / XP / Vista

BrowseControl 3.1
Basic Network Administrating Utility For The Cyber-Café Owner

Features  
Performance 
Ease of Use
Value for Money
Overall 

RATINGS
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XFX’s “serious gamer”
Alpha Dog Edition is
here, featuring all the

128 shader units it’s
supposed to. The only thing
distinguishing it from the
GTX / Ultra models is the
256-bit memory interface.

The card features a core
factory overclocked to 678
MHz (the default Core is
650 MHz), and here’s where
the fun begins—the core is
now faster than an
8800GTX, and the scores
show it. Shader clocks are
also up to 1700 MHz from
the default of 1625 MHz. Of
course, the 8800GTS Alpha
Dog still has the restriction
of 16 ROPs (Raster
Operations), as opposed to
the 24 ROPs on the GTX /
Ultra cards.

Nevertheless, this card
has some serious
horsepower, and runs

noticeably cooler than the
8800GTX and Ultra cards;
it’s a lot shorter, too—9.5
inches opposed to 11 inches
on the older cards. Priced
lower than its older sibling,
running cooler and
basically having less power
requirements seems like
the XFX 8800GTS 512 Alpha
Dog Edition has all the
accolades in its kitty.

Lost Planet is a sweet
bundle. At Rs 25,000, the
XFX is costly now. Yes, it’s
around Rs 5,000 cheaper
than the cheapest
8800GTX, but the new
8800GT core changes
things considerably. Eighty-
five per cent of the
performance at nearly half
the price! This card is a
mite too expensive to be of
any use to the discerning
gamer who will likely buy
two 8800GTs for a little

more than the price of a
single 8800GTS, and use
them in an SLI setup.

Specifications
128 Shader Units; Core Speed:
678 MHz; Memory: 2,000 MHz;
Memory Bus: 256 bits

The 8800GT Sonic utilises
a very simple and

radically different cooler
from the stock NVIDIA
cooler, and isn’t bad for it.
Though not as attractive, a
simple circular heatsink and

a large embedded fan do get
the job done better. The
heatsink extends to strips
that run over the memory
chips, passively cooling
them. Temperatures are
around 15 degrees less than
the stock cooler, meaning

Palit has really got the
Sonic’s thermals spot on!
Tomb Raider Anniversary is
bundled—sweet for all the
Lara Croft fans floating
around.

The 8800GT Sonic proved

to be a pleasure to test. It
comes really close to
embarrassing its older
siblings at half the price,
even less. For reference,
we’re throwing in our stock
8800GTX for a real
comparison. We’ve used the

highest settings that gamers
are generally likely to use—
4x AntiAliasing and 8x
Anisotropic Filtering have
been enabled; all other
settings are at their
maximum values.

Priced at Rs 14,750
(chances are you’ll get this
card a bit lower on the
street), the Palit 8800GT
Sonic is an impressive
offering that delivers
performance with a cool
head. If you’re looking for a
fast DX 10 card, buy the

8800GT Sonic without any
qualms—we guarantee
satisfaction. If you’re the
kind who wants to run
games at maximum detail,
invest in an SLI board and
pick up two of these.

Specifications
112 Shader Units; Core Speed:
600 MHz; Memory: 512 MB;
1800 MHz; Bus Width: 256-bit

XFX 8800GTS Alpha Dog Edition
Pull Her Dog Tags Mate…

Contact: Mediaman Infotech Pvt Ltd
Phone: 022-23828100 / 23823100 /
011-26293001 / 3002
E-mail: dinesh@mediamangroup.
com/ himanshu@
amigointernational.biz
Web site: www.palit.biz/en/
Price: Rs 14,750

Features  
Performance
Value for Monery
Bundle
Overall 

RATINGS

Features 
Performance
Bundle
Value for Money
Overall 

RATINGS

Palit 8800GT 512 Sonic
Sonic Boom!

Contact: Rashi Peripherals Pvt Ltd
Phone: 022-67090909
E-mail: xfx@rptechindia.com
Web site: www.xfxforce.com
Price: Rs 25,000

Contact: Codework Solutions Pvt Ltd
Phone: 0484-4055678
E-mail: india@codework.com
Web site: www.browsecontrol.com
Price: Rs 1,001; 5-user: Rs 2,761
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The PIXMA MX318 is the
latest All-in-one (AIO)

from Canon. It is a lustrous
grey with a gloss finish,
along with black; this MFD
does not have the best build
quality—particularly
questionable are the trays. 

The input tray can
accommodate 100 sheets of
paper—just enough for a
SoHo setup. Print
resolutions up to 4800 x
1200 dpi are supported, and
the optical scanner
resolution is 1200 x 2400
dpi—promising remarkably
good print and scan quality.
Sheet-fed as well as flatbed
scanner options are
available. A 30-sheet
document feeder lies hidden
until you flip it open.

The control panel is
fairly simple to use, with
buttons dedicated for each
of the multiple functions.
A single line mono LCD
displays all the necessary
status and settings
information. It features
PictBridge port, but the
absence of memory card
slots was conspicuous. It
connects to the PC via a
USB port, but there is no

network port. It supports
high-speed Super G3 fax,
with 20-destination auto-
dialling; the fax memory
of 50 pages is ample for
most needs.

Print speed is very slow:
it takes over half a minute
to print black text at the
best quality, while printing
the combi-document takes
over a minute at normal
quality and well over
hundred seconds at best
quality. It is relatively faster
at printing photos, taking
just under four minutes for
an A4 photo, and it does a
good job at it with brilliant
colours and good definition.
The black text does not have
clear edges, though it is not
smudged. Combo
documents are printed
relatively better, the colour
part in particular. It even
manages to print yellow
text against a black

background well. Black-and-
white copying takes 28
seconds per page, while
colour copying takes 41. It
does a rather bad job at
this, and the copies appear
washed out.

Canon bundles along
the Scansoft PaperPort
application that lets you
scan as well as manage
documents. It even has OCR
capability, thus saving you
the cost of buying OCR
software. Control Center 3
brings all the features of
the MFD at your fingertips. 

The Canon PIXMA
MX318 has the features, but
doesn’t have the
performance to back them
up, and the considerably
high price tag of Rs 10,995
does nothing to help things
in its favour.

Specifications
Printer: Resolution: 4800 x
1200 dpi (effective); Input tray:
100 sheets

Scanner: Type: Flatbed and
Sheet-fed; Resolution: 1200 x
2400 dpi (optical); Media size:
A4; ADF: 30 sheets

Fax: Speed: 33.6 Kbps; Memory:
50 pages; Speed dialling: up to
20 numbers

General specifications:
Dimensions: 46.5 (W) x 44 (D) x
23 (H) mm; Weight: 8.6 kg;
Power consumption: Standby:
1.8 W; Off: 1.8 W; Max: 16 W

Canon PIXMA MX318
Yay! For Features, Nay! For Performance

Contact: Canon India Pvt. Ltd. 
Phone: 1800-345-33-66
E-mail: info@canon.co.in
Web site: www.canon.co.in
Price: Rs 10,995

Performance  
Features
Ease of Use
Value for Money
Overall 

RATINGS

If you thought Intel’s latest
X48 chipset was really

something, wait till you see
this—we got our socks
knocked off and the tingle
left behind in our toes was
enough to assure us we
were looking at something
radically different. In fact,
this motherboard is so new,
there were no details of it
on the Net as of this
writing.

Presenting the
Skulltrail in its desktop
(yes, Desktop) avatar—Intel’s

D5400XS—a consumer
board featuring dual
processor support, and
four, SLI-capable PCIe
graphics slots, among
other things—but don’t say
that out aloud. The
D5400XS is based on Intel’s
MCP 5400 Northbridge
(MCH), and a 6321ESB I/O
ICH. Somewhere between
lie two MCP 100s from
NVIDIA—that’s what
enables SLI on this board.

With support for 16 GB

of ECC memory through
four DIMMs and the ability
to house two quad-core
processors, the D5400XS is
bound to leave a trail of
skulls in its ponderous
wake...

And it’s a Desktop-
oriented board too—with
Intel’s latest IDT STAC
9274D 8-channel HD-
supporting audio codec, six
SATA ports, two E-SATA
ports, and even nifty add-
ons like power and reset
buttons, and an HDD

activity LED right on the
board. There’s also a two-
digit POST (Power on Self
Test) debugger. The BIOS is
chock-full of overclocking
options—CPU, memory and
FSB overclocking and
overvolting are supported,
and strangely enough,
recommended. All this
makes the D5400XS one
helluva desktop board,
although its overclocking
potential is yet to be seen.
The reason we kept our

shenanigans to a minimum
(despite the fact that Intel
helpfully provided us with

unlocked CPUs) was that at
3.2 GHz, we felt these quad-
cores were close to their
thermal limits. The thermal
specs of these 45nm cores
are even better than the G0
stepping Core 2 Quads we
tested earlier, but we didn’t
want to push anything.

While you won’t really
appreciate the power of
two processors with most
regular tasks, if you’re a
3D designer, animator or
hardcore gamer, you will

definitely appreciate the
sheer horsepower at your
fingertips. With multi-
tasking or even multi-
threaded applications, the
difference astonishes—
especially with the two
QX9775 Core 2 Extreme
processors, which are
basically 45nm, 3.2 GHz
quad-cores. Note that the
pin layout on the board is
slightly different—Socket
771 (LGA) CPUs are
supported. (Regular
Desktop CPUs are in the
LGA 775-pin format.)

Check out our
benchmarks (above) to see
how this monster kicked
hindquarters.

We don’t expect the
D5400XS to break any sales
records—just benchmarks.
This platform may just
kick off in the workstation
market, particularly for
rendering machines, where
the enormous
multiprocessing CPU and
GPU power will be
harnessed better.

The entire platform is
power-hungry. If you’re
looking at SLI, two quad-
cores, and around three
hard drives, opt for a 1000-
watt power supply... Also
invest in a decent air
conditioner—and/or good
aftermarket CPU coolers;
these babies dissipate 150
watts each.

Buy this only if you can
really afford to—at around
Rs 25,000 for just the
board, it’s one of those
luxuries that’ll just add to
your collection of nice
things, right beside the
Rolex and Porsche!

Intel D5400XS
Gross XS-es 

CPU 10208
Memory 5452
Graphics 11918
HDD 5782
CPU Arithmetic (Dhrystone) 114876
CPU Arithmetic (Whetstone) 90840
CPU Multimedia (Integer) 682306
CPU Multimedia (Floating) 372881

Doom 3 (640x480, 1600x1200, 4xAA, 4xAF) 247.6
Doom 3 (1600x1200, 4x AA, 8x AF) 200.6
Far Cry (640x480) 317.67
Far Cry (1600x1200, 4x AA, 8x AF) 154.59

Benchmarks
W Prime (32M) 6.562
PC Mark 2005

SiSoft Sandra 2007

3D Mark 2006:
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they can be undone. Go to Tasks and
Settings > Change Advanced
Settings > Undo & Exclude.
There are tabs for Virus & Spyware,
Browser Settings, and Network
Addresses. Any changes to these
components can be restored by clicking
on the item and clicking Restore or
Restore item to System.

Enabling And Disabling
Automatic Tasks

During a complete PC Tune-up, Norton
360 runs a whole lot of tests, which you
might not want it to do. To disable some
of these, click on Tasks and Settings
> Change Advanced Settings >
Undo & Exclude. For example, if you

don’t want to do a disk backup, you can
uncheck the checkbox for the Backup
task. Click Close when done.

Creating Firewall Rules
Click on Tasks and Settings and

then on Change Advanced Settings >
Firewall Protection Settings.
Here you’ll see two tabs—Firewall
General Rules and Firewall
Program Rules. Firewall General
Rules contains simple rules sets for the
entire system, not for any particular
program. The Firewall Program
Rules screen lets you add your own rules
for a program. All the programs using the
Internet and the network will be
displayed. Click on the drop-down next to
the program and choose from the type of
access you want to assign. If you choose
Custom, a set of rules will be displayed
from which you can choose. Click Add to
add a new rule of your own. Follow the
steps in the Wizard and the new rule will
be created. You can create many rules for
a single program in the same manner.

Exceptions In Detecting
Viruses And Spyware

Exceptions can be made to the different
kinds of viruses and spyware scans that
Norton 360 does on your system. One
such setting exists; you can find it by
going to Tasks and Settings >
Change Advanced Settings >
Virus & Spyware Protection

Settings. Under the Automatic
Protection Settings tab, there is an
option for ignoring low-risk threats.
This is set to Ignore by default, and
you can set it to Automatically
Remove if you want. Click the Threat
Categories tab if you want to disable
any kind of threat if you use different
software to check for those.

SKYPE

For those who aren’t aware yet,
Skype is a dedicated software for
making phone calls over the

Internet to another PC for free, or to
land lines (which requires you to pay a
fee). Here’s a look at a few of Skype’s
important features, and some
recommendations on add-ons.

Checking Audio Quality
Ever wondered what you sound

like to the person on the other end of a
Skype call? Well, you need to make a
call to echo123. First make all necessary
audio setting changes. When you’re
ready to test it out, click on the address
bar at the bottom of the Skype window
and enter echo123. Press [Enter] and
the call will be made. You will be asked
to wait for a beep, after which you can
speak. Your recorded message will then
be played back. You can use this to
tweak your audio recording settings.

Skype Live
A nifty new addition to Skype,

Skype Live allows users to create public
voice chat rooms. You can connect and
talk to people on all kinds of topics.
Such meetings can also be planned well
in advance, and a listing of current
conversations can be found on the Skype
site or from the Live tab right in Skype.

Disable Sound Recording
Normalisation

Skype has a feature that changes the
volume at which your voice is recorded—
depending on any sudden changes in

volume. This, in some cases, does not
work effectively, and could result in low
recording volume. The feature can be
disabled by going to Tools > Options
> General > Audio Settings.
Uncheck the Let Skype Adjust my
Audio Settings box. Here, as you’ll
see, you can also force a volume for the
microphone and speakers.

Using Your PC’s Internal
Speaker As A Ringer

If you’re using a headset for Skype,
there’s no way of knowing if you have a
Skype call when you aren’t wearing the
headphones. An easy trick to use the
internal PC speaker as a ringer. Go to
Tools > Options > General >
Audio Settings. Under the Ringing
section, check the Ring PC Speaker
box and click Save.

Skype On The Move
Like many other software, Skype

can be used as a portable application.
This means you can carry your (personal)
Skype installation around with you on
your portable music player or USB drive.
First install Skype like you normally
would on your hard drive. Then, from
the installed location, which is usually
C:\Program Files\Skype\Phone,
copy Skype.exe to a folder on your USB
drive. Create a folder called Data inside
that folder. Start Notepad, type in
Skype.exe /datapath=“Data”
/removable. Save the file as
Skype.bat in the same folder as
Skype.exe on the USB drive. Run it and
enter the information like you normally
would in a fresh installation. Check the
box for Sign me in when Skype
starts if you want to be able to double-
click on the BAT file and log in
automatically from any computer.

Contact Management
Contacts in Skype are just like in

any other program. You might have a
bunch of friends from school and some
others who don’t have everyone in their
list. Skype allows you to forward these

contacts to others. Select
Tools > Send Contacts.
Hold down [Ctrl] and
click on the contacts you
want to send. In the Send
contacts to field, enter the
contact to whom you want
to send the list. Click Send.

The other interesting
feature people usually miss
out on is Groups. Go to
View > Contact Groups
> Enable Contact
Groups. In the small
Groups bar that appears
above your contact list,
click on the + icon to create

Disable Skype’s control over the volume control if the feature
doesn’t work effectively

Tasks that run automatically can be disabled
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NORTON 360

Even though the competition has
increased in the anti-virus and (in
general) the security software

market, Norton continues to steam
ahead with its variety of suites and
applications. We reviewed Norton 360 a
few months ago and thought it pretty
good. It was a little lighter than most
Symantec products and, more
importantly, it was easy to use for a
newbie. Hidden away behind its
colourful yellow interface lies a few
advanced features, and these are what
we’ll be looking at here.

Backing Up Data To Disc
Backups are important to keep all

your important data safe from virus
attacks. Norton 360 can back up data to a
specified location, even to CD or DVD.
Click on Tasks & Settings, then on
Change Backup Settings. Step 2

here has the Backup Location. Click
on Change and select your CD-Writer or
DVD-Writer drive. Click OK. Choose the
folders to be backed up like you normally
would. This time, when the backup
process starts, the data will be put onto
disc instead of a local hard drive.

Once you’ve activated your copy of
Norton 360, you’ll get free online
storage where you can back up your
data to. In the same window where you
selected the CD / DVD drive as your
backup destination, you’ll also find
Secure Online Storage.

The Controls?
Any newcomer to Norton 360 will

be baffled by the interface—sure, it
looks nice, but there are no clear
buttons for scanning or for any of the
other tasks. Go to Tasks & Settings.
This window has all the functions. To
scan, click the Run Scans link and
choose from the type of scan you want
to run. You can run a custom scan with
only a few checks done by clicking Let
me Choose.

Full Backup
There is a big difference between

the Quick and Full Backup in Norton
360. Quick Backup is used to back up all
the important documents from your My
Documents. The Full Backup will scan
your entire hard drive for important
files to back up. The Complete Backup is
therefore the preferable one. To choose
Complete Backup, click on Tasks &
Settings. Click Change Backup
Settings. At the top right, click on
Full Backup and click Save Settings.

The Full Backup might still miss out
on certain important data that it can’t

detect. In such cases, you can manually
add folders and files by clicking on the
Add a file or Add a folder buttons in the
Backup Settings window.

The Phishing Bar In Internet
Explorer

The Phishing Bar in Internet Explorer is
there to warn you of sites that could
possibly be fakes. Norton 360 refers to
its own database and provides warnings
through the bar. This bar, if you do not
want it, can be disable by clicking on
View > Toolbars > Show Norton
Toolbar. If you want to disable the
Phishing detection feature completely (if
you use a browser not supported by
Norton 360), you can do so by clicking
on Tasks & Settings and then on
Change Advanced Settings. On the
right, uncheck the Transaction Security
box. You can also disable pop-ups and
updates from here if you wish to.

PC Tune-up Schedule
Setting a schedule for the PC

Tune-up is a good idea, we tend to hate
running the whole line-up of scans
when we’re working. It’s best to set a
schedule time or an automatic weekly
or monthly tune-up schedule. Go to

Tasks and Settings, and then click
on Change Advanced Settings from
the menu on the right. Select Task
Scheduling Settings. By default,
the schedule for PC Tune-up is set to
Automatic, and Norton 360 runs the
schedule whenever it finds it suitable.
Click on the drop-down and click on
Weekly or Monthly scans. Choose the
days or dates and the time you want the
tune-up to start. Similarly, a schedule
can be set for the backup as well.

Undo And Exclude 
The Undo and Exclude feature is

implemented so that, should Norton 360
make any drastic changes to your data,

TIPS
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Data backups can be made onto CD or DVDs
as well

Add the Norton anti-phishing toolbar to IE

Scheduling PC tune-up sessions; it’s a good idea
to have the tune-up running when the PC is idle
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mIRC
A quick guide to mIRC, the ultimate IRC client! 

Rossi Fernandes

IRC (Internet Relay Chat) is a real-time
communication system that was

around before the first instant messenger
in 1996. Even today, it is used by commu-
nities of all kinds—from software devel-
opers to gamers.

Development on mIRC is not as
active as it used to be, but it’s still the
tool of choice for IRC users.

Automatically Connecting To Channels
In mIRC, every time you connect to a
server, you need to join a channel to chat
with people in that channel. It can be
irritating to have to type the join com-
mand every time you want to join a
channel. Select Favorites >
Organize Favorites, and click Add.
Enter the channel name with a hash
sign, #linux, for example. Click Add to
choose the network on which the
channel exists, select the server on
which the channel exists, and click OK.
Check Join on connect and click OK.
Next time you connect to the server, you
will be automatically connected.

Another easy way to join a channel is
to create a Windows shortcut to the
channel. Right click on the Desktop (or
any folder, for that matter) and select
New > Shortcut. Enter the location as
irc://ServerName/ChannelName,
for example, irc://irc.freenode
.net/linux. Double-click the icon and
mIRC will join the channel and server.

Highlighting Your Nick
IRC users usually keep their clients in
channels all day, idling. You obviously
won’t be looking at mIRC all the time, so
you’re going to miss out on the conversa-
tions going on (in the channel) that may
have been directed at you. The highlight
feature highlights your nick every time
anyone calls it out. Select Tools >
Address Book, then the Highlight
tab. Check Enable highlight. In the
field for choosing the words that trigger
the highlight, enter $me to have your
nick highlighted. Choose the type of
alerts you’d want—colours, sounds, alert
messages—whatever. Click OK when
done. In the same manner, you can add
more keywords to be highlighted, and
also use wildcards with the words.

Setting Nick Colours
Chat rooms can have hundreds of
people, with many of them chatting at

the same time, so it’s difficult to make
out if your friends are chatting—there
are so many messages scrolling by so
quickly! mIRC can highlight your
friends’ nicks. Select Tools >
Address Book and then Nick
Colors. Check Enable nick colors.
Click Add, then enter the nick you want
to highlight. Set a nick colour from the
drop-down menu and click OK.

Customising Colours 
When you’re staring at channels, the
default black text on a white back-
ground can be distracting. Recent ver-
sions of mIRC come with a few presets.

Click on View > Colors. Choose from
one of the schemes in the drop-down
menu. You can customise the colours as
well; to change fonts, select View >
Font. Select the font and click the
checkbox that says Set as default
channel font (if you want to use this
font for all channel windows).

Creating Your Own Menus
You’ll notice that if you right-click in any
window or on a nickname, there are
menus that allow access to certain func-
tions. You can add your own functions
and menus. Go to Tools > Script
Editor > Popups. Choose, from the
View menu, for which window you want
to create the pop-ups. Enter a name for a
menu or function. To create a submenu,
add a dot in front of the menu name, for
example, .Menu1. To set a function for a
menu item, enter the name of the menu
followed by a colon and the command,
for example, Join Linux:/join
#linux. This will create a menu item
called Join Linux. Clicking it will make
you join the channel called linux. These

menus can be handy for tasks like
quickly switching status, joining chan-
nels, and making actions. Remember,
however, that there’s a lot more that can
be done with mIRC scripting!

Connecting To Multiple Servers
All your favourite channels might not be
on the same server, so you need to switch
servers to join them. Fortunately, mIRC
added support for multiple servers so
users could stay connected on many
servers at once. Go to File > Select
Server. Select the network and double-
click the server you want to connect to.
Check the New server window box.
Click Connect; a new window will
appear, and the connection to the server
will be made. There is another way to
create a new server window while con-
necting to the server—if you know the
exact address of the server. Enter
/server -m irc.ServerName.com.
For example, /server -m
irc.freenode.net will create a new
server window and connect to Freenode.

Undock A Channel Window
The mIRC interface houses smaller
channel windows within it. When you
want to chat on only one of the many
channels you’re on, you can undock the
window from the mIRC interface and
have it run in a full-screen window. Right-
click on the tab you want to undock and
click Desktop. To send the undocked
window back to mIRC at any point, right-
click on the window’s menu and click
Desktop again. 

rossi_fernandes@thinkdigit.com

Have alerts come up when anyone mentions
your name on IRC

Make your own pop-up menus for your
favourite actions 

Undock your favourite channel away from
mIRC’s flooded interface
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them as well. This should allow you to
be able to control Skype without having
it in focus.

Installing Add-ons For Skype
You can enhance the functionality

of Skype using add-ons. Go to Tools >
Do More > Organize your Extras.
Here, you can choose from a categorised
list of add-ons. Some of these might
require that you have Skype Credit. Here
are some that are worth trying; click on
the green Open link on an add-on to
download and install it.

FFDSHOW

f fdshow is a filter that can
be used to decode a huge
number of formats, which

means you don’t have to go
about installing all those codecs
out there. Media Player Classic
and ffdshow work as a great
combo, and we will be using
MPC to demonstrate some of
ffdshow’s features. ffdshow is
constantly under development,
and new releases are brought
out very often. http://ffdshow-
tryout.sourceforge.net/ and
http://www.x264.nl/ are good
sites to find updates for ffdshow. These
updates bring in optimisations like better
support for multi-core processors. If
you’re using the K-Lite codec pack that’s
on our CDs, you’ll have ffdshow installed.

Disabling ffdshow For Codecs
It’s a similar problem for ffdshow

with some codecs (like with some
applications). Certain codecs won’t work
as well with ffdshow as with some others.
Like we’ll soon mention, ffdshow has
quality enhancements settings which can
cause performance drops. To disable
ffdshow for a particular codec, right-click
on the playing video, select Filters >

ffdshow Video Decoder, then choose
Codecs. Under the Decoder column,
click the current decoder and choose a
new decoder for the codec. Restart the
player or the video to check if it works. If
you get a blank output for that format,
follow the same steps and set it to the
previous decoder.

Enabling Deblocking And Other
Quality Enhancements

One of ffdshow’s unique features is the
ability to enhance the quality of video.
Most of the videos we watch are heavily

compressed, and some of them have
pixelation, which is especially noticeable
on large LCD screens. You can reduce this
by enabling deblocking. Right-click on the
playing video and select Filters >
ffdshow Video Decoder. Check the
box that says Postprocessing. To get
an idea of how much the quality
enhancements are affecting the video,
check the Only right half box. Check
one of the processing modes available and
set a processing strength using the slider.
When you’re pleased with the quality,
uncheck the Only right half
checkbox and click the Process whole
image checkbox. Click OK to finish.

Some of these processing methods
can be highly CPU-intensive, so you might
want to select a different processing
method such as fast SPP deblocking.
Lowering the processing strength (by
moving the Processing Strength
slider) can also help.

Changing Contrast Ratios And
Levels

The other type of enhancement can be
done to the colour saturation and
contrast levels of the video. The
parameters can be different from video
to video, but if, generally, you find
abnormalities in the amount of colour,
you can change it. Right-click on the
Media Player Classic window with a
video running, and click Filters >

a new group. You can now drag and
drop existing contacts from your list
into any of these groups.

The Groups feature allows for
flexibility. For example, you can right-
click on a group, say all your
colleagues, and click Start Group Chat.
You can also send contacts and files
(like we mentioned).

Giving Skype Some Style
Skype hasn’t changed a lot through

the years. There are few settings that can
improve on the default look. You can
change the wallpaper (the background
you see on your Skype window). Go to
File > Personalize > Change
Wallpaper. There are many preset
wallpapers you can choose from. Other
than that, you can set a custom
wallpaper by clicking on Browse. You
can choose a plain colour by clicking on
the Pick a preset color radio button and
then using the slider to select a colour.

Enabling Keyboard Shortcuts
Keyboard shortcuts for Skype are

disabled by default; they can be enabled
by selecting Tools > Options. Click
on Advanced and then on Hotkeys.
Check the box that says Enable
keyboard shortcuts. You can change
the shortcuts and enable and disable

Give Skype a makeover!

Deblocking can help reduce the pixelation you see on
highly-compressed and low-resolution videos

The Extras Manager has a showcase of add-ons for Skype
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NiBiTor
Tightening a few nuts in your NVIDIA graphics card…

Rossi Fernandes

NiBiTor, or the NVIDIA BIOS Editor,
does just that: it edits the BIOS of

NVIDIA cards. (Download it from
www.softpedia.com/get/Tweak/Video-
Tweak/NVIDIA-BIOS-Editor.shtml).

Note: Before we go through some of the
important features of NiBiTor, we must warn
you that modifying the BIOS is very risky;
you could end up permanently damaging
your card.

Acquiring And Saving The BIOS
Before editing the BIOS, you need to
first get it from the card. To do this, you
first select the card you want to flash by
going to Tools > Read BIOS >
Select Device. Choose your card and
click OK. Next, go to Tools > Read
BIOS > Read into NiBiTor to have
the firmware loaded into NiBiTor.
Clicking on Read into file will save
the ROM as a file. Choose a location and
click Save. You can load this ROM by
selecting File > Open ROM. You can
load previously saved or downloaded
firmware in the same manner.

Once all changes are done, you will
need to save the BIOS by selecting File
> Save BIOS. Choose a location and
click Save.

Overclocking Functions
The overclocking tab shows the speeds
of the card at different presets that the
driver tells the card to run at. There are
three main settings—3D, 2D, and
Throttle. The speeds you set will be
used instead of the default speeds for
those profiles. Be sure your card isn’t
already running hot. Any drastic change
in speed could physically damage your
card. Enter suitable speeds in the
Extra fields. For this, you could use
overclocking tools such as Rivatuner
(www.guru3d.com/rivatuner/) and
PowerStrip (www.entechtaiwan.com/util/
ps.shtm). When you use them, you’ll get
a good idea of how far you can
overclock your card and monitor its idle
and load temperatures.

Setting Fan Throttling
The controls for temperature levels and
fan speeds can be found under the
Temperature tab. We’ve spoken about
profiles as well as speeds for the core on
those profiles. NiBiTor can also change
the fan speeds depending on the
profile. On the right of the window, you

can find fan speeds for 3D, 2D, and
Throttle. Enter the values as a
percentage of the maximum speed of
the fan. With this, your system can run
quieter when there isn’t heavy gaming
going on. Again, you have to be careful
not to run your fans too slowly,
otherwise the GPU will begin to
overheat. Depending on the type of card
you use, you should see more options in
the Temperature tab in NiBiTor.

Enabling / Disabling Temperature
Monitoring
Temperature monitoring is a feature
you’ll find on most of the higher-end
cards, but it might not always be
enabled on entry-level cards. Modifying
the BIOS could enable the feature. Click
on the Temperatures tab and check the
box that says Enable 6600GT temp
monitor trick. On the other hand, if
you don’t want the temperature to be
monitored (if you want any throttling
feature to be disabled, for example), you
can do it by checking Disable temp
monitoring.

Setting Boot Display Settings
Every time you power up your machine,
there are a few lines of text that appear at
the top of the screen—information about
your graphics card. NiBiTor lets you set
your own custom text and colours—your
name, for example, and other fun bits of
text (you could make it look like you have
an 8800 Ultra). With the BIOS loaded in
NiBiTor, click on the Boot Settings
tab. The OEM Signon tab has a preview of
what the default text looks like. Adv.
Signon has detailed information about

the graphics card. Make any changes, or
put your own text here. If you click on the
drop-down for Boot Display mode,
you can set a resolution, and you’ll have
coloured text instead of the standard
grey using the drop-down menu for text
colour. Click Apply when done.

NiBiTor only allows you to modify
bits of the BIOS; it doesn’t flash the card
for you. Once you’re done tweaking, you
need to use a BIOS flashing tool such as
NVFlash to flash the card. Put NVFlash
on a floppy disk along with the BIOS file
you edited. If you don’t have a FDD, you
can use a USB drive and get DOS
running on it. A software called HP USB
Boot Storage Format Tool can be used to
format a USB drive with a bootable DOS
image on it. (Get it at
http://files.extremeoverclocking.com/file.p
hp?f=197) Use a bootable DOS image to
create a bootable DOS drive. Set the USB
drive as the primary boot disk in your
BIOS. Before writing the BIOS, make a
backup on your drive of the existing one.
This will come in handy if anything goes
wrong during the flashing procedure.

Rescuing Cards
There’s always a chance of ending up
with undesirable results while playing
with BIOSes; problems can also occur
during the flashing procedure. Again,
be extremely careful while modifying
the card’s BIOS, but if you do get it
messed up, you’ll have to use a backup
PCI card to rescue your graphics card—
restore the backup of the ROM that you
took before flashing it. 

rossi_fernandes@thinkdigit.com

The temperature monitor can be enabled on
some cards that have it disabled by default

You can assign speeds for different profiles
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ffdshow Video Decoder. Choose
and check the Picture properties box.
Use the sliders for the Luminance
gain (contrast) and Luminance
offset (brightness) to change the
brightness and contrast. Here, again,
select the Only right half checkbox
from the top of the window to get a
preview of half the screen. Next, move
the slider for the Saturation till you
get a suitable result. When the settings
are done, click OK.

Disabling ffdshow For Certain
Applications

ffdshow can forcibly lock itself to certain
applications and games. This can result
in poor performance or other issues

while playing. One of the biggest
problems was The Elder Scrolls: Oblivion;
people had instability and performance
issues. In such cases, it’s a good idea to
disable ffdshow. (Oblivion is one of several
games that have now been added to the
Ignore List of ffdshow in the releases
that followed.)

Right-click on the playing video and
select Filters > ffdshow Video
Decoder. Click on Info & debug from
the menu on the left. Here, check
whether your application is already
mentioned in the text bar next to Don’t
use ffdshow in. If it doesn’t, click
Edit and then Add to add your
application. Browse to the location of the
program and select the EXE of the
application. Click Open. In the earlier
menu, you can also use a similar
procedure to mention which programs
you want to use ffdshow with as well. 

Saving And Loading Preset
Settings

All the settings you’ve made can be saved
through ffdshow for use at a later time,
for example, on another computer. Start
the ffdshow Video decoder configuration.
Make sure you have all your settings
done, then click on Image settings.
Click on Save to file… to save the
preset. Select a location and give a name
to the preset. To load a preset, click on
Read from file... To create a
completely new preset from a saved
preset, go to New > From file and
select the file. To enable a preset, double-
click on it.

ffdshow can also auto-load a preset
depending on which format or codec

you’re using (or any other parameter). In
the same Image Settings view, check
the box that says Automatic preset
loading. First click the preset you want
to use, then click Preset autoload
conditions. Here, select the
parameters you want to check before
enabling the preset. For example, if we
want all XviD images to make use of a
preset, check the On FOURCC match
box, click the button next to it, and
select XVID from the list. Click OK.

Using Subtitles
A few media players like Media

Player Classic and VLC have support for
displaying subtitles while playing
movies. If you don’t use Media Player
Classic or VLC, then you might not be
able to see subtitles in movies. ffdshow
can enable subtitles in pretty much
every media player.

Go to the ffdshow Video Decoder
window by and check Subtitles. Click
on the File radio button and click on …
to browse and point to the subtitle file,
which may be where you downloaded it
to, or in the same folder if it came along
with subtitles. Select the position where
you want the subtitles to be displayed by
using the Horizontal and Vertical
sliders. To change the style of the fonts,
click on the Font item from the left. Set
a suitable font, shadow, colour, etc. and
click OK.

There are a few more advanced
features. You can set a folder where all
your subtitles are stored—just be sure to
rename the subtitle filenames to match
your video files. For example if your
movie is called MovieTest1.avi, rename
your subtitle file to MovieTest1.srt.
Check the Heuristic search box; it
can help in auto-detecting the subtitle
file. If you don’t mention a path,
ffdshow will look for the subtitles in the
same folder as the video file.

Capturing Images From A
Video

ffdshow does a lot more than image
enhancing—you can have screenshots
taken at regular intervals during a
movie. This can be enabled by right-
clicking on the movie and clicking on
Filters > ffdshow Video
Decoder. Check the box for Grab. Select
at what frequency you want the frames
to be captured. Click on the button next
to Path to select the location where the
images should be dumped. Finally, set a
suitable format and a quality setting.
Click OK and start playing the movie to
start the capturing. To disable the
capturing, uncheck Grab.

Enabling And Using Keyboard
Shortcuts For ffdshow Effects

Effects can enabled on the fly while
playing videos using ffdshow. The
shortcuts are assigned, but not enabled
by default. To enable the shortcuts, start

ffdshow can have issues with some games—it can be disabled for them

Shortcuts are useful in enabling effects
without accessing the menus
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The arrow keys can be used to
control the playback and visualisations.
Use the up and down keys to change the
type of control—playback, visualisation,
volume, etc. Use the left and right keys
to change the value.

A Game In J River Media
Jukebox!

One of the visualisations that come
with Media Jukebox 12 has a game in
it—Pong! By default, the visualisation
has both players as AI, but you can
control the left paddle by pressing [W]
to move it up and [S] to move it down. 

Downloading Podcasts
J River Media Jukebox can manage

and download podcasts and then play
them whenever you want. Click on
Podcasts to access the podcasts
feature. If you know the address of the
RSS feed for a podcast, click on Add
New Feed. Enter a name and the exact
URL for the RSS feed. Click OK. You can
also use Google search to browse and
find podcasts feeds right through
Media Jukebox.

Once you have the podcasts added to
your list, you’ll find them under the
Podcast link to the left. You can choose to
have all the podcasts automatically
downloaded, or you can manually
download the podcasts you want. To
download a podcast, click on the
Download link in the Episode Status
column in the podcast of your choice. To
have podcasts automatically downloaded,
click the Edit This Feed button at
the top. Use the Download drop-down
menu and select All Episodes to
download all the episodes.

Using Smart Playlists
The Smart Playlist is a unique, and

an equally useful feature in Media
Jukebox. It allows you to filter out music
very accurately. So for example, you can
have a list of all the songs in your library
that are 192 kbps and from 2007. To add a
new smart playlist, right-click on
Playlists and click Add Smartlist.
Choose the parameter by clicking on the
Rules drop-down menu, and enter a
suitable value. In this case, choose
Bitrate and enter the value as 192.
Multiple rules can be added in the same
manner by clicking the Add New Rule
button, so we add another rule—Year,
and the value as 2007. There are also lists
of preset rules that can be added by
clicking on Add Stock Rule button.

Auto-renaming Tracks
Our music collections are often

not titled properly, and the files have
random names. You can have MP3s
renamed using the ID3 tag data in the
files or vice versa. To do this, first select

the files you want to rename. Right-
click on the selected files and click
Library Tools > Fill
Properties from Filename to have
the tags filled with information from
the filenames, or click Rename Files
from Properties to use the ID3 tag
information to rename the files. From
the drop-down menus, you can choose
one of the fixed presets that suits the
way your files have been named. The
same can be done while converting title
details to filenames.

Creating Audio CDs
Media Jukebox can create Audio CDs

as well as standard MP3 CD or DVDs with
its inbuilt CD / DVD burning feature. Click
on the Action tab on the left and choose
Burn Disc. Choose whether you want to
burn a Data CD or an Audio CD. If you use
the Data CD or DVD, you can even use it
to burn data files like you would in any

CD / DVD burning application. Just
beware that Media Jukebox doesn’t
include subdirectories when you choose
the files and folders to be burned. Drag
and drop the files you want to burn on
the disc. Click on Burn to burn the disc.
Before you do that, you can customise and
change the settings for the writer. Click
on Details to see the sequence of songs
on the CD. You can drag and drop them in
the order you want them to be in.

If you click on Options > Burn
Settings, you can choose the speed
that the disc should be burnt at. Click
on the drop-down next to the drive and
choose the speed. 

Creating CD Labels 
J River Media Jukebox 12 comes as

a 12 MB installer, and it includes
everything—a CD / DVD writing feature
and even a CD Label Creator. The CD
Label Creator feature is great for
burning Audio CDs. The software can

create a cover for your discs and for the
labels discs cover as well.

First select the tracks that you plan
on putting on the CD by holding down
the [Ctrl] and [Shift] keys. Then, go
to Tools > Advanced Tools >
Disc Labeler. At any time, you can
get a preview of the finished print by
clicking on the Preview button.
Themes for the print can be selected by
clicking on the Themes dropdown
menu. The CD Info option will show you
the list of songs and the name of the
artist and CD titles which you can
change. The last three menus on the left
have customisation options for the front,
back cover, and the CD label. In each one
of them, you have the option to use the
cover art as the background for the label
and also a listing of the tracks on the
CD. You can also click on Go To Label
Editor to be able to modify every detail
of the design and label.  

Using iPod Support
Music Jukebox 12 can also sync with

most iPods. Connect your iPod like you
normally would and start Media Jukebox
12; your iPod should be detected by the
program. If it hasn’t detected it, go to
Tools > Options > Handheld. Click
on Redetect all devices to detect
the devices. Now, click on Drives and
Devices, and you should see your iPod
in the list—and all the songs and media
on it. You can now drag and drop songs
into your iPod. iPod users can now
acquire album art for their songs and
then transfer it to their iPods and have
cover art displayed on them.

This same feature can be used for
non-iPod music players. You can set the
folder or location on the player’s drive
under Tools > Options >
Handheld. Click Add Device and give
it a name. Next, click on Browse and
choose the location of the media
player. Click OK.

The Audio CD burning feature can be used to burn data CDs and DVDs as well
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the ffdshow configuration window. Click
on Keys & remote. Click the
Keyboard control checkbox; you’ll
see all the effects and features that can
be enabled through shortcuts. You can
double-click on any one of the effects to
change the shortcut. Hold down [Ctrl],
[Alt], and [Shift] along with the key
for the effect to toggle it. This feature
can be especially useful in cases when
you want your processing settings that
you earlier set up to be enabled instantly.

If you want to see the status of all the
effects currently in use, you can enable
the OSD feature in ffdshow. Click the OSD
checkbox. By default, some other
information will be displayed. Disable
these details by un-checking the boxes
and clicking OK. Now, every time you
enable an effect, a notification will
appear on the screen for a short duration.
Settings for the font used on the OSD can
be changed from the Font menu.

ffdshow’s Audio Decoder
ffdshow’s Audio Decoder

component can be used to play back all
music formats. You will need to set your
media players to use ffdshow. For
example, in Winamp, go to Options >
Plug-ins > Input. Double-click on
Nullsoft DirectShow Decoder. Add
the formats that you want ffdshow to use
separated by a semicolon, for example:
MP3;MP4 Click Close.

Now when you play a song in
Winamp, you should see the ffdshow
Audio Decoder icon in the System Tray.
All the effects can be viewed and settings
changed by first clicking on ffdshow
Audio Decoder. The different plugins can
be enabled by checking on the boxes next
to the names. The rest of the
functionality is similar to that in ffdshow
Video Decoder.

Using Winamp Plugins
When you use ffdshow on other

media players, it gives you the option to
use Winamp’s inbuilt plugins, like
special equalisers. Start the ffdshow
Audio Decoder. Click the Winamp 2
checkbox to enable this plugin. Locate
the path for the Winamp folder using
the button at the top. All the plugins
will be listed in the drop-down menu at
the bottom of the window. Choose the
plugin you want to use. In this case,
we’ll use the Shibatch Super Equalizer.
Click on Configure to set the options
for the plugin. Click OK when done.

Using The Inbuilt Equaliser And
Importing Winamp Presets

You can also use the inbuilt equaliser
instead of Winamp’s by clicking on the
Equalizer checkbox. Make any changes
to the equaliser and click OK. You can also
load presets from the Winamp equaliser.

Assuming you saved the equaliser settings
to an EQF file, click on the Load Winamp
preset button. Browse to the location.
Enter the File name as *.eqf and point
to the file you saved. A small entry should
appear next to the button. Click it to load
the preset. Click OK when done.

J RIVER MEDIA
JUKEBOX 12

Some of us are used to Winamp, and
some have stuck with Windows
Media Player... but don’t forget that

there are alternatives. J River Media
Jukebox 12 is one of the latest releases
of the Media Jukebox application. It is
completely free and fully-functional
(unlike J River Media Center). The
interface is similar to that of iTunes,
and it has a lot of impressive features.

Recording Your Own Tracks
Media Jukebox 12 can record tracks

through the line-in or microphone. The
Sound Recorder that comes with
Windows has a limitation of 60 seconds;
Media Jukebox 12 doesn’t.

To start the recorder, go to Tools >
Advanced Tools > Record
Sound…. Click on Options to configure

the settings. Click on Encoding to see
the encoder settings. Click on the
Encoder drop-down button and select a
codec that you want to use. Click
Encoder Settings to set the advanced
options for that encoder—quality profiles
and the bitrates. Click on Recorder to
select the input settings. Select the device
and the source—it could be a line-in or
microphone or mixer. Set a higher
recording volume if your microphone
isn’t loud enough. When done, click OK.
Click Start to start to start recording.
You can split a continuous recording into
multiple tracks by clicking on Split
Track at any time.

Downloading Cover Art For
Albums

When we collect music, we generally
sorting and rename it in an orderly
manner. Almost all well-known media
players have support for cover art,
which is displayed alongside the song
playing. Click on the Playing Now
link on the left, and the album art for
the song and album will be displayed at
the top of the playlist.

Most media players don’t download
covert art for you; you are to depend on a
standalone application for downloading
album covers and then set it for each
album. Media Jukebox 12 can download
the album art for all songs and albums.
To download album art, select all the
songs and albums from the playlist, right
click-on it, and click Cover Art > Get
From Internet… Click OK and the
images will be downloaded. Depending
on the number of songs, it can take a
while. You can also acquire the cover art
using a scanner—click on Get From
Scanner… to do that. If you find a good
album cover while you’re browsing the
Internet, you can copy it to your
clipboard. Right-click on an image in
your browser and click Copy. Right click
on a song and click on Cover Art >
Paste from Clipboard. You can also
use an image URL.

Album View
Assuming you

have all your music
sorted into albums and
all the album art
downloaded, you can
use the Album View,
which displays a very
attractive presentation
of all your music. Click
on Audio from the left
menu, then click on
the View menu and
then on View
Settings > Album
Thumbnails. You can
double-click on any of
the albums to start
playing all the tracks

on it. You can also choose how many
album covers should be displayed on a
page. Use the slider at the top right of
the window to alter the number of
covers displayed.

Switching To Full-screen View
Media Jukebox 12 has a dedicated

full-screen mode, which can be useful as a
dedicated media playback system. The full
screen can be used for navigation mode,
and the cover art we just talked about can
be displayed as a full-screen image. You
can double-click on the visualisation
being displayed at the bottom left of the
screen to switch to full-screen mode.

Media Jukebox 12 comes with an inbuilt recorder so you can
record your own tracks
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such as Notepad. Locate the line containing 72
Ar. Change the number in that line to reflect the
desired output resolution, but keep in mind that
this number should be greater than 100 and less
than 9600. (For example, you can set it to 800 Ar.)
Repeat this procedure for each instance of 72 Ar.
Save the file in text-only format and close the text
editor. You’ll now be able to open it in Illustrator.

You’ll, Umm, Need To Pay...
When I try to create a movie DVD using my DVD-
Writer with Nero, I get a message like “install

multi-channel plug-in.”
Yogendra Sharma

The version of Nero usually bundled with
DVD-Writers does not contain the audio plug-

in that allows you to copy multi-channel DVDs.
You will need to purchase it online from
www.nero.com. It is available for €1 9.99 (Rs 1,150).

The Version Matters
I get the error message “direct x 9.0c not found”
when I try to run Spiderman 3. Other games run

fine. Please help!
Sahil Naik

You must install the latest version of DirectX
9.0c, which is the November 2007 edition (it’s

on our CDs and DVDs starting December 2007).

Do-it-all Discs
How can I make a multi-boot CD with Windows
XP Professional and Media Center Edition?

Alok Kumar

You can use a tool such as EasyBoot from
www.ezbsystems.com to create multi-boot CDs

of different Windows versions. Remember that it
is illegal to do so unless both versions of Windows
are legal. Here are the steps to add Windows XP.

Create a folder named XPPR under
C:\easyboot\disk1. Copy the files win51 and
win51p from the root directory of the XP CD to
C:\easyboot\disk1. Copy the i386 folder to
C:\easyboot\disk1\XPPR. Copy wxp.bat
from C:\easyboot\resource to C:\easy-
boot\disk1\XPPR and run it. Copy w2ksect.bin
from C:\easyboot\disk1\ezboot to a new
file named xppr.bin.

Start EasyBoot. Select Tools >Replace
Text, browse to C:\easyboot\disk1\
ezboot\xppr.bin, and specify i386 as Text
to Replace, XPPR as Replace to, and click
Replace; one occurrence should be replaced.
Repeat this for C:\easyboot\disk1
\xppr\setupldr.bin, replacing i386 by xppr;
four occurrences should be replaced. Open
c:\easyboot\disk1\xppr\txtsetup.sif in
Notepad, search for SetupSourcePath, and
change SetupSourcePath = “\” to
SetupSourcePath = “\XPPR”. Set the menu
item’s command as run xppr.bin. Save the file.

Repeat these steps to add more version of
Windows, but make sure that you use a differ-
ent name for the folder XPPR and the file
xppr.bin. After you’ve prepared the
contents, save the compilation by clicking
Save. Click Make ISO, select the name and
location of the place to save the ISO image
file to, and click Make.

Gone, Yes, Gone!
I had encrypted some files on my E drive. I
formatted and installed a fresh copy of Windows

XP because of a virus, and I am now not able to open
these files. Is there a way to recover them?

Karthikeyan Kshatriya

When you encrypt files in Windows XP, a
unique encryption key is generated and used,

and this makes it virtually impossible to decrypt
and view those files from another installation of
XP or any other OS. Unfortunately, therefore,
there is no way to recover files encrypted in an
unbootable installation of XP.

No Access For You!
I use BSNL NetOne to connect to the Internet.
For the past few days, I have not been able to

connect; I get an error message that says “Error 775:
The call was blocked by the remote computer.”

Vipul Paliwal 

Though the error says the call was “blocked”
by the remote computer, nothing is really

wrong. The error only occurs if the username and
/ or password are incorrect, or if your account has
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A One-Step Fix
I use Windows XP. Whenever I try to install a
software, I get an MSI (Microsoft Installer) error.

Nawajeevan Panthee

Download the latest MSI installer redistrib-
utable and you will not get any further errors

while installing an MSI package. You can find the
MSI Installer 3.0 redistributable for Windows XP
at www.microsoft.com/downloads/details.aspx? fami-
lyid=5FBC5470-B259-4733-A914-A956122E08E8
(http://tinyurl.com/2jsmzd).

Just A Download Away
My SanDisk Cruzer 1 GB with U3 used to work
well, but the U3 application launcher now gives

an error. Please help.
Ayush Sobti

Download and install the SanDisk U3
LaunchPad Installer from

http://u3.sandisk.com/download/apps/LPInstaller.exe.
This is a small file—less than an MB. Make sure
your Flash drive is plugged in before you launch
the program. Follow the on-screen instructions,
and after a few seconds, your U3 disk will be ready
with the latest U3 application. Note that this
installer is not compatible with Vista, so use it
only if you have XP or Windows 2000 SP4—we’re
assuming this is the case. Also, at no point of time
during the installation should you try to remove
the USB drive; you could permanently damage it.

Greyed Out!
The Standby button, which used to be avail-
able as a shutdown option on my computer,

is now disabled. What could have caused this?
Ram Ramesh

The disappearance of the Standby button
means XP is not able to properly use the

power management functions of your moth-
erboard. This could have been caused by vari-

ous things—for example, you might have
changed the power management settings in
the BIOS after XP was installed. If that is the
case, revert to the original settings, or try
loading the defaults. Another common reason
is the installation of a device that does not
support power management (or supports it
partially); this could be a PCI device such as a
LAN card or a TV-Tuner card. Try to upgrade
the drivers of the device, and also run
Windows Update. If that doesn’t help, you
might need to remove the device from the PC
to restore Standby functionality.

Notnet
I have a Seagate 120 GB hard disk with
Windows XP SP2. My PC has recently started

showing a .NET Framework error message—as in
the screenshot.

Indrajit Bose
Make sure you have the .NET Framework
installed: check that the C:\WINDOWS\

Microsoft.NET\Framework (assuming that XP
is on the C drive) exists and
that it is not empty. If the
folder doesn’t exist (or if it’s
empty), then install the
.NET Framework.
Otherwise, open the
Registry Editor, and 
navigate to HKEY_LOCAL_MACHINE\SOFTWARE\
Microsoft\.NETFramework. In the right pane,
double-click the (or create a) String entry named
InstallRoot. Set its value to C:\WINDOWS\
Microsoft.NET\Framework\. Exit the Registry
Editor and restart Windows.

Errant Programs
My Windows XP computer takes a long time to
shut down. What could be the problem?

Anuj Shreshta

There could be many reasons, though the
most common one is a program that runs in

the background and refuses to close. You’d know
best which program this is: try and recall if you
recently installed a program after which the prob-
lem started, and see if you can afford to uninstall
it. Also try to speed up your system after referring
30 Minutes Expert: Keeping Your PC Prim And Proper in
our October 2007 issue.

Resolving Resolution
When I try to open a file in Adobe Illustrator 9, I
get an error message that reads something like

“Can’t open the illustration. The illustration contains
an illegal operator. Offending Operator: ‘Ar’ Context:
72”. When I click OK, the file opens, but there are
missing items.

Prakash Sharma

This problem can be solved by editing the
PostScript code of the document and remov-

ing the incorrect output resolution information.
Make a backup of the original file before proceed-
ing. Write down the portion of the error message
that follows the word Context:, in your case, 72.
Open the Illustrator document in a text editor

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Chop And Change
I have video files in the MPG format
and want to convert them to an AVI.

Is there a way to get them onto one CD in
the AVI format?

Bhuvnesh Goel

You can use DivX Converter to get
your job done. Download and

install the DivX Bundle from
www.divx.com. Go to the DivX program
group and launch DivX Converter. A
small Converter window will open; click
on View List to open the list window. Click Add to browse
for and add your MPG files one by one. When you add
more than one file, you will see that the greyed box next
to Combine videos into a single DivX file and include
menu will become available; check it.

Click on the icon with an exclamation mark just below

the checkbox. Here, click
on Advanced to access the
encoding options such as
resolution, bitrate, and
more. You can select a
certified profile, or specify custom
settings. Check the box next to Limit
Filesize to and set the maximum
expected size of the encoded file (this
would be 700 MB in your case, since you
want to get the files onto a single CD). If
the source files have different resolu-
tions, you should check Use Custom

Resolution and specify an appropriate resolution (specify
either a resolution matching one of the files, or a standard
video resolution). If necessary, click on the Lock icon so that
you’ll be able to specify a custom aspect ratio. Finally, check
the box next to Limit Total Average Bitrate to—this will let
you specify the video and audio bitrates individually.

Use DivX Converter to combine two AVI
files

The .NET Framework initialisation error

Question 

of the

Month

All your computing niggles and nags
are dealt with here!

Your Questions, Our Answers
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expired. Of
course, you could
even be dialling
the wrong
number, but
from the screen-
shot you’ve sent
in, it appears to be correct. So if you’re sure about
the validity of your details and your account,
contact the BSNL Helpdesk.

Here’s Your Link!
My computer is infected by the Brontok virus; it
resides in the My Document and My Pictures

folders as an HTML file. I’ve tried deleting it many
times, but it reappears. I’ve tried to download the
removal tool from Softpedia.com, but it does not get
downloaded. Please help.

Tushar Dharashive
Download the Brontok virus removal tool
from http://dnl-pr1.kaspersky-

labs.com/utils/klwk/klwk.zip. This is a
small (70 KB) file and can be easily downloaded.
Extract the contents to a folder and run the
executable file. Reboot the computer after the
removal process is done, and install a good anti-
virus software to prevent future infections.

The Way It’s Read
Is there a way to make numbers show up
with the thousand separator (by default) in

Word 2007?
Santosh Bhide

Choose the Insert tab on the Ribbon and
select Quick Parts > Field. Select the

item =Formula in the list and click Formula.
Type your number in the Formula field preceded
by the equals symbol. Enter #,##0.00 in the
Number format field and click OK. Done!

To make changes to the value, click on the
number and press [Shift] + [F9]. This will
show the fields so you can change the value. Press
[Shift] + [F9] to retain the format—you’ll see
what we mean when you try it.

A Patch To Match
I want to play Quake 3 Arena online, but I’m not
able to connect to some servers even though

they are listed in the multiplayer option of the game.
Raghav Chari

Verify that you have installed the latest patch
for Quake 3 Arena; it is 1.32c, available for

download from www.idsoftware.com. If, when you
click on the server in the list, you see the default
Quake 3 logo, then you do not have the map or
mod the server is using, so you won’t be able to
connect to it. Go to Game Options in the game
and set Automatic Downloading to On (this
allows you to download the required map auto-
matically). Some game servers require
PunkBuster to be installed and enabled, and this
is mentioned after the server name in the list.
The latest Quake 3 patch comes with this anti-
cheat software, but in case you opted to not
install it, you need to do so by downloading it
from www.evenbalance.com/index.php?page=
pbsetup.php. (Download the version for your OS.)

You’ve Got To Tell It!
I recently purchased an NVIDIA 7600GS PCI-
Express graphics card, but it doesn’t display

anything on my ATI RS480 motherboard. The graph-
ics card works when it’s installed in my friend’s
computer. My computer can still boot using the
onboard graphics, so my motherboard is not faulty.

Pankaj Thorat

It looks like your motherboard is still using
the onboard graphics to boot. You need to

set the PCI-Express graphics card to initialise
first. Enter the BIOS, look under Integrated
Peripherals > Init Display First, and
set it to PCIEx.

The Indian Connection
I use Yahoo! Messenger to voice-chat with my
friends. I recently purchased a webcam. When I

try to chat with the webcam on, the audio quality
becomes very poor, and it is often inaudible.

Rajesh D

You need a broadband connection to be
able to video-chat; your Internet band-

width is probably not enough to support video
chat—try and see if you can get a faster connec-
tion! If you can’t, you could reduce the size of
the video stream by reducing the resolution of
the webcam under the webcam’s advanced
properties. Also, do not download while chat-
ting; this eats up bandwidth.

Out With The Old
I tried to install Office 2007 from the Digit DVD,
and it displays an error: “An error occurred

during installation and setup was unable to
complete.” When I clicked on PowerPoint setup, it
shows “Error 1731.” I have Media Center Edition.

Kiran Kumar Sripati

This error occurs when you try to update,
reinstall, or install an additional feature of a

Windows Installer setup-based program from a
different version of the source setup. In your case,
you may have an earlier version of Microsoft
Office installed. You need to uninstall that version
before trying to install the newer version. You may
need the original installation source files of the
older version of Office to be able to uninstall it.

Sound Off!
When I try to play a song on my computer, I get
this message: “Cannot play back the audio

stream: no audio hardware is available, or the hard-
ware is not responding”. I use Windows XP.

Sarang Phadnis

This error occurs when the computer does
not have an external sound card, when your

sound card is not working properly, or when the
sound hardware acceleration is set too high.
Install the latest drivers for your sound card.
Open Sound and Audio Devices in the
Control Panel. Click on the Audio tab, then on
the Advanced button under Sound Playback.
Click on the Performance tab and move the
Hardware Acceleration slider a notch closer
to None. Click OK, and restart your computer.
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Rossi Fernandes

It’s quite probable that you don’t
want to move to Vista right now,
and that you still have an urge to

try some of its features. The whole
Vista thing being called the biggest
tech failure of 2007 isn’t encouraging,
either. However, there is hope in the
form of standalone add-on programs
for XP that can give you close to the
entire Vista experience.

Note: A lot of these programs are in
development phase, and some of them
might modify system files—so proceed
with caution.

Using A Sidebar
Sidebars may have existed
since the early days when
details of Vista were being
leaked onto the Web.
Sidebars are a great way
to have instant access to
information such as
weather, RSS feeds, and
mail all the same time on
your Desktop. If you want
a sidebar today, you have
several good ones to
choose from. The most
famous has to be Google
Desktop (http://desktop.
google.com). You can down-
load it or free. Once
installed, right-click on
the icon in the system
tray and make sure you
set it as a sidebar. Click
the + sign at the top of the
sidebar to add gadgets to
it. You can shift them all
about the sidebar by drag-
ging and dropping.

Another software that
can used to install a sidebar is
Desktop Sidebar (www.desktopside-
bar.com). Desktop sidebar, too, is
powerful, but not as attractive or
Vista-like looking as Google Desktop.
You can always download skins for
it, though.

File Indexing And
Searching
Google Desktop is more
than just a sidebar—it is

also an indexing tool. These can scan
your drive for documents and other
files, and locating files becomes
much faster than if you were to use
the default Windows search. To look
for files in Google, press [Ctrl]
twice, and a search window will

appear. The text field in the sidebar
can also be used.

Another well-known indexing tool
is Copernic Desktop Search 2
(www.copernic.com). Like the Google
Desktop indexing feature, you can use
Copernic Desktop Search to look for
files and e-mails. Because the initial
indexing is a slow process, it’s a good
idea to force the indexing process in
Copernic Desktop Search whenever you
aren’t going to be using the computer.
Go to Tools > Options >
Indexing & Performance. Uncheck
two boxes: Suspend indexing while I
use my computer, and Suspend index-
ing while computer resources are
highly used.

Taskbar Visual Tips
Visual tooltips are small
visual previews of
windows; they appear

when you move your mouse pointer
over an item in the taskbar. You can
get Visual Tooltip from
www.chrisnsoft.com/ visual-tooltip/.
Unzip the file and run
VisualToolTip.exe. Now move the
mouse pointer over the taskbar and
you’ll be able to see previews of
programs. You can modify the size of
each preview by right-clicking on the
system tray icon and then selecting
Options. Click the Thumbnail tab. Any
other changes to the look of the
tooltips can be done by clicking on
the Display tab.

Getting The Vista Look
XP themes have been
around for quite a while,
and designers have been

working on themes that look a lot
like Vista. For custom themes to work
on Windows XP, you first need to
patch the UXTHEME.DLL file. If you’d
like, you can download an automated
patcher from
www.softpedia.com/progDownload/
UXTheme-MultiPatcher-Download-
2369.html. Run the patcher and Cancel
any warnings about Windows files
being replaced. Reboot, and you’ll be
able to use custom themes. Copy the
theme files you download into
C:\Windows\Resources\Themes.
Double-click the .theme file to
preview the theme. In the Display
properties window, click on Apply to
apply the theme. Sites like
www.themexp.org and
www.deviantart.com have loads of
themes—and quite a few that mimic
Vista’s default theme.

The Vista Start Menu
This is a little different
from the one in XP: it has
a search bar. Vista Start

Menu Emulator (http://vseproject.
extra.hu) is a little application that
brings Vista’s Start Menu to XP. If you
have a good Vista theme installed, this
Start Menu replacement will work as a
great combination.

A very good alternative to Vista
Start Menu Emulator is called ViStart
(http://lee-soft.com). 

Flipping Windows!
Top Desk (www.otakusoft-
ware.com/topdesk/) is a
neat little utility that

allows you to get the effect Vista
gives you when you multitask
between applications. After you
install Top Desk, pressing [Windows
Key] + [Tab] will show you a
visual list of all running applica-
tions. You can keep pressing the key
combo (or use the arrow keys) to
switch between applications.

Performance Boost
ReadyBoost is one of
Vista’s performance
boosting features.

ReadyBoost works by using a USB
Flash drive as additional memory.

For ReadyBoost, you can find a
commercial software called eBoostr
(www.eboostr.com). Once you have the
program installed, reboot the
computer. Start the program, and
you can now add a Flash drive that
you want it to use. Enter the size of
the cache file you want to use.

Windows Media Player 11
Every major Windows
release is highlighted by
the release of a new

Windows Media Player. Vista came out
with Windows Media Player 11, but
Microsoft also has it out for XP. It is
available for free download from
www.microsoft.com/windows/windowsme-
dia/player/11/default.aspx

rossi_fernandes@thinkdigit.com

Get Vista’s Productivity 
Features In XP

Google
Desktop
comes with
a great
sidebar

The flip effect from Vista on Windows is
possible with Top Desk
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Get the six-year-old XP up to Vista speed with a few nifty additions!
The BSNL NetOne connection
error message
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A
good friend is about to the tie the knot next month,
and we’d been window shopping to check out stuff
for his new place—a generous gift from his invest-

ment broker dad. During our sojourn we chanced across a
showroom with few flat screen panels on display. Like any
good movie junkie, he was hooked—he wanted a flat screen
and he wanted something big!

Flat panels are of two types—LCD and Plasma panels. Let’s
bust a myth here: Plasma screens are actually better than LCD
displays in general—they have better contrast ratios (1500:1
and better), and better, more natural colour tones. A plasma
display will also display better blacks, and greater varieties of
grey—all because of the improved contrast ratio. However,
LCDs aren’t far behind, and the latest S-PVA panels sport
improved contrast ratios from earlier MVA panels, while the
cheaper TN panels play with the masses interested in some-
thing cheaper. I also cautioned my friend not to look at the
“dynamic contrast ratio” figure. In fact most panels’ contrast
ratio won’t exceed 1500:1, though many advertised as 3000:1
will have an actual contrast ratio of around 800:1. An actual
contrast ratio of 1000:1 ought to be sufficient for most users.

Also remember that LCDs get prohibitively costly after
a certain size (42 inches or so), and this steep price hike
hasn’t got anything to do with better performance—just a

costlier manufacturing process. If you’re looking for a big
screen—say 50 inches or so, then consider only a plasma
panel—much better value for money. However, plasma
screens aren’t made in sizes smaller than 50 inches, so if
you’re looking for something around the 32-inch mark,
then you’re stuck with nothing but LCD. Also remember
that large screens look terrible at close range; 32 inches is
plenty for a viewing distance of 12-18 feet, and 40 is better
if you can put 20 or more feet between you and the TV. 

A Samsung showroom had a couple of LCDs on display—
one each from their costlier Bordeaux and cheaper Mosel
models. The Bordeaux has a sleeker look and a higher con-
trast panel and the 26-inch is priced at Rs 32,000, while the
Mosel is priced at Rs 2,000 less. The 32-inch Bordeaux is a bril-
liant deal at Rs 42,000. This showroom had EMI facilities avail-
able, and my friend was all smiles. A 42-inch Samsung plasma
screen was also available for Rs 55,000—a sweet deal if you
want a plasma screen. We came across the same two LCDs at
a large mall—and the salesman assured us he’d match the best
price we got from anywhere after we scoffed at the higher
quoted prices. The Sony Bravia 26-inch LCD was priced at Rs
33,000, while the 32-inch equivalent was Rs 8,500 more. The
Bravia uses the same panel as the Bordeaux (both S-PVA
panels) but has a better display processor. We also saw a 40-

inch Bravia from Sony’s V “value” series—for Rs 89,990. 
It seems the new LG Pearl Black is the new “in” thing. These

TVs are as gorgeous as Samsung’s shapely Bordeaux, and
decked in the same Pearl Black colour (the Bordeaux can be
had in white too), and the swivel portion of the base has a tasty
dark wine-red hue which attracts looks even when switched
off. These panels feature 10000:1 contrast ratios (dynamic, of
course) and a brightness of 600 cd/m2—quite good.

A 50-inch Hitachi plasma screen was also on display for 
Rs 55,000, although the salesman pointed out that service
might be an issue. It seems brands like Sony, Samsung and
LG garner votes mainly due to hassle-free service. There was
an Akai 32-inch LCD at Rs 38,000—the cheapest 32-inch we
came across—but one look at the picture quality told us
we’d be better off spending a few thousand more.

After deliberation, a couple of (soft) drinks and a pizza,
my friend had built up enough fortitude to fork out a good
bit of cash. We finally decided on the Samsung plasma 
(PS-42C91H) for Rs 55,000; a half hour of gentle persuasion
had us at Rs 53,000. After paying half the amount in cash
and swiping his credit card for the rest, we got a deal of 
Rs 52,500, and he drove home with his purchase as happy
as a child at an ice-cream stand. 

agent001@thinkdigit.com

Shh... The Movie’s Starting
New year, new home... Agent 001 goes out shopping for an HDTV 
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Digital Tools l Agent 001

Channel Muddle
My PC configuration is: Intel Core 2 Duo E6600,
Intel DG965WH motherboard, 1 GB Transcend

RAM at 667 MHz, 250 GB HDD, 19-inch LG TFT, Sony
DVD-Writer. I want to upgrade the RAM to 2 GB. Should
I go for a 1 GB Transcend at 667 MHz in dual-channel,
or can I use 1 GB at 800 MHz also in dual-channel?
Which will be faster? Can I use 3 GB? Will it show any
improvement? What brands do you recommend?

Aniket Gaikwad

You seem confused about the concept of
dual-channel memory. Firstly, you need

two sticks of memory to even get dual-channel
mode enabled, so a single 1 GB DDR2 800 MHz
module won’t work—but two 512 MB modules will,
if the memory speeds are the same. I recommend
2 GB over 1 GB anytime, simply because DDR2 is
ultra-cheap. 3 GB would be better under Windows
Vista, although under Windows XP, I’d expect the
difference under demanding applications would
be no more than 10 per cent. 2 GB of DDR2 667
MHz memory will cost you around Rs 2,400, while
800 MHz memory will cost an extra Rs 600. Tran-
scend is a good brand—stick with it.

The Question That Won’t Go Away
I bought an XFX GeForce 8800GT, and my system
configuration is Core 2 Duo E6300 at 1.86GHz, Intel

original motherboard DG965RY, Transcend 1GB RAM at
533 MHz, Seagate Barracuda 80 GB, LG DVD-Writer. I’m
using a 400-watt PSU from Odyssey; is it sufficient or
should I upgrade? Do recommend a PSU taking into con-
sideration that I will add a 320 GB HDD.

Vicky Fernandes

That power supply is a serious hazard in
such a high-end PC. I recommend a 500-

watt PSU from VIP (Rs 2,300 or thereabouts), or
even a 550 W CoolerMaster Extreme Power,
which should cost you around 3,000 bucks. Don’t
compromise on system stability or even compo-
nent life with a power supply that can’t handle
all that processing juice.

Shades Of Grey…
I want to buy a digital camera, and I’m looking
at the Canon PowerShot A650 IS. I checked with

some big stores in Mumbai, but they don’t have that
model; the PowerShot A570 IS is available. Should I
go for it? Is buying an A650 IS from the grey market
at Rs 14,500 a good option?

Tejas Unnikrishnan

To be honest, most people buying cam-
eras these days prefer the grey market

where the additional cost of a bill with the tax
incurred is saved. Add to that the fact that there
are hardly any fakes for cameras, and you are rea-
sonably safe. The PowerShot A650 IS will be a
better option than the A570IS, especially if your
budget is as large as Rs 14,500.

Moving Pictures On A Budget
I would like to buy a digital camcorder with
either the DVD or mini DV format. My budget

is Rs 40,000. Please suggest some good models
with exact prices.

Sumita Dey

Samsung’s DC230, at Rs 24,995, should be
a good camcorder for you: good build

quality and quite ergonomic. We also liked the
quality of the image after zooming—all in all, suit-
able for an amateur on a shoestring budget. I’d rec-
ommend the Panasonic SDR-H20 (HDD-based)
since its Image Stabilisation is excellent and per-
formance exemplary, but you have specified a
DVD-format-model only. If you can spend around
Rs 50,000, then the Canon DC51 is excellent.

One Fits In Your Pocket…
I want a console for casual gaming. What is the dif-
ference between the PSP and PS2 with regards to

gaming performance? Would it be worthwhile to go for
the PSP due to its other features on offer?

Raghav Kanwal

First of all, the PSP is a handheld multi-
media device, not really a console like the

PS2, PS3, or Xbox. If you want to game on the go
and even listen to music or play movies, the PSP is
very suitable—it slips into your pocket, and it has
a good screen. The PS2 will require connectivity to
a TV set, and is a better gaming solution than the
PSP, except it isn’t portable. The Xbox 360 is a good
alternative to the PS2, although it’ll cost around 
Rs 18,000, while the PS2, having been around for
a while, will cost in the region of Rs 7,000. The PSP
will cost around Rs 7,500.

I Need Two
My current configuration is the following: Intel
Pentium III 866 MHz processor, 256 MB SDRAM,

40 GB Seagate HDD PATA, 80 GB Samsung HDD PATA,
and Windows XP Pro SP2. I would like to upgrade,
with a budget of 15K. Here are my specs: Intel Core 2
Duo E4400 2 GHz (Rs 5,500); Gigabyte GA-G33M-S2H
(Rs 5,950); 1 GB DDR2 667 MHz RAM Transcend / Cor-
sair/ Kingston (Rs 1,450—1,700). The problem is that
I have two PATA drives, and the motherboard I men-
tioned has only 1 PATA port. Also, I mostly play only
the FIFA series of games. So, of my 15K budget,
12,900-13,150 is spent, and with the rest, I can buy a
new cabinet / PSU combo, maybe also squeezing in a
USB keyboard. What say you?

Karthik

If you really need both PATA drives and
cannot do without upgrading your storage,

then I’d suggest the Zebronics 650 SLI mother-
board. This board is one of the only ones to feature
two PATA ports. It should cost around 4,500 bucks
now. Also look at the E4300 and save some money,
as the performance difference is minimal. If you
decide to ditch both PATA drives, then go for a Sea-
gate 7200.10 series 160 GB hard drive, or if you can
afford it, the 250 GB series, which should cost
Rs 2,200 and 3,000 respectively.

The extra bit you squeeze in should allow you
to go for a decent cabinet + SMPS combination. A
USB keyboard should cost around Rs 500; Logitech
has some decent entry-level offerings. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001
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Sanket Naik

W
hen it comes to cell phones,
the country is at a sweet spot
right now—the place where
demand and supply curves
intersect, and maximum sat-

isfaction is achieved. 
With portable productivity becoming a

necessity, we’re seeing multimedia phones
with PDA-like functions, and PDAs with
superb cameras and great PMP capabilities;
people want one device to do it all, and
they’re prepared to shell out the premium. Be
it the Apple iPhone, Nokia N95 or Sony
Ericsson W910i, every cell phone has some-
thing new on offer—something radically dif-
ferent that promises to change the way we
use them today. 

A year ago, cameras and music players
were considered luxury features, and only cell
phones above Rs 10,000 used to come with
them. Today, even entry level models from
most vendors have two megapixel cameras
and a decent music player. Cell phones are
being increasingly used for listening to music,
watching videos, taking causal photographs,
playing games, chatting on messengers, read-
ing e-books—the possibilities are unlimited.
They reflect our lifestyles, and new innova-
tions are based around our senses—touch,
movement—something natural. 

In this comparison, we were in for some
surprises; the first was the iPhone—something
so radical it changed our perceptions of how a
phone should be. Second was the Sony
Ericsson W910i, another example where move-
ments are used for changing music tracks.
Third, the three phones with five megapixel
cameras that are as good as digital cameras.
Fourth was Motorola’s RAZR V2—a style icon—
and lastly, the svelte Blackberry Pearl 8120.
Then there were some that amazed us—the
sheer value for money that is the Nokia E51.
Read on to see the best for you.

75

Ion 
Maidens

Nobody’s looking for just plain
old telephony from a cell phone
any more; they’ve become a
part of our work, and a part of
our play....

Jiten Gandhi
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LG KE970
Born to shine! 

LG KE770 
Sleek, cool, affordable

Sony Ericsson models such as the K550i. The
auto-focus system requires delicate use of the
dinky shutter release key; a little clumsiness,
and you’ll see blurred, washed-out photographs.
Tonal accuracy isn’t that great either; the photos
are generally overexposed. Outdoors, the camera
fares better, and the colours are more natural.
Video recording is strictly okay; it is limited by
the resolution and fps.

Music on the KE970 was good; the phone han-
dles MP3, AAC, and AAC+. The Inline control with
3.5 mm jack allows you to connect different pair
of earphones, though the bundled pair is okay.
With our reference Bose in-ear phones, the
volume level was good and the quality crisp, but
there is still room for improvement.

PhotoID, Bluetooth, mobile e-mail, USB mass
storage, and a document viewer for MS Word,
Excel, PowerPoint, and PDF are some of the other
notable features.

On the performance front, the phone is
snappy, with no apparent lag in the user inter-
face. Signal reception is good; however, voice
clarity could have been better. With nominal use,
the phone goes two days before the low battery
alarm pops up.

The LG KE970 is a stylish phone, and is rea-
sonably priced at Rs 11,990—if you can put up
with the operational glitches and the extra bling.

The KE770 is the second phone in the Shine
series from LG. It’s a candybar; “sleek and

shiny” is the best way to describe it. At 9.9 mm, it’s
slimmer than the Motorola L9 phone (on which it
is modelled). Built from stainless steel with no
moving parts, the KE770 exudes the built-to-last
feel.

When the display is in inactive mode, the
mirror-finished display screen can be, well, a
mirror. The well-lit, flat keypad is a joy to use, with
distinct tactile feedback. The navigational keys are
well-spaced-out and free from the glitches you’ll
see on the KE970. The Call End button is placed
near the top and to the side; it also acts as a Power
Down switch—strange placement, we’d say, but
effective for one-handed operation.

The volume control buttons, Camera / MP3
button, and USB connectors are on the same side.
Internal memory is 70 MB, which can be
increased via the microSD card. The memory slot

is placed below the battery, and it isn’t hot-
swappable.

The 2MP camera with the photo-assist
light and self-portrait mirror is on the
back of the phone. The camera is similar
to the one on the KE970, and the per-
formance is similar, too. Indoor shots lack
tonal accuracy, and are often overex-

posed. Outdoor images retain tonal accuracy
but lack crispness. 

Music quality is not really great, but given
that it isn’t touted as a music phone, we’d say the
music capability is reasonable. There are no
external playback controls. MP3, AAC, AAC+, 3GP,
and MPEG4 are supported, but files need to be
copied to the right folder on the phone—else the
media player can’t search through to them. Video
playback is just about okay—it is seriously limited
by the screen size.

The phone has a good bundle of applications:
MS office file viewers, PDF readers, a health chart,
and a data wallet. The phone also support the Lost
Mobile Tracking System (LMTS). You’ll also find
regular applications such as the clock, calculator,
games, and more.

Signal reception was good, but voice clarity
could do with a lot of improvement—especially
that of the speakerphone. The volume is too low,
and it crackles as well. Flight mode figures, and
that’s a plus. Battery life is around a day and a
half with nominal usage. 

A price of Rs 7,990 means the KE770 is a good
buy if you are looking for a sleek, cool-looking
phone. If you’re planning on using multimedia
features on a regular basis, we’d suggest you look
elsewhere.

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Samsung G600
One great slider!

Motorola MOTO RAZR 2 V8
RAZR fans, listen up...

Samsung makes the best slider phones, and
the G600 would make you agree. It is a quad-

band 2G slider; the fit and finish are exemplary.
At 105 grams, it’s light, and the proportions are
just right—the phone fits snugly in one’s palm.
And it looks good, too—you might say “sophis-
ticated”; it sports a black-grey combination
with silver accents.

The front facia is dominated by a (large) 2.2-
inch display capable of 16 million colours. The
display is sharp and the colours crisp. Outdoors,
the screen goes pale, but it remains perfectly leg-
ible even in direct sunlight. The navigational
buttons are well-spaced-out and the Call and End
keys are huge. The five-way roundel is superb,
and can be used to navigate the menu without
looking at the phone.

The spring-loaded slider can be operated
with the minimum of force; it’s the best slider
mechanism we’ve yet seen. The keypad is large
and tactile, and therefore easy to use. But here’s
a damper: when you enter a number, the digits
on the screen appear as if written using a cal-
ligraphy pen (complete with the “scratching”
sound)!

The G600 is equipped with 40 MB of internal
memory with support for hot-swappable microSD
cards. Samsung doesn’t bundle any, and the
internal memory is too low (for the camera or for

the music player).
The G600 joins the ranks of the Nokia N95 and

the Sony Ericsson K850i by cramming in a 5-
megapixel camera. During our tests, the camera
performed well; the images were clean, and the
tonal balance good; outdoor photographs were
better than indoors. A good camera overall, but
it’s not quite close to those on the Sony Ericsson
or Nokia. The camera is on the slider, and it needs
to be opened before you can click; though it pro-
tects the lenses, clicking snaps with the slider
open isn’t practical.

The G600 supports most music formats, and
has a great media player. The headphone con-
nector is, unfortunately, proprietary, so replace-
ment 3.5-mm-jack earphones can’t be used.

Performance-wise, the response of the G600 is
good; skipping from menu to menu is fast. Signal
reception is great, and so is voice clarity. The
speakerphone is loud enough, and doesn’t suffer
from echo problems like those on most phones
do. Battery life is healthy—two and a half
days with nominal usage. 

Retailing at Rs 18,000, the G600 seems
reasonably priced. As a phone, it shines in
all departments, but if you want a multi-
media device, we should say there are better
options. If what you really want is a quality
slider phone, the G600 should fit the bill.

With the release of the MOTO RAZR 2 V8,
Motorola has yet again raised the bar for

stylish cell phones. In fact, just “stylish” doesn’t
do it justice—it’s stunning! In its second iteration,
the body of the MOTO RAZR is built from exquisite
materials; it comes with two large screens, a
revamped keypad, and a great music player. 

The RAZR 2 feels slimmer than the original
RAZR, thanks to a less pronounced chin. The 2.2-
inch LCD on the flap is the first of its kind on any
phone—it’s sharp, and the clarity is amazing.
Near the bottom of this screen are touch-sensi-
tive electrostatic keys. All the keys on the new
RAZR, including the touch-keys, vibrate when
pressed—this, we think, is good in terms of haptic
feedback. 

The interiors of the V8 are pretty similar to
those of the original RAZR except for the keypad
layout and the overall feel. The main display is sim-
ilar to the one on the flap—2.2-inch, 256K colours.
The display is sharp and completely legible out-
doors. The keypad has changed for the better—it
has more feedback, and the backlight is much
better than on the original RAZR. 

The most significant change, however, is in
the user interface. The phone is based on the
Linux+Java platform, called MOTOMAGX. The
interface is visually more refined and definitely

Features
Performance  
Build Quality
Value for Money
Overall 
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better than that of the older Motorola phones (the
ones we’re used to cursing!).

The multimedia, especially the music player,
is excellent. Playback can be controlled without
opening the flap, thanks to the touch-sensitive
buttons. Audio quality is excellent, and the bun-
dled earphones are good. The phone supports the
MP3, AAC, and AAC+ formats, but there’s no FM
radio. Also, bundled memory is just 512 MB, with
no expansion allowed—lame, from a media
player perspective. 

The camera is reasonably good—about as
good as any other 2MP cell phone camera.
Indoors, photographs turn out dark; colours also
get affected in low-light conditions. Video
recording is strictly okay.

In our tests, signal reception was good in all
the conditions we put the phone through. Voice
clarity was good, with no crackling or echo when
we used the speakerphone. Battery life, when
compared to the earlier model, is much
better: with nominal usage, the phone
remained alive for two days. 

The Motorola RAZR is expensive at 
Rs 16,799; you can get a better-featured
phone at that price point. However, there is
a RAZR fan following, and the new phone
strikes the right chord.

The LG KE970—also known as the Shine—is aptly
named, because the first thing you notice

about the phone is the brilliant shine from the
brushed stainless-steel body. Even the main dis-
play is mirror-finished, and when the screen is
inactive, you can actually use it like one!

This tri-band phone is based around a slider
design. The slider mechanism feels smooth;
opening the phone takes just a nudge. Build
quality is good, and the phone is comfortable to
hold. The (largish) 2.3-inch high-resolution display
looks brilliant indoors; however, it pales out-
doors—this can be attributed to the glossy screen.

The volume control buttons are on the right
along with the shortcuts to the camera and music
player. To use the memory card slot, you need to
remove the battery cover, but it is hot-swappable.
The phone’s 50 MB of internal memory can be
augmented using microSD cards. 

The keypad is flat but easy to use because the
individual keys are large. The navigation keys

aren’t the best we’ve seen, though. The
rocker in the middle scrolls though the
menu and can be pressed to activate the
menu. The adjoining keys allow horizontal
movement but they are small and tight—
uncomfortable, we thought.

The 2-megapixel camera, though
good, can’t match the ones on entry-level
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Motorola SLVR L9
A no-nonsense candy-bar

Sony-Ericsson W910i 
The Ultimate Walkman slider

The MOTO SLVR line features typical, no-
nonsense, slim candy-bar phones with a

reasonable amount of features. The SLVR L9 is
the successor of the L7; in the looks depart-
ment, the two are nearly identical.

Despite it being entry-level, the fit and
finish of the L9 are surprisingly good. The

pearl-grey finish is as good as that on the
more expensive RAZR 2. The back cover is

finished in rubberised material, and
therefore offers good grip. 

A 2-inch, 256 colour, 176 x 220
LCD is more than enough for this
phone. The screen is sharp and

bright, and stays perfectly legible out-
doors. The navigational keys consists of a

roundel and two soft menu keys. There are
two additional buttons (for Cancel and
launching FM).

The keypad is well-spaced, with each key
being separated from the other by small
ridges; however, the tactile feedback
isn’t as good as that on the new RAZR 2,
despite the visual similarities.

One of the prominent differences
with respect to the older L7 is the fact
that the memory slot is on the right. The
L9 accepts microSD up to 2 GB (the

phone has just 20 MB of internal memory).
With many phones supporting up to 4 GB of
additional memory, this is a bit of a disap-
pointment. The user interface on the L9 hasn’t
been upgraded to the newer MOTOMAGX—it
uses the older, not-so-polished UI. Well, we
should say it is easy to work with, but visually-
speaking, Symbian’s revised Series 40 is 
more intuitive. 

Coming to multimedia, the SLVR L9 sup-
ports the MP3, AAC, AAC+ and MPEG4 formats.
The media player is mediocre compared to that
on the RAZR, and indeed, that of any music
phone today. Audio quality is reasonably good. 

The 2-megapixel camera is pretty much
similar to that on the RAZR 2. The camera per-
forms admirably outdoors; in low-light condi-
tions and indoor environments, photos turn
out dark. It’s also capable of recording video
in the MPEG4 format, but the quality is
nothing to write home about.

We had no problems as far as signal recep-
tion goes, but the speakerphone clarity could
have been better. Battery life is strictly okay—
we got around two days with nominal usage. At
Rs 8,399  the L9 is reasonably-priced; 
however, we can’t see any compelling reason
to recommend it to anyone.

The W910i is the latest in the Walkman
series of phones from Sony Ericsson. It

comes with a new media-browsing interface,
and an inbuilt motion sensor for games 
and music.

The slim W910i employs a smooth slider
mechanism. The front facia is dominated by a
(huge!) 2.4-inch LCD screen—strikingly beauti-
ful, and it remains perfectly legible even in
direct sunlight.

The navigational keys include a small steel
five-way rocker which doubles up as the
Playback control when using media player,
and two soft menu keys. Two additional keys
are placed near the top, which are configured
for the photo album by default; they can be
used while gaming as well. The flat keypad
lacks tactile feedback and feels mushy—not
good if you SMS a lot. The Power On and
Walkman buttons at the top are rather 
difficult to operate. 

Music is the forte of the W910i.
Playback quality is awesome; the bun-
dled earphones are simply superb, plus
you can use any 3.5 mm earphones
you’d like. Two features have been
added, called Shake control and
SenseMe. Shake Control, as the name
suggests, implies the use of motion 

sensors (gyroscopes, to be precise) to control
music playback. Shake the phone in one direc-
tion to switch to the next track and in the
other direction for the previous track—you’ve
no doubt seen this in the advertisements for
the phone. The feature works overall, but it
needs refinement. SenseMe is a kind of media
browser where tracks are sorted by tempo
(like fast or slow) and mood (happy or sad). For
a song to be tagged with the right mood, it
needs to be uploaded via the Media Manager
application (otherwise it remains hidden
from SenseMe). 

The camera on the W910i is decent, but not
the best; you’d have expected SE to do better.
As with all 2MP cameras, it performs better out-
doors; image quality decreases with light. Video
recording is okay. 

The phone itself is typical SE—a simple user
interface and snappy performance. A 2 GB
card is included, and you also get a USB read-
er with this phone. The only gripe we had with
the phone was the keypad, which has no tac-
tile feedback, and feels like the buttons on
washing machines. 

The W910i is easily the best of the W series
of phones from SE. Retailing at Rs 18,899, we’d
recommend the W910i to someone looking for
a suave, slim music phone.

Sony-Ericsson K810i 
Good as a camera phone

Sony-Ericsson K850i
Some of this, some of that—and a great camera

The K810i comes from Sony Ericsson’s Cyber-
shot series. The 3.2-megapixel camera

sensor is what differentiates this phone from
the crowd and from other SE phones. The 810i
is aimed at causal shutterbugs, and has some
neat features that should go down well with
that audience.

The translucent body with steel buttons
gives the phone its unique appearance. The
phone is quite long, but is comfortable to hold.
The back cover is finished in rubberised mate-
rial, and that gives the phone excellent grip,
which is good for clicking snaps.

The navigational keys are similar to those
on older SE phones such as the K750i. The joy-
stick is much better, though, and well-recessed.
The soft menu keys and additional shortcuts
keys are small and tightly placed; this could
turn out to be a problem for some. The keypad
is well-spaced-out, and consists of little round
keys—much better than those on the K550i or
the W880i. At first sight, the keypad might
seem uncomfortable, but you’ll find it’s not.

The 3.2MP camera is well-protected by a
sliding lens cover. Being a Cybershot, it has
one-touch shortcut keys to change flash
modes, timer, Macro, and megapixel rating.
One row of the keypad has the appropriate
markings, and gets highlighted when camera

mode is activated. There are two buttons near
the top, for changing the shooting mode and
scenes. The Auto-focus works well and locks on
the subject immediately, but in low light, it
takes a while. There is a reasonably powerful
xenon flash to light up the subject. Perfor-
mance is quite what you’d expect from a 3-
megapixel camera. Colours, sharpness, and
detail were perfect; more importantly, the
shooting experience is great.

The K810i can play music too, and the
quality is above average; it can’t match that of
the Walkman series, though. Further, the bun-
dled earphones are the regular ones (which
come with entry-level Sony-Ericsson phones),
not the Fontopias. The K810i supports MS
micro memory cards; though SE has bundled
128 MB, it might not be enough if you plan to
carry music and click photographs at 3
megapixels. 

We had no issues with the phone perform-
ance; signal reception was good, and so
was the voice clarity. Battery life is okay—
expect around two days unless you plan to
surf the Internet and use Bluetooth a lot.

The K810i retails at Rs 15,500; we say
it’s reasonable. In fact, we’d recommend
the K810i to anyone looking out for a
good camera phone.

The K850i is the flagship model in the Cyber-
shot line-up from Sony-Ericsson. Based around

a 5-megapixel camera, it’s pitted against Nokia’s
N95 as far as the camera is concerned. The K850i
comes in at a notch above the K810i.

The phone sports a completely revamped
design, with hardly any resemblance to earlier SE
models. It is blocky, but the fit and finish are
excellent. A nice, luminous green strip runs
around the edge. 

The navigational D-pad is a squarish ring that
surrounds the 2 and 5 number keys. The edges
are raised for proper contact. There is no action
button; rather, there are touch-sensitive buttons
just below the screen. They are context-sensitive
and are dynamically assigned the proper func-
tions, similar to soft menu buttons. The touch-
sensitive buttons work flawlessly, but require
some time to get used to. The backlight at times
seems overpowering, and distracts. The keypad
consists of small square buttons—usable, but no
fun when texting. 

The camera is at the back, and the lenses have
their own retracting cover. A hard plastic sheet is
drawn over the length of the phone, covering the
lens. It protects the shiny back of the phone, but
also attracts fingerprints; when clicking, you’ll
need to clean the portion near the lens. 

The K850i is designed to deliver a digital-
camera-like experience, and it doesn’t disap-
point. The camera controls have evolved over the
K810i, and the ergonomics are much better.
Since the K850i doesn’t have any additional ded-
icated buttons, most settings can be changed
from the single touch-sensitive button.

Camera performance was superb; colour
accuracy is pretty impressive—better than that
on the N95. The K850i feels snappier
throughout; it starts in an instant, file saves are
fast, and it switches back to the phone in a
second. Indoors, the camera has a tendency to
underexpose if the flash is used. 

The K850i comes with 40 MB of internal
memory, and a 512 MB MS micro card comes
bundled, but with a 5 megapixel camera and
music, you’ll have to buy more memory. Music-
wise, the phone is on par with the K810i, and
it betters the N95, but can’t match any of the
W series phones. 

Priced at Rs 21,000, the K850i is 10K
cheaper than the Nokia N95. It misses out
on GPS and WiFi, but it has a much better
camera and music player, and longer bat-
tery life. Let’s just say the K850i fits the bill
if you want a good smartphone with an
excellent camera.
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Nokia N95 8GB
This is it!

Nokia N81 8GB
Good enough music, not-so-good camera

The successor to the acclaimed N95, this new
incarnation just got better all round.
The navigational console has been completely

revamped. The oblong buttons are easy to use,
and the directional pad is much better than that
on the N95. The extra chrome on the buttons

could have been avoided, we think—it picks up
finger smudges and is likely to peel off. The

number keypad is well-laid-out, but the
hard-touch keys, combined with the

slightly raised surface, makes
finger-pad touch-typing a pain. 

The music player is fea-
ture-rich—you can shuffle

and repeat tracks,
there’s a functional

equaliser, and a visualisa-
tion function too. Audio

quality seems to have
improved over the N95. Music

quality is decent on the supplied
earplugs, and this phone is just great
with better earphones! Sony Ericsson
still rules the game with their Walkman
series of phones, though.

The 5MP camera is another first—great
image quality and a good flash unit. How-
ever, like all cell phone cameras, the zoom
is useless. The lens cover you see on the N95

has been dropped in this new incarnation—and
that’s not something we approve of.

Image quality is similar to that on the N95.
The camera performs admirably outdoors;
colour saturation is perfect, and so is the expo-
sure. Indoors, in low-light conditions, the focus
tends to hunt for a while, and tonal accuracy
suffers as well.

The phone comes with 160 MB of internal
memory, which is well-supplemented by 8 GB of
flash memory. No expansion is available for
memory cards, but it’s not required. There’s a
fully-functional GPS application inbuilt. This
works well in conjunction with a GPRS connec-
tion. WiFi (g) is inbuilt, as is the mandatory Blue-
tooth (version 2.0, now with A2DP), and the
jurassic infrared. For the radio fan, the N95 8 GB
incorporates FM radio.

The new N95 8GB comes with higher-capacity
batteries that extend its life by two hours over the
N95. With nominal use, we got around two days
of battery (45 minutes of talking, 2 hours of lis-
tening to music, and intermittent GPRS use).

In conclusion, the Nokia N95 8 GB is a superb
convergent device. Be it music, camera, GPS, or
Internet connectivity, it just does everything
better than most devices on the market. Priced at 
Rs 28,000, this is the device to have—if you can
cough up the money.

The N81 marks Nokia’s entry into music-related
services similar to that offered by Apple (as in

iTunes). Like the N73 and N95, the N81 comes in
two editions—Standard and Music. The former
has a memory card slot, while the latter has 8 GB
of flash memory and no memory slot.

The N81 is handsome—rounded edges, black
lustrous finish, and you’ll notice the use of con-

trasting brushed silver on the edges. Build
quality is excellent, and though the body

has a plastic feel to it, it’s rugged, and
should take the rigours of everyday life.

The slider mechanism is taut, but we’ve
seen better ones on Samsung phones

(and lately, the Sony Ericsson W910i).
The front facia is dominated by

a huge, sparklingly-clear 2.4-inch
display. The screen equals that on
the N95 (which has the best among

cell phones).
Just below the screen is a whole new

navigational console. The directional pad
(D-Pad) now also acts like a touch-sensitive
scroll wheel, but the keys can also be used
like regular keys. Though it works OK, the
touch-sensitive scrolling needs refinement.
The playback control keys are cramped
near the D-pad and are frustrating. The

alphanumeric keypad isn’t quite what we
expected from Nokia; it is flat, hard, and frus-
trating to use. 

The music player is similar to that on the
N95 and other Symbian-based phones. However,
the Navi-scroll gives it an edge in terms of
usability. We’d like to see Nokia ironing out the
chinks in the touch-sensitive UI. Eight GB of
memory means enough space to pack in your
entire collection. Transfer times are reasonably
fast. Audio quality is good, and nearly equals
that of the N95; what we liked was the place-
ment of the 3.5 mm jack—it’s on the top. The
bundled earphones are good, but we liked our
music with the Bose in-ear plugs.

The camera is a complete let down, be warned:
just 2 megapixels doesn’t cut it anymore—at least
not on a high-end phone.

Three games come preinstalled—all of them
demos. The games are based on the Ngage plat-
form, and gaming is fun thanks to two additional
keys and the excellent display. Internet browsing
is great—thanks largely to the Web browser which
is the best you’ll get on a handheld today. 

The Nokia N81 8 GB retails at Rs 19,400. That
price is reasonable, but we feel the N95 is a
much better overall device—we’d recommend
it over the N81.

Features
Performance  
Value for Money
Build Quality
Overall 

RATINGS

Nokia E65
Not quite the E…

Nokia E51 
A classic reborn

As much as common sense tells us to avoid
slider phones for obvious reasons—as in

moving parts, wear and tear—they’re hot! The
E65 is red-hot (literally), and it’s available in
mocha, too. The entirely matte-finished body
offers good grip, and it manages to also look
classy. Red—russet brown really—might not
appeal to all, but the soft contours are nice.

With Bluetooth, WiFi, 3G, EDGE, and
more, the E65 is a business-oriented device
with some artistic flair. The number keypad is
well-laid-out with raised demarcations on
each key, similar to the N95—but remember
there’s no QWERTY. Keypad backlighting is
good. The 2MP camera and the music player
are pretty ordinary.

Pop the hood and it’s a Symbian S60 9.1
device. Quick Office has been provided, but
it’s Word and Excel editing at its barest (doc-
ument creation is out of the question). GPS
software is bundled: it’ll work with any
Bluetooth GPS device. There’s also a pretty
nifty text-to-speech module that will read out
data whose menus are placed in the Voice Aid

folder. Contacts can be read out, as can phone
numbers, recent calls, and the time. You also
get a voice assist while dialling, which will
help in the event of miss dialling while in a
hurry (only if you remember the number).
Still, we think the software needs a lot of
work to be decently functional.

The phone is slow, though, especially
while using the voice functions—
which bespeaks low memory. Call
quality is good, but not on par
with some of the other
Nokia phones we’ve tested.
Calls disconnect easily
when signal strength is at
one tower.

At Rs 16,800, the E65 isn’t
the definitive business phone that
the E series label might indicate. A phone
with very similar specifications and func-
tions with a cheaper price tag comes to
mind—the N80. But then all new phones
are costly, and a couple of price cuts may
see this one become popular.

If you are an executive in the market for a cell
phone, Nokia’s E series offers the best bang for

the buck. 
The E51 has a superb 2-inch display capable

of 16 million colours. The resolution of 240 x
320 is very high for a small screen, so fonts
appear sharp and crisp. In direct sunlight, the
screen is completely legible—even at half the
maximum brightness!

As compared to the E50, the new phone has
a completely revised keypad with dedicated
keys for Contacts, Calendar, E-mail, and Home.
This approach has its advantages: you can
directly access essential information at the
touch of a button. The soft menu keys, how-
ever, are a pain to use—they are too small for
comfort. The keypad is a delight to use—good
tactile feedback, and the key spacing is immac-
ulate. The rubberised keys for volume up /
down, push to talk, and the power switch are
hard to operate, and require some serious
poking to work.

The E51 is peppy—it uses the same processor
as the flagship N95 model. With 130 MB of
memory onboard, you can do lot of multi-
tasking without the phone getting slow, and
the memory can be expanded to 4 GB via the
microSD slot. The E51 runs on Symbian OS S60,
and crams in a lot of additional features. For
example, the Advanced Call Manager lets you
manage incoming and outgoing calls more effi-
ciently. WorldMate, an application meant for

frequent fliers, comes bundled too.
The Nokia E51 has an abundance of connec-

tivity options. It’s a 3G quad-band phone with
HSDPA, WiFi (802.11g), Bluetooth, Micro USB,
as well as infrared (just in case). The
WiFi locator feature helps a great
deal in searching for nearby WiFi
hotspots. Multimedia features
include an MP3 player (it sounds
good), a 2MP camera with still and
video shooting, and FM radio.

The phone performed admirably
during our tests; signal reception was
good, and so was the voice clarity.
Internet browsing was fast as compared
to the E50 or E61, thanks to the revised
Web browser. The pictures from the
camera were above average, but not in low
light. The speakerphone is clear, with little
or no echo on the recipient’s side. The
speaker is placed on the anterior side of the
phone, and though it’s loud enough, when
it’s placed on softer surfaces such as a bed or
sofa, the ringer volume gets muffled. Battery
life is good—we got around three days
with nominal usage and a terrific seven
days of standby. 

The Nokia E51 retails at Rs 13,000, and
we say that’s how Nokia should price all its
phones. For truckloads of features, snappy
performance, classy looks, and terrific
pricing, the Nokia E51 is a must-buy !

Features
Performance  
Build Quality
Value for Money
Overall 
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Palm Treo 750 
Windows on a Palm!

Motorola Moto Q V8
A great bundle—but that’s about it

The Treo 750 is the latest PDA phone from
Palm; it promises one-handed operation (a

Palm trait), though it’s a Windows Mobile
based device. The phone has a lot in

common with its predecessors on
the design front, and it has the

distinctive Palm device feel
to it—nice!

The new phone is tad
slimmer than its predecessors; it

feels lighter, and the curvaceous
design helps hide the bulk. 

The 2.5-inch LCD screen domi-
nates the front. It is sharp and com-

pletely legible in direct sunlight. The
navigational console (buttons) consists of

a five-way rocker, two soft keys, and four
additional pre-defined keys (Call, Windows

key, Hang up, and OK).
The dinky QWERTY thumb-board still

remains one of the best we’ve seen thus far;
though small and cramped, the chances of
mistyping are very low. 

The phone is powered by Window
Mobile Version 6; given that the phone
runs a 300 MHz processor, this may not
have been a smart choice—Windows
Mobile version 6 requires a speedy
processor. As available memory goes, the

Treo 750 is anaemic, and Windows’ dodgy
memory management doesn’t help either. 

Palm has done its bit to revamp the interface
and make it easy to navigate without touching
the stylus—something we really like about Palm
devices. The “Today Screen” shows information
such as messages, e-mail, voicemail, appoint-
ments, and more upfront; each of them can be
accessed using just the navigation keys. To place
a call, a contact name can be directly keyed in
from within the Today Screen.

On the performance front, the phone is no
slouch; the UI is generally zippy—applications
open in a snap. We did encounter some instances
when the phone nearly crawled when a lot of
applications were open, but then no-one opens
too many applications simultaneously in a real-
world situation. We encountered no signal issues,
and voice clarity was good with no background
noise or echo. The speakerphone quality is good,
too; however, the ringer volume needs improve-
ment. The camera quality is average.

At Rs 22,990, the Treo 750 is expensive con-
sidering that competing models offer a better fea-
ture set at a lower price. Palm is giving away a
foldable Bluetooth keyboard along with this
phone, but that still doesn’t justify the price. Nev-
ertheless, discounting the high price, the Treo
750 is a good Windows-based PDA phone.

The Moto Q runs on Windows Mobile 6, and
the user interface is zippy. By default, the Moto Q
uses Motorola’s theme, but we prefer the Win-
dows theme. The Today screen can be customised
to show events such as meetings and birthdays, as
well as e-mails and text messages. 

The “Documents To Go” application comes
preinstalled, and it’s great; it ably handles Word,
Excel, PowerPoint, and ZIP files. A default Win-
dows file manager helps browsing the device
effectively. System tools include a memory man-
ager and a task manager. (The task manager is
useful for when you need to know about back-
ground processes and kill them.)

Multimedia features are mediocre; Windows
Media Player can be used for MP3s and video. The
1.3MP camera is strictly okay; the photographs are
passable, and video capture is jerky. Connectivity
options include USB, Bluetooth, IR, GPRS, and
EDGE. Motorola has been generous with the
bundle: a portable adapter, a good-quality leather
pouch, a headset, the USB cable, the 1 GB miniSD
card, and two batteries. The higher-capacity bat-
tery is fatter and requires a different battery cover,
which also comes bundled.

Rs 17,325 is expensive for the hardware on
offer. The Nokia E61i with WiFi and better multi-
media features is available for less.

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

ASUS P750 
The über business phone

ASUS P526 
PDA for the masses

The ASUS P750 is top-of-the-line, 3G capable
PDA phone that has every possible feature

you’d ever want. The design is gorgeous, and
the phone looks great in its matt black outfit. 

Though oriented towards executives, the
P750 lacks a QWERTY keypad; it does have
touch screen, which in combination with Win-
dows Mobile 6 makes up for the lack. There are
five input options available, and the XT9
option works like a charm—it can predict
words better than the old T9 dictionary most
other cell phones have. 

The 320 x 240, 2.6-inch touch screen is
good; it lacks brilliance (only 65K colours) but
it works. The joystick and jog dial have excel-
lent tactile feedback, and they never jump a
menu. The alpha-numeric keypad is well
spaced out and works out great for typing
short messages. 

The P750 comes loaded with an abundance
of pre-installed applications—Microsoft Office
6.1, including Word, Excel, PowerPoint, Notes
and Calendar, is the highlight. The P750 also
features GPS, a business card reader, UR time
home screen, Remote presenter, Java, ASUS
launcher, etc.—this phone is a treasure trove.    

The media player supports MP3, WMA,
AAC, AAC+ and 3GP. The audio quality is good,
considering that this is a business phone. The

onboard 3 megapixel camera delivers reason-
ably good photographs , provided there is
adequate light; video recording is passable.
The phone comes with 65 MB of memory,
which can be augmented to up to 2 GB
via the microSDHC slots. 

Internet browsing was relatively
fast, and setting up WiFi network is
smooth, without any hiccups. Other
connectivity options include Blue-
tooth, GPRS, HSDPA and USB. ASUS
has been generous with the bundle—
nice leather pouch, USB cables,
adapter, in-car phone cradle, and a
box full of manuals.  

The P750 performed
admirably. The signal reception
was good; in low reception areas
calls weren’t dropped. Voice
clarity is great, and the speaker-
phone is loud and clear. On nominal usage—45
minutes of talking, some Internet access
and music—the phone stayed alive for
three days. 

At Rs 32,000, the P570 is a good deal
for the hardware and the software on
offer. Most importantly, the P750 
delivers in the area that matters the
most—usability.

The P526 is an affordable PDA phone that
goes head-to-head with the Sony Ericsson

P1i and Nokia E61i. Priced at Rs 17,000, it offers
a good value as an entry level touch screen
based cell phone. The handset’s design is very
similar to its high-end sibling, the P750. The
P526 is well-proportioned, and feels more com-
fortable to hold than Nokia’s E61i. 

The P526 doesn’t have a joystick, and com-
pletely relies on the touch screen for naviga-
tion, which isn’t very intuitive. The soft menu
buttons and two dedicated buttons are in the
form of a small thin strip, and are difficult to
operate. The keypad is well spaced, and offers
good tactile feedback. 

The P526 is also comes bundled with the
necessary applications—Mobile Word, Excel and
Powerpoint. PIM functions include a Meeting
Time Planner, Remote Presenter, Voice com-
mander, business card recognition and Java
support. The phone also includes GPS, but the
corresponding software needs to be installed
separately. 

Audio quality is so-so, and can’t match the
Nokia E61i or Sony Ericsson P1i. The 2 megapixel
camera delivers decent photographs, but only in
well-lit rooms. Outdoors, it performs like any
other 2 megapixel camera; good exposure and

consistent colour accuracy. The phone comes
with 128 MB of internal memory, and that can
be increased via the microSD card. 

Internet browsing on GPRS was slow, but
that’s more of a provider issue. No WiFi is a
serious shortcoming; the competition
has it, and they also have the newer
Bluetooth 2.0 with A2DP, while
the P526 just has version 1.2.
The ASUS P526 has good
signal reception, and
we had no problem
with dropped calls or
static. Voice clarity
was good, and the bat-
tery survived for two days
on 45 minutes of talk,
GPRS usage and tinkering
around with GPS.

To summarise, the ASUS P526
performs well, comes pre-installed with
useful applications and has loads of fea-
tures but misses out on essentials such
as WiFi. If you want an affordable touch
screen PDA phone, then the ASUS P256
fits the bill. However, also consider
Nokia E61i and Sony Ericsson P1i as
viable options.

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS
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The Moto Q marks Motorola’s entry into the
highly-competitive PDA cell phone market.

The company has earlier tried getting into this
market via their A series of phones (Moto

Ming), but failed to garner any footing. 
For the Moto Q, Motorola has gone

with the tried-and-tested design for a
QWERTY phone. It is wide but well pro-
portioned, and therefore feels much
better to hold when compared with
Nokia’s E61/61i. Lessons learnt from the

RAZR have been used to good effect on
the Moto Q; the phone is slim for a PDA

phone.
Finished in jet black, the exterior has a

rubberised feel, and the body offers excel-
lent grip. Except for the navigational D-pad,
all the buttons are flat and at times difficult

to press. The QWERTY keypad offers excellent
tactile feedback and equals that of those on

high-end PDAs such as those from Black-
berry and Palm. 

The 320 x 240, 2.4-inch, 65K colour
screen seems dated; the Nokia E61 has had
a 16 million colour screen for a long time.
The Moto Q has an anaemic 40 MB of
internal memory, which can be augmented
via the bundled 1 GB mini SD card.

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS
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Sony Ericsson P1i 
Fixing old mistakes

ASUS M530w
Nokia’s bane

The P1 is the latest in Sony Ericsson’s busi-
ness line, succeeding both the P990i and
the M600i—bringing the former’s func-

tionality to the latter’s form factor.
Its dimensions are nearly the same
as the M600i, adding a couple of
millimetres to the thickness, and
its style statement is in Chinese—
the shiny plastic sides and the
chrome details look downright
tacky, and we prefer the M600i’s
matte finish. It’s based on the same
Symbian UIQ 3 platform as the P990i
and M600i, with a few minor changes.
The OS is definitely quicker, which is
probably due to the oodles of program
memory that the phone comes with—
128 MB, doubling the M600i’s 64. Other

than that, there’s nothing remarkably
new here.

Just like the M600i, the phone doesn’t fea-
ture any soft-keys, and you’re expected to

operate it using either the stylus or your
fingers on the touchscreen. There’s also
the three-way jog dial, which thankfully
does away with the annoying protrusion
that featured on the previous phones. The
screen itself is wonderfully vibrant and
quite responsive to touch, but is naturally
a fingerprint magnet. We recommend

slapping on a screen guard the second you open
the box—the screen’s responsiveness will suffer
a tad, but it’ll be worth it. The stylus is longer
and easier to write with, and its locking mecha-
nism seems much firmer than the M600i’s
flimsy setup. The QWERTY keypad is the same
as the M600i—two letters to the key—and is just
as easy to get used to. 

The 3.2 megapixel camera is respectable,
though not exceptional—indoor photos are a
bit grainy, but overall, the clarity and colour
balance of the photos satisfies. There’s a
second camera on the front for video calls, but
you can’t take self-portraits with it. Like the
P990i, this model also comes with a business
card scanner—just take a photo of a business
card, and the OCR software will create a new
contact for you. The feature works just as well
(or as badly, as the case may be) as the one 
on the P990i. 

In the connectivity department, the P1i
supports 3G (but no EDGE) and WiFi—802.11b,
to be precise. WiFi connection speeds are quite
decent, and battery life thankfully doesn’t
suffer for it. 

The P1i isn’t really light years ahead of the
P990i, but it definitely nudges it off top spot.
There’s no annoying flip top, the audio levels are
louder and the huge program memory lets you
multi-task like you’ve never multi-tasked before. 

The M530w is another entry level PDA phone
from ASUS—it lacks a touchscreen, but

includes a full QWERTY thumb board. The
M530W goes head to head with the Motorola

MotoQ and the Nokia E61i—right down to
the slim design. 

The ASUS M530w is offered in two
colours—white and black. We got the

pearly white for review, and the pho-
tographs don’t do it justice—it may

look like the old Sony Ericsson
T100, but the white body with
orange detailing manages to
look quite appealing. The navi-
gational buttons are well laid

out—they are large, comfortable
to use and have good tactile feedback.

However, the numeric keys have an
orange glow thanks to the backlight, and
the screen-printed numbers on them are
not easily legible. 

The M530w runs on Windows Mobile
6 and has all the standard features set of
the mobile OS. There is no ASUS
launcher application pre-installed here.

You get the ClearVue viewer for Word, Excel,
PPT and PDF file formats. Other applications
include Java, Remote presenter, Task Manager
and a business  card recogniser. 

The M530w’s multimedia features—espe-
cially music—are just passable. It supports MP3
and video playback, but entry level phones
from other makers will easily beat the M530w
at this. The 2 megapixel camera is quite similar
to one on the P256, and delivers decent photo-
graphs—nothing particularly remarkable here.

There numerous connectivity options—
WiFi, 3G, GPRS and Bluetooth.  Internet
browsing speeds are decent on WiFi and GPRS,
though the battery life takes a beating when
these features are used. We managed around
two days of battery life on nominal usage. We
didn’t encounter any problem with signal
reception, but voice clarity could do with
work—some crackles creep in. 

At Rs 18,500, the M530w goes head to head
with the Nokia E61i, which has a similar fea-
ture set. Given a choice between the two,
choosing one is a tough call; we’d stay with
Nokia E61i just for Symbian.

Features
Performance  
Build Quality
Value for Money
Overall 
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Apple iPhone
Bliss…

The iPod changed the way we listen to
music, and the iPhone is bound to

change the way we use a cell phone. It’s not
available in India yet, but we went ahead
and bought one to give you a glimpse of this
Next Best Thing. 

The 320x480, 3.5-inch display dominates
the entire length of the phone. The screen is
sharp, crystal clear and has excellent colour
reproduction. Watching videos is an
amazing experience. 

There is no keypad or QWERTY on this
phone—hence the huge screen. You use a vir-
tual keyboard—touch the letters to type
them in. It’s fun once you master it, but can
be inaccurate if you use your thumbs. 

The user interface is hard to describe in
words—once you get used to the touch,
using the phone becomes plain instinct.
Getting around menus is fun; swipe your
finger up or down to scroll any list, swipe it
left or right to move left or right. The single
button is used for exiting all applications—
as simple as it gets. 

The iPhone also has all the features of
the iPod. Music quality is good, but the
iPod sounds better. The bundled ear-
phones are rubbish as usual—no bass, no

highs, just mids. The headphone jack is
recessed, and all earphones don’t fit it
directly—they need an adapter, curse Apple.
Video playback is simply the best we have seen
on any portable media player. Viewing photo-
graphs is fun, and you can use your fingers to
zoom in and out—very natural. 

Safari does a great job of rendering non-
optimised Web pages—more so if you rotate
the phone to view sites in landscape mode.
To read, you can zoom in and out on any
part of the page.  The phone is completely
locked and installing additional appli-
cations requires hacking the phone; we
don’t recommend this. 

To conclude, this is the best
phone we have reviewed, period.
It’ll be wise to wait for the
iPhone’s official release in mid-
2008, though. 

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Blackberry Pearl 8120
Style++

The 8120 is the latest in Blackberry’s Pearl
series. Though venerable in the business

domain, Blackberries were devoid of any con-
sumer frills which other phones offered—thus
the Pearl 8100 was born, but it came with some
shortcomings. The 8120 improves on many
aspects but one—3G—but that shouldn’t matter
in India anyway. 

The 8120 is simply gorgeous—something you
will fall in love with at first sight. The phone is
slim, lightweight and feels superb to hold. Its
dimensions are perfect—comfortable in the palm
and the pocket. The 2.2-inch display may not be
the best, but it is bright enough to get your work
done. Properly aliased fonts are easy on the eyes
and make the most out of this screen. 

The 8120 makes do with a pseudo-QWERTY
keypad—two letters per key, and text entry is pre-
dictive. It takes a while to get use to this format,
but we got up and running on it within an hour.
The roller ball (pearl) at the centre is used for
navigating menus, pages, etc., and works like a
charm. The unusual input method feels odd, but
once you get used to it, going back to another
format is boring. 

Business features are the forte of Blackber-
ries, and that requires no introduction. The
phone can easily handle most commonly used
files types—DOC, XLS, PDF, etc. The PIM func-

tions are well implemented, and are quite 
easy to grasp. 

The 8120 supports most music formats,
and does a good job of playing them. It
even plays MPEG4 video. The 3.5 mm jack
lets you plug in better earphones if you
want them. The jack is placed near the top
edge, and will be uncomfortable when in
your pocket. The phone comes with a
paltry 64 MB of internal memory, but sup-
ports a hot-swappable microSD card. Black-
berry hasn’t been able to fix the basic issues
with their cameras—photographs lack
sharpness, and tonal accuracy suffers. 

Internet browsing using WiFi was great;
not so much with GPRS. The phone also sup-
ports Bluetooth and USB. When it comes to
the core function of being a telephone,
Blackberry outshines most and the Pearl 8120
is no exception. It has the best call reception in
this entire test. During our test, the phone
remained alive for four days before
needing a recharge. 

At Rs 25,000, the Pearl 8120 is an excel-
lent business device with just one short-
coming—no 3G (high speed internet). If
you are interested in this model for the
multimedia capabilities, we’d advise you
to look elsewhere. 

Features
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Build Quality
Value for Money
Overall 
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BRAND 
MODEL

Price (Rupees)
Comments

Features
Physical Specs
Form Factor
Dimensions (L x W x H) (mm)
Weight (grams)
Screen Resolution (pixels)
Screen Size (inches)
No Of Colours (Screen)
Touchscreen (Y/N)
Dual Screen (Y/N)
Network Bands
Memory
Phone Memory
Expandable Memory/Type
Other Features
Keypad (Regular/QWERTY)
Address Book Capacity
No Of Calls In Register (Made/Rec./Missed)
Voice Recorder
Voice Dialling
Talk Time (Claimed) (hours)
Standby Time (Claimed) (hours)
Operating System
Connectivity
Browsing (GPRS/HSCSD/EDGE/3G) 
Connectivity (WiFi/Bluetooth/IR/USB)
Camera Specs
Camera (Y/N)
Resolution (Mega Pixels)
Video Capture (Y/N)
Dual Cameras
Flash (Y/N)
Auto Focus (Y/N)
Camera Settings (Scale Of 10)
Multimedia
Music Formats Supported
Playlist Features (Scale Of 10)
Audio Quality (Scale Of 10)
Bundled Earphones Quality (Scale Of 10)
Video Playback Quality (Scale Of 10)
FM Radio (Y/N)
Build Quality (Scale Of 10)
Body
Keys
Ergonomics (Scale Of 10)
Interface (UI)
Navigation & Menus
Keypad Layout and comfort
Performance
Signal Reception (Scale Of 10)
Voice Clarity (Scale Of 10)
Processing Speed (Scale Of 10)

Scoreboard                      Lifestyle
LG

KE770

Rs 7,990
+ Good value

– Multimedia lacks bite

Candybar
105 x 46 x 9.9
79
176 x 220
1.77
256 K
No
No
Triband

70 MB
microSD

Regular
1000
50 / 50 / 50
Yes
No
2.5
200
Firmware

Yes / No / Yes / No
No / Yes / No / Yes

Yes
2
Yes
No
Yes
No
5

MP3, AAC++
5
4
5
5
No

7.5
7

6
6
6

6
6
6

LG
KE970

Rs 11,990
+ Good build quality

– Mediocre camera

Slider
99.8 x 50.6 x 13.8
119
240 x 320
2.2
256 K
No
No
Triband

50 MB 
microSD

Regular
1000
50 / 50 / 50
Yes
No
3
280
Firmware

Yes / No / Yes / No
No / Yes / No / Yes

Yes
2
Yes
No
Yes
Yes
5

MP3, AAC++
5
5
5
5
No

7.5
7

6
6
5

6
6
6

Motorola
RAZR2

Rs 16,799
+ Stylish

– No memory slot

Clam shell
103 x 53 x  11
117
240 x 320
2.2
256 K
Yes
Yes , 2.2-inch 256K
Quadband

420 MB (or 2 GB)
None

Regular
1000
30 / 30 / 30
Yes
No
7
330
Firmware 

Yes / No / Yes / No
No / Yes / No / Yes

Yes
2
Yes
No
No
No
5

MP3, AAC, AAC+
6
7.5
6.5
6
No

7.5
6.5

6
6
6.5

7
6
6.5

Motorola 
SLVR L9

Rs 8,399
+ Slim

– Rudimentary UI

Candybar
113 x  49 x 11.5
96
176 x 220
1.9
256 K
No
No
Quadband

20 MB
microSD

Regular
NA
10 / 10  /1 0
Yes
Yes
4
350
Firmware

Yes / No / Yes / No
No / Yes / No / Yes

Yes
2
Yes
No
No
No
4

MP3, AAC, AAC+, MPEG4
5
7
6.5
5
Yes

7
6.5

5.5
5.5
6

7
6
6

Nokia 
N81 8GB

Rs 19,409
+ Sturdily built

– Mediocre camera

Slider
102 x 50 x  18
140
240 x 320 
2.4
16 M
No
No
Quadband

8 GB
none

Regular
Memory Limited
30 days
Yes
Yes
4
410
Symbian S60

Yes / Yes / Yes / Yes
Yes / Yes / No / Yes

Yes
2
Yes
Yes
Yes
Yes
7

MP3, AAC, MPEG4
6
7
7
6
Yes

8
6.5

7
7
6.5

7
7
7

Nokia 
N95 8GB

Rs 28,000
+ Great converged device

– Expensive

Slider
99 x 53 x 21
128
240 x 320 
2.8
16 M
No
No
Quadband

8 GB 
microSD

Regular
Memory Limited
30 days
Yes
Yes
6
280
Symbian S60

Yes / Yes / Yes / Yes
Yes / Yes / Yes / Yes

Yes
5
yes
Yes
Yes
Yes
7

MP3, AAC, AAC+, eAAC, WMA
6
7
7
6
Yes

6.5
6.5

7
7
7

7.5
7
7

Samsung 
G600

Rs 17,999
+ Stylishly built

– None

Slider
101 x 47.8 x 14.9
104
240 x 320
2.2
16 M
No
No
Quadband

55 MB
microSD

Regular
1000
30 / 30 / 30
Yes
No
3.5
300
Firmware 

Yes / No / Yes / No
No / Yes / No / Yes

Yes
5
Yes
No
Yes
Yes
7.5

MP3, AAC, AAC+, WMA
6.5
6
6
6
Yes

7.5
7.5

6
6
6.5

7
7
7

Sony-Ericsson
W910i

Rs 18,899
+ Superb music quality

– Bad keypad

Slider
99 x 50 x 12.5
86
240 x 320
2.4
256K
No
No
Quadband

40 MB
MS micro (M2)

Regular
NA
30 / 30 / 30
Yes
No
9
400
Firmware

Yes / No / Yes / No
No / Yes / No / Yes

Yes
2
Yes
Yes
No
No
7.5

MP3, AAC
6.5
7.5
7.5
5
Yes

7.5
4.5

6.5
6.5
5

7
6
6.5

Sony-Ericsson
K810i

Rs 15,534
+ Excellent camera

– Audio could be better

Candy bar
106 x 48 x 17
103
240 x 320
2
256K
No
No
Quadband

64 MB
MS micro (M2)

Regular
1000
30 / 30 / 30
Yes
Yes
10
400
Firmware

Yes / Yes / No / Yes
No / Yes / Yes / Yes

Yes
3.2
Yes
Yes
Yes
Yes
8

MP3, AAC, MPEG4
6.5
7
5.5
5
Yes

7
5

6.5
6.5
6.5

7
6
6.5

Sony-Ericsson
K850

Rs 20,995
+ Great looks

– None

Candybar
102 x 48 x 17 
118
240 x 320
2.2
256K
Semi
No
Quadband

40 MB 
MS micro (M2)

Regular
1000
30 / 30 / 30
Yes
Yes
9
400
Firmware

Yes / No / Yes / Yes
No / Yes / No / Yes

Yes
5
Yes
Yes
Yes
Yes
8

MP3, AAC, MPEG4
6.5
6.5
6.5
6
Yes

7
6.5

6.5
6.5
7

7
7
6.5

Lifestyle
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BRAND 
MODEL

Price (Rupees)
Comments

Features
Physical Specs
Form Factor
Dimensions (L x W x H) (mm)
Weight (grams)
Screen Resolution (pixels)
Screen Size (inches)
No Of Colours (Screen)
Touchscreen (Y/N)
Dual Screen (Y/N)
Network Bands
Memory
Phone Memory
Expandable Memory/Type
Other Features
Keypad (Regular/QWERTY)
Address Book Capacity
No Of Calls In Register (Made/Rec./Missed)
Voice Recorder
Voice Dialling
Talk Time (Claimed) (hours)
Standby Time (Claimed) (hours)
Operating System
Connectivity
Browsing (GPRS/HSCSD/EDGE/3G) 
Connectivity (WiFi/Bluetooth/IR/USB)
Camera Specs
Camera (Y/N)
Resolution (Mega Pixels)
Video Capture (Y/N)
Dual Cameras
Flash (Y/N)
Auto Focus (Y/N)
Camera Settings (Scale Of 10)
Multimedia
Music Formats Supported
Playlist Features (Scale Of 10)
Audio Quality (Scale Of 10)
Bundled Earphones Quality (Scale Of 10)
Video Playback Quality (Scale Of 10)
FM Radio (Y/N)
Build Quality (Scale Of 10)
Body
Keys
Ergonomics (Scale Of 10)
Interface (UI)
Navigation & Menus
Keypad Layout and comfort
Performance
Signal Reception (Scale Of 10)
Voice Clarity (Scale Of 10)
Processing Speed (Scale Of 10)

Scoreboard                      Business Business
ASUS
P526

Rs 16,990
+ Good value for money

– No WiFi

Candy bar
110 x 58 x 16
115
240 x 320
2.6
65K
Yes
No
Quadband

128 MB
microSD

Regular 
Memory Limited
20 / 20 / 20
Yes
Yes
4
150
Windows Mobile 6

Yes / No / Yes / No
No / Yes / Yes / Yes

Yes
2
Yes
No
No
No
7

MP3
6
5
5
5
No

7
7

6.5
7
6

7
7
7

ASUS 
M530w

Rs 18,490
+ Slim design 

– Small screen

QWERTY Phone
117 x  65 x  14
135
320 x 240
2.4
65K
No
No
Quadband

256 MB
miniSD

QWERTY
Yes
20 / 20 / 20
No
No
5
250
Windows Mobile 6

Yes / No / Yes / Yes
Yes / Yes / No / Yes 

Yes
2
Yes
Yes
Yes
No
6

MP3, WMA
5.5
5.5
5
5
No

7
6.5

6
6
6.5

7
7
7

ASUS
P750

Rs 32,000
+ Great features

– No QWERTY

Candybar
113 x 58 x 17
130 grams
240 x 320
2.6
65K
Yes
No
Triband

64 MB
microSD

Regular
Memory Limited
memory limited
No
Yes
6
240
Windows Mobile 6

Yes / No/ Yes/ Yes
Yes / Yes / No / Yes

Yes
3
Yes
Yes
No
Yes
6.5

MP3
6
6
5
5.5
No

7
7

6.5
7
6

7
7
7

BlackBerry
8120

Rs 24,990
+ Excellent business phone

– Lacks 3G

Candybar
107 x  55 x  14
91
240 x 260
2.2
65K
No
No
Quadband

64 MB
microSD

Semi-QWERTY
NA
NA
No
No
4
360
Firmware

Yes / No / Yes / No
Yes / Yes / No / Yes

Yes
2
Yes
No
Yes
No
6.5

MP3
6
6
6
5.5
No

7
7

7
7
6.5

7.5
6
7

Nokia 
E65

Rs 16,800
+ Stylish

– Feels filmsy

Slider 
105 x 49 x 15
115
240 x 320
2.4
16 million
No
No
Quadband

128 MB
microSD

Regular
Memory Limited
30 days max
Yes
Yes
6
265
Symbian S60 UI

Yes / Yes / Yes / Yes
Yes / Yes / Yes / Yes

Yes
2
Yes
No
No
No
5

MP3, AAC, MPEG4
6
6
5
6
No

7
7.5

6.5
6.5
6.5

7
7
6.5

Motorola
Moto Q V8

Rs 17,325
+ Slim and light

– Relatively expensive

Qwerty phone
116 x 64 x 12
115
320 x 240
2.4
65K
No
No
Quadband

40 MB 
miniSD

QWERTY
Yes
NA
Yes
Yes
5
240
Windows Mobile 6

Yes / No / Yes / No
No / Yes / Yes / Yes

Yes
1.3
Yes
No
Yes
No
5.5

MP3, AAC
5
5
5
5
No

6.5
6.5

5.5
5.5
6.5

6
6
6

Nokia 
E51

Rs 13,000
+ Excellent value for money

– None

Candy bar
114 x 46 x 12
100
240 x 320
2
16M
No
No
Quadband

130 MB
microSD

Regular
Memory Limited
30 days 
Yes
Yes
4.5
310
Symbian S60

Yes / Yes / Yes / Yes
Yes / Yes / Yes / Yes

Yes
2
Yes
No
No
No
6.5

MP3, AAC
6
6
5
5
Yes

7.5
7.5

7
7
7

7.5
7
7.5

Palm
Treo 750

Rs 22,990
+ Great one handed operation

– Relatively expensive

Candybar
111 x 58 x 22
154
240 x 240

65K
Yes
No
Quadband

60 MB
miniSD

QWERTY
Memory Limited
Memory Limited
Yes
No
4.5
200
Windows Mobile 6

Yes / No / Yes / Yes
No / Yes / Yes / Yes

Yes
1.3
Yes
No
No
Yes
5.5

MP3
5
5
5
5.5
No

7
7

7
7
7

7
7
7

Sony-Ericsson
P1i

Rs 22,500
+ Feature rich

– None

candybar
106 x 55 x 17
124
240 x 320
2.6
256K
Yes
No
Triband

160 MB
MS micro

QWERTY
Memory Limited
Memory Limited
Yes
No
10
440
UIQ 3.0

Yes / Yes / No / Yes
Yes / Yes / Yes / Yes

Yes 
3
Yes
yes
Yes
Yes
6

MP3, AAC
6
6
6
5
Yes

7
7

6.5
6.5
6.5

7
6.5
6

Apple
iPhone

NA
+ Great user experience

– No 3G, video recording

Candybar
115 x  61 x 11
135
320 x 480
3.5
16 M
Yes
No
Quadband

8 GB
No

Touchpad
Memory Limited
Memory Limited
Yes
No
8
250
Mac OSX

Yes / No / Yes / No
Yes / Yes / No / Yes

Yes
2
No
No
No
no
5

MP3, AAC
8
6
5
5
No

7
7

9
9
7

7
7
7
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In this comparison test, we’ve omitted prod-
ucts we reviewed in the last comparison;

most of those products are still available in the
market, though. Given the choice, choosing
the right phone for the right kind of applica-
tion can be confusing. 

MUSIC PHONES
Entry Level
At the entry level, nothing beats Sony Eric-
sson’s Walkman phones—the W200i is where
it starts from, but if you can stretch you budget
by a couple of thousand, we recommend the
W610i 0r W810i. Both these phones have excel-
lent music quality, and are available for under
Rs 10,000. 

Mid-range
Here you have options from both Nokia as well
as Sony Ericsson. The SE W850i and W660i
have excellent audio quality, and come with
good earphones. Nokia N73 Music Mdition and
the XpressMusic 5160 and 5130 have good
music players too. Most of these phones fall in
the Rs 10,000-15,000 price bracket. The Sony
Ericsson phones win here for their excellent
sound. 

The Best
Nokia’s N95, the Apple iPhone and the Sony
Ericsson W910i are you best bets here.  There
isn’t much difference in music quality between
the N95 and W910i. While the N95 is bulky, the
W910i is light and slim—it also has the “shake”
controls and SenseMe technologies. The N95 is
a more complete package, so we recommend
that. The iPhone offers a great user experience,
but the sound quality can’t match the other
two—especially on the bundled earphones. 

CAMERA PHONES
Entry Level
Here, the Cybershot phones from Sony Eric-
sson are your best option. The SE K550i is a
superb entry level camera phone, which also
has a good music player and FM radio. The
trusted K750i is still a worthy phone here. The
Nokia N70 also has a comparable camera, but
it’s an old phone and not everyone might like
to own it. 

Mid-range
The Sony Ericsson K810i is an excellent 3.2
megapixel camera phone, and at Rs 15,000, is
quite a package. The K790i—the first 3.2 megapixel
phone in the market—is now available for Rs
11,000, and makes for terrific value. Nokia fans
can get similar camera quality in the Nokia N73
and N73 ME. The camera on the XpressMusic
Nokia 5160 is also in the same league. 

Decision Maker
Top Of The Line
The Nokia N95 and N82 have 5 megapixel cam-
eras, and they deliver crisp photographs in all
conditions—with a few tweaks in settings. Both
have extensive in-camera controls, and also
offer a TV out cable. If the N95 is too expen-
sive for you, go for the N82. The Sony Ericsson
K850i delivers good photographs, but there are
few issues—photographs tend to under-expose
when the flash is used; hopefully, a firmware
upgrade will fix this.

BUSINESS PHONES
Entry Level
The Nokia E51. Nothing beats this newcomer—
3G, WiFi, Bluetooth, IR, USB—you’re always
connected in every possibly way. A good
screen, decent multimedia features and a
sweet price of Rs 13,000 gives it an edge over
every other phone in this category. 

Mid-range
The ASUS P526, the Motorola Q, the ASUS
M530w, the Nokia E61i and Sony Ericsson P1i
are few of the better options here. Nokia’s E61i
has been our favourite. It is feature-laden,
delivers good performance and is priced rea-
sonably—it’s still difficult for us to recommend
something else. However, if you want a phone
with a touchscreen, then the ASUS P526 and
Sony Ericsson P1i are your best bets. 

High-end
The Blackberry platform is hard to beat when
it comes to core business-oriented features.
The Curve 8300 and 8830 World Edition are
the best, but if you care for better multimedia
options, we suggest the Nokia E90—it’s sturdy
and powerful. The Blackberry Pearl 8120 is a
great phone if you don’t want to carry a bulky
business phone.  If you want more PDA fea-
tures—and a touchscreen to boot—you should
look at the ASUS P750. 

PHONES TO FLAUNT
The Apple iPhone! No one has it, and that’s
good enough reason to buy it. That apart, the
iPhone is a gadget in its own class, and will get
you noticed wherever you go.  

The Motorola RAZR V2 is the phone to have
if you want something that’s a little more,
well, legal. The pearl-grey finish, large LCDs
and intricate detailing makes the phone stand
out from the crowd. The new RAZR is not all
show—it has a lot of practical features and a
completely revised user interface too. It’s also
much cheaper than the iPhone. The Black-
berry Pearl 8120 is another classy-looking
phone, but only for serious businessmen 
on the move. 

sanket_naik@thinkdigit.com  
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Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone +91-9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

5.1 Speaker Sets
Artis S6600R/FM

Good performance, radio
None in particular 

Contact Kunhar Peripherals Pvt Ltd
Phone +91-22-66345758
E-mail mail@kunhar.com
Price Rs 8,500

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Tech India Pvt Ltd
Phone +91-9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
No remote sensor at rear

Contact Acer India Pvt Ltd
Phone +91-9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,35,000

Digital Cameras
(High-End)
Canon PowerShot A570 IS

Good overall performance
Lacking in macro 
performance
Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 13,995

Digital Cameras
(High-End)
TECH-COM DSC-524X PLUS

Good features and 
performance
Average macro performance

Contact Shree Sagarmatha
Distributors Pvt. Ltd.

Phone +91-11-26428541 
E-mail techcom@airtelbroad-

band.in   
Price Rs 5,250

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 4,000
MobiBlu DAH-2100

Good performer
Tiny screen for video

Contact J.J.Mehta & Sons
Phone +91-22-24306356
E-mail   info@jjmehta.com
Price Rs 4,000

MP3 Players up to Rs 10,000
Sandisk Sansa e250

Good performance, 
feature-rich
Tacky scroll wheel

Contact Rashi Peripherals Pvt Ltd
Phone +91-22-67090909
E-mail navinderc@

rptechindia.com
Price Rs 8,150

Internal DVD-Writers
Samsung SH-S203

Performance, inexpensive 
None in particular

Contact Samsung India
Electronics Pvt Ltd

Phone +91-11-41511234
E-mail c.serrao@samsung.com
Price Rs 1,200

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 7,500

Digital Tools l A-List

Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up
Contact Technology and Gadgets
Phone +91-22-23823331
Web site
www.technologyandgadgets.com
Price Rs 35,000

Graphics Cards 
(Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular
Contact Asus Technology Pvt Ltd
Phone +91-22-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site ww.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 4,500

Multimedia Cell Phone
above 20,000
Nokia N95 8 GB

Great all round
Little bulky

Contact Nokia India
Web site www.nokia.com
Price Rs 28,000

Below Rs 12,500
Sony-Ericsson W910i 

Great sound
Flat and clumsy keypad
Contact Sony Ericsson Mobile 

Comm. India Pvt Ltd
Web site www.sonyericsson.com
Price Rs 19,000

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone +91-22–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone +91-120-4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 5,995

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800-222-422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone +91-44-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone +91-22-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone +91-124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

The best products tested so far in different 
hardware and software categoriesThe A-List
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Value Executive Phone
Nokia E51

Loads of features
None

Contact Nokia India
Web site www.nokia.com 
Price Rs 13,000

Business Device
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt.
Ltd.

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

PC Webcams 
Logitech QuickCam IM

Strong performer
Manual focus

Contact Compuage Infocom Ltd
Phone +91-22-65297356
E-mail india_getcreative 

@ctl.creative.com
Price Rs 1,995
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Samir Makwana

It’s important to know where you are in the
world; this is why we have Global Positioning
Satellite (GPS) even entering our daily lives—

the latest high-end mobile phones, cameras and
who knows what else. Industries like logistics
have depended on it to get to their destination on
time. But where does all the information on your
GPS device come from?

GPS is part of a much larger umbrella
called Geographical Information Systems (GIS).
By definition, Geographical Information
Systems are computer-based tools and tech-
nologies used to collect, convert, analyse,
model, produce and demonstrate spatial infor-
mation. Simply put, it’s all the information
from your geography textbook put into a data-
base. Today GIS is used in natural resource
management, environmental planning, disas-
ter management, defence, transport and logis-
tics, urban development, public utilities
works, and business applications where you
need to know the geography of the area.

I’m Special
Let’s start with what you can specialise in:
GPS: Global Positioning Satellite systems do just

that—use a satellite to tell you your position on
the Earth. This is easily the most widely used GIS,
and is a great enabler for many more.
Remote Sensing: Remote sensing is the science
of obtaining information about locations on
Earth—its natural resources, for example—with-
out physically going to the location. The Earth’s
surface is scanned by using the sensors on satel-
lites, and can then be analysed using electro-
magnetic radiation.
Photogrammetry: Photogrammetry is the
technique of creating 2D or 3D models,
images, maps or scale drawings of a region,
based on photographs. Put simpler, it’s the
technique of telling how high a mountain is by
clicking a couple of pictures from different
angles and making a few calculations. The art
is incredibly old; today, Microsoft’s
PhotoSynth represents its future.
Spatial Image Processing And Analysis: Spatial
means ‘pertaining to space’. Digital images from
satellites are analysed to create data structures,
and then analysed mathematically. This also
involves conversion (from analogue to digital and
so on), enhancement, display and finally drawing
information from those images. 
Projection System: The method of transforming
real-life surfaces to two-dimensional maps is
called a Projection System. This process requires

Shrikrishna
Patkar
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applications being developed.

At this stage, they're expected to acquire
comprehensive knowledge and experience of
the usage as well as development of GIS
software and tools. 

Analysts: These are professionals who have
strong fundamentals of mapping, are excellent
with GIS applications, and have had some work
experience as developers or technicians with GIS
projects. Their job involves the study and analysis
of GIS projects, and where necessary, suggest
tools to meet the project’s requirements. 
GIS Analysts with enough experience can also
choose to be independent consultants.

Project Co-ordinator/ Manager: After
managing GIS projects for about five or more
years, one can expect to be at the position of a
GIS Project Co-ordinator/ GIS Manager. In GIS
services providers, project managers play
crucial role in getting more business. Usually,
professionals stay at this position for 5-8 years
but in exceptional cases, they manage to jump
directly to the top level before that period.
Administrative Positions: Administrative
positions like Business Development Manager
involve interacting with clients, and bringing
in more projects for the organisation. Their
roles bend more towards the management
side, but knowledge of GIS technologies and
market trends—both domestic and
international—is crucial. 
Verma echoes, “New technologies are constantly
coming, and this is a fast evolving field, requiring
candidates to stay abreast with the latest
happenings—they must take the initiative to stay
up to speed if they want to keep growing at the
pace of the industry.”

System Requirements 
Careers in GIS start with a passion for
geography—ideally cultivated in school. 

“Graduates from myriad fields such as civil
engineering, geology, zoology, geo-technology,
geo-informatics, botany, statistics, economics,
commerce and business, geography including
cartography, remote sensing, environmental
science and sociology are eligible pursue
career in GIS”, says Mandar Mehta, CEO and
founder of Datapoint Computer Services,
which offers Engineering  Services
Outsourcing, KPO, BPO, ERP, Project
Management, Digitization/CAD, GIS and e-
Governance services. 

Interested students from Computer
Science and Engineering, Programming, Civil
Engineering, CAD / CAM professionals,
database systems specialists and Web
technology specialists find their place in GIS
software and Web development. 

Courses
In India, there are a number of courses that you
can opt for: a B.Sc. / M.Sc. in GIS or Remote
Sensing, an M. Tech in GIS or Geo-informatics,
and so on. At the Master’s level, students can
choose electives to specialise their education. In
addition, to several short-term courses like
diplomas and certifications are also available.
Many institutes—both Indian and internation-
al—even offer distance learning, some online.
Do remember to thoroughly evaluate your uni-
versity if you’re pursuing an online education.

Even government institutions and organisa-
tions like the Indian Space Research Organisation
(ISRO), the Geological Survey of India, the Space
Application Centre at Ahmedabad, the National
Remote Sensing Agency (NRSA), and the Survey
Training Institute at Hyderabad and offer short-
and long-term courses, and also conduct work-
shops frequently for an affordable fee.

Internships
One of the most important and exciting parts of
a career in GIS is the internship—real-world expe-
rience is a must. GIS employers are always look-
ing for cheap labour for low- and assistant-level
GIS tasks like data conversion. On the GIS soft-
ware development side, interns could be given
module programming, GIS software engine pro-
gramming and documentation, or even trained
as research and development assistants for GIS
software.  Students with internships with GIS
companies obviously get preference over others,
but having no experience is not a demerit.
Companies are always open to employ interns,
given the current dearth of a skilled workforce.

The Future 
“Today, the structure and uniform spatial infor-
mation about different regions of India isn’t
readily available as data sets with the
Government, but this indicates immediate
opportunities in the data conversion business,
and also multiple opportunities in its application
in several domains,” says Mehta. 

Though the pace of the GIS industry growth
is slow right now, there is a great demand for
skilled GIS professionals—not only for
Government, but also for commercial businesses.
Kapil Sibal, the Union Minister for Science and
Technology, at the Map World Forum in January
2007, mentioned that the Indian GIS market is
expected to shoot beyond the $1 billion mark by
2012. The estimated data conversion services
exports were $100 million in 2007, and are
expected to achieve $500 million in the next five
years. The global geospatial industry growth rate
ranged between 12 to 15 per cent annually.

Verma anticipates, “The future prospects of
the Indian GIS industry are huge, because of the
upcoming demand for premium quality digital
maps and consumer navigation services. There
will be demand at all levels of the value chain—
from collecting GIS data in the field accurately,
quickly and smartly, to compiling and processing
that to create digital navigable maps, building
products and services—both for consumers and
enterprises—on top of the maps.”

samir_makwana@thinkdigit.com
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lot of accuracy—the Earth is round, maps are
flat. Moreover, the special features of the area
under consideration also come into play.

Employment opportunities range from organ-
isations developing GIS software solutions, com-
panies providing GIS services, and different
departments with the Government.

The Situation
A typical GIS project would be something like
developing roads in a village to connect it to the
nearest town. There’s a lot of work involved, and
there are many roles that need playing:

Data builders, well, collect data about the
area—temperature, soil quality and other
geographical information. This data comes
from photographs of the location and images
taken by remote sensing, and then compiled
into maps, tables and figures. 

Digitisers convert all that data to a digital
format, which can then be used in software
and databases.

GIS Developers use GIS software
applications to model the area based on the
data, and customise it based on the needs of
the project.

GIS Analysts use the GIS data and the
original data to check for possible challenges in
the project and develop a plan for its execution.

The GIS Manager is in charge of the
overall planning, control and management
of all activities—from data collection to
data analysis.

“The beauty GIS as a career is that it absorbs
enthusiasts with both core and non-core GIS
skills. Individuals can be recruited by
organisations that create GIS products, or
those who use these products and offer GIS
services. However, for any industry, the main
problem lies in creating the data related to our
country’s demography, geography and
infrastructure—this isn’t tailor-made and thus
needs lot of effort to build”, says Manideep
Saha, Head-Infrastructure for India and SAARC
Region, Autodesk.

Though GIS a multidisciplinary career,
work experience and knowledge at different
levels can be categorised under:
Digitisers / Executives / Operators: Fresh
graduates from an IT background, with strong
fundamental knowledge of GIS / CAD software,
hardware like GIS Servers and geographical are
expected for such a role. The job profile

involves tasks like geo-spatial database editing
and processing, Computer-aided Mapping and
drafting by creating 2D and 3D environments,
quality checks and analysis of existing databases
and creating analytical presentations from
spatial data available in figures and tables.

“A strong fundamental understanding of
databases and database relations is necessary. It
is necessary to know how to structure queries
and execute them with an eye for detail, 
accuracy and quality. In data, each element is
unique and needs special attention, whereas in
programming, once you write a program
everything comes out correct”, informs Rohan
Verma, founder and head of MapMy India.com.

Those interested in working on the GIS
software development are required to learn
programming languages like C, C++, C#,
ADO.NET and Java, while those looking to work
on the Web development side should know
scripting languages (both server-side and client-
side) like JavaScript, AJAX, ASP, PHP and Perl. 

“The major tasks for beginners in Web
Development involve using JavaScript (AJAX in
particular) and interfacing with APIs such as
Google Maps, Yahoo Maps, and other services”,
says Kaushal Gala, ex-GIS Web Developer 
currently working at Dell Inc. in the US.

At the beginner level, you can get to know
the work cycle of GIS projects, and generally
get exposed to the industry. You can super-
specialise in a particular domain by working
with organisations that offer GIS services in
that area. After working for about two to
three years, you advance to the level of
Engineer / Technician.

Engineers / Technicians / Developers:
Developers are expected to design and develop
applications using GIS software engines and
GIS servers to meet project requirements.
These applications function with the database
of the digitised files at the back end. Engineers
and Technicians are required to keep the
database servers in sync with the GIS

“Data conversion
is the core
business area
currently with lot
of opportunities
arise due it’s
applications in
multiple business
domains.”

Manideep Saha
Head-Infrastructure for
India-SAARC region,
Autodesk 

Institute of Remote Sensing-Anna Univ.
Faculty of Science-Banaras Hindu Univ.
Indian Institute of Remote Sensing
(National Remote Sensing Agency)
Dept. of Applied Sciences,Environmental
Science and Engineering Group/Dept. of
Remote Sensing-Birla Institute of
Technology 
The Centre for Environmental Planning
and Technology (CEPT)-Ahmedabad
GIS Institute, Noida
Centre of studies in Resources
Engineering/Dept. of Earth Sciences-IIT
Mumbai
Dept. of Civil Engg-IIT Kanpur 
Centre for Atmospheric and Oceanic
Sciences-Indian Institute of Science
Indian School of Mines Dhanbad
Dept. of Environmental Science-Pune Univ.
National Remote Sensing Agency

Dept. of Geography-Univ. of Madras 
Dept. of Space Sciences-Pune Univ.
Dept. of Earth Sciences-Roorkee Univ.
Dept. of Geography-Gujarat University
Dept. of Geography-Jamia Millia Islamia 
School of Environmental Sciences-
Jawaharlal Nehru University 
National Bureau of Soil Survey and Land
use Planning, Nagpur
Space Application Center, Ahmedabad
Geological Survey of India Training
Institute, Hyderabad
NBSS & LUP, Nagpur
Survey Training Institute, Hyderabad
Centre of Studies in Resource
Engineering, Mumbai
Dept. of Geography-Utkal Univ.
Regional Remote Sensing Service Centres
at Kharagpur, Nagpur, Dehradun, Jodhpur,
Bangalore

Universities Offering Courses In GIS And Related Areas

Payday

Salary 
Per Annum (INR)
10 lakh and above
8—10 lakh
6.4—8 lakh
4 -6 lakh
1.2—3.2 lakh

Experience
(Years)
8—10
6—7
3—5
1—3
-

Designation

Administrative Positions
Project Lead/Project Manager
Analysts
Senior Designer
Digitizers/Executives/Operators

GIS is a growing industry, and there are
initiatives that need to be taken to
increase its popularity and fill the
employment void. 

“Along with awareness about GIS
as mainstream and upcoming career,
there is need to develop and follow a
uniform academic curriculum at the
university level. Increased support
from Government for using GIS in all
its departments for generating trained
work force is expected, since GIS

companies also look to the government
for geospatial data”, says Mehta.

There is also a need for including
GIS-related topics at the secondary
school level itself. “GIS and related
subject courses are rarely available at
the undergraduate level in India”,
notes Saha. Though many private
institutes offer courses in GIS and
related areas, the cost of training at
these institutes is much higher
compared to universities.

Points To Ponder
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the URL, you might well end up in a situation
where your visitor ends up at the squatter’s site
instead of yours. In extreme cases, you might end
up in the same situation that the White House did
not too long ago—the domain www.whitehouse.com
was taken over by a squatter with pornographic
links all over, so people who thought they were
visiting the White House home page (www.white-
house.gov) came away with a nasty shock. Court
battles ensued, and today, www.whitehouse.com goes
to a real Web site. 

Cybersquatting is illegal, and while some are
content to just choose another URL, you should
file a complaint with the Asian Domain Name Dis-
pute Resolution Centre [ADNDRC] (www.adndrc.org)
to get your URL freed. The site can be daunting
with all the legal jargon, though. If you don’t
want to do much dirty work, hire a third party like
DNRecover (www.dnrecover.com). Just fill up their
form and they’ll give you a cost estimate in 24
hours; once you give them the go-ahead, they’ll
do the footwork for you, and when your domain is
finally freed, you pay. 

Host? Check. Domain? Check. Now it’s time for
content. 

Choices, Choices
If you don’t want to pay an overpriced Web design
firm to design your site for you, don’t: there are
plenty of (perhaps even too many) open source
CMSes for you to choose from. From our own expe-
riences and the sheer number of new sites that
are adopting them, we can tell you that you don’t
need to look beyond Joomla (www.joomla.org) and
Drupal (www.drupal.org). Both are quite easy to
administer, though if you don’t have geeky lean-
ings, you might find yourself more comfortable
with Joomla’s graphical control panel. Both are
tremendously customisable, and you’ll also have a
wide choice of extensions you can install for even
more functionality.

Joomla has another edge over Drupal in that it
supports advertisement management right out of
the box. You can create clients, associate ad ban-
ners with them and tell the system how many
impressions the client has purchased for that par-
ticular banner. When you’re managing banners,
you can also get data on how many times the ad
was clicked. You can get all this in Drupal too, but
only after installing the Advertisement module.

Drupal’s categorisation—called Taxonomy—
takes a little while to understand; at the most
basic level, it lets you put content under multiple
categories, so you can file an item under “Job” and
“Mumbai” at the same time. Joomla, however, sup-
ports this only after you install an extension.

Finally, there are more themes—both free and
paid—available for Joomla. This shouldn’t make
too much of a difference, since the option to hire
a freelancer to design a theme according to your
specifications as always open. Overall, if you’re
maintaining your site yourself, pick Joomla for its
straightforward approach.

Google To The Rescue
One of Google’s more interesting projects in
recent times is Google Apps for Your Domain. It
lets you, in short, use Google services like Gmail,
Calendar and so on with your domain. So when

Digital Business l Smart SoHo

Nimish Chandiramani

It’s a daunting proposition to develop a Web
site for a home business, especially while
you’re juggling between all sorts of tasks to

keep the business up and running. Thankfully,
you now have a choice of many free tools to help
you do just that—but it’s not that simple. Many
of these tools are built with personal sites in
mind, so choosing what’s right for you requires
a discerning eye.

But we’re getting ahead of ourselves. The
first (and possibly the most important) part of
setting up a new Web site is choosing a good
Web host. 

The Ground Up
Choosing a Web host isn’t easy—you’ve got all
those colourful proclamations of unlimited
storage space and bandwidth to sift through,
and the catches (there’s always one) are pretty
tough to pin down. Your best bet is to get plenty
of reviews from people who’ve been using these
services, preferably someone you know person-
ally. In any case, don’t cough up till you’ve vis-
ited the WebHosting Talk forums (www.
webhostingtalk.com) and checked out what people
have to say about the host you’re about to

choose. Refer to the box What you need, What it
is for what to look for when you’re out Web
host-hunting.

Then there’s the question of where to host
your site—India or abroad? In India, the phys-
ical proximity helps—users will be routed
through fewer servers before hitting your site,
so they’ll get better access speeds. If you’re
going to cater primarily to Indian customers,
we’d have unhesitatingly recommended
hosting your site in India. Unfortunately, there
are caveats: Web hosting here is still in its nas-
cent stages, and the odd infrastructure issue
can crop up from time to time. There’s also the
fact that the prices here seem criminal com-
pared to hosts in the US. This is, of course,
bound to change, but it’s a chicken-and-egg sit-
uation—more people need to buy hosting for
prices to fall, and vice-versa. For now, you’ll get
much better deals with a US host like GoDaddy
(www.godaddy.com) or HostGator (www.hostgator.
com). For a whole lot of features—unlimited sub-
domains, unlimited e-mail addresses and such
(at a price, of course)—visit A Small Orange
(www.asmallorange.com) or SoftLayer (www.soft-
layer.com). The prices are significantly higher,
but you pay that price for much better relia-
bility and service.

So you’ve chosen a host and are ready to reg-
ister your domain name, but to your frustration
find that not only is your domain of choice
taken, it’s taken by a squatter...

Get It Back
Cybersquatting is just what it sounds like—
parking your virtual behind on a spot that
should belong to someone else, and then
demanding a ransom to let it go. Depending on

Shrik
rishna Patkar

@
The Office

Forget about
running your
business with
the phone and
personal
meetings—here’s
all the
information you
need to set up a
site that’ll take a
load off you
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people sign up for e-mail on your site, they’ll
see the familiar Gmail interface (complete with
the counter that shows them how big their
inbox is getting), but they’ll have an address
that ends with @yourdomain.com. You’ll also get
all the other natural goodness that Gmail
offers—rugged spam protection, IMAP access

and integration with Google Calendar. If you
pay for the Premier Edition ($50 per account
per year, with 25 GB storage for each), you even
get a 99.9 per cent uptime guarantee and 24-
hour support. 

If visitors need to know your schedule for
upcoming weeks or months, you can use
Google Calendar to publish them. Thanks to
configurable access restrictions, you can choose
to show visitors only when you’re free or busy,
and hide the information about the actual
event. If you’re working with someone who you
can’t meet with every day, Calendar becomes
an invaluable collaboration tool as well. Also
included in the package are Google Docs and
Spreadsheets, though they’ll be more useful to
you and your team than to your visitors. 

Some Random Wisdom
You can check out demos of Joomla and Drupal
at OpenSourceCMS (www.opensourcecms.com) to
see how they suit you, but we recommend actu-
ally downloading and setting it up on your PC
using software like WAMP, which installs
Apache, PHP and MySQL to your Windows PC,
then uploading the lot. If you’ve chosen cPanel
hosting, you don’t even need to do that—just
use Fantastico to install the CMS you want and
start building your site. If you decide halfway
through not to use it any more, you can unin-
stall it just as easily. 

Finally, always get yourself a .com domain—
nearly everyone uses the [Ctrl] + [Enter] com-
bination when they enter URLs (thinkdigit +
[Ctrl] + [Enter] takes you to www.thinkdigit.com
in any browser, for instance), so if you get your-
self, say, a .net domain, you’re just making vis-
itors type four characters extra, and nobody
wants that. 

nimish_chandiramani@thinkdigit.com

Storage Space: If you’re building a
site that’s mostly text, even a 500 MB
hosting plan will do. For many hosts,
the average is around 5 GB, which is
quite ample.
Bandwidth: This is the amount of data
transfer allowed to and from your site.
If someone downloads a 400 KB image
from your site, for example, you’ve
used up 400 KB of your bandwidth.
You’ll usually be well under your
bandwidth limit (mostly around 25 GB
or so) in your site’s early days.
Content Platform: The language that
your site’s content is written in. PHP is
standard for a CMS, so hosts that
don’t support it should be crossed off
your list. You might have to pay extra
for Ruby on Rails support—the
platform has started to gain a lot of
attention. It’s not as hassle-free as
PHP, though.
Databases: Where PHP is standard for
content, MySQL is the standard for

databases. Look for a host that offers
at least five free MySQL databases
with their plan. Beware of some Indian
hosts: their plans might look
attractive, but you’ll have to cough up
extra for each new database. 
Overselling: One of the universal
truths of hosting: just like hotels
overbook rooms and airlines overbook
flights hoping that someone will
decide not to show up, Web hosts sell
you storage space and bandwidth
hoping that you won’t use it all up.
They might sell 5 GB of space to ten
people, but host all those sites on a 20
GB hard drive. It’s a relatively safe
bet—for a small business site, even
500 MB is a lot, so no upper limits
might be hit. Just remember that
everybody oversells—that’s how they
get their plans to look so attractive. 
cPanel: This is a site administration
control panel that’s filled to the gills
with features, and is very easy to use.

Among other things, it features
Fantastico, an installation script that
automates the installation of a variety
of CMSes. 
Load Balancing: This is a feature of
more expensive hosting plans: your
site is hosted on two different servers,
so visitors are intelligently directed to
the one that has less load. In addition,
if your site has to be updated, it’s
done one server at a time, so the site
itself is never down. 
Shared Hosting: Like the term
implies, this means that your site
won’t be the only one hosted on the
server. This is your best choice in the
beginning, when your site isn’t getting
bombarded with traffic. Once visitors
to the site increase—or if you face
performance hassles—you can
consider moving to dedicated hosting,
where you’ll be the only site on a
particular server (naturally, this is
more expensive).

What You Need, What It Is

Joomla’s (top) graphical administration is easier to get
used to than Drupal’s (above) minimalistic approach
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“W e noticed that employees had unrestricted access to all
areas of the company and we wanted to curtail this. We
recently installed a protected access system, which not only

provides access based on fingerprint analysis, but also does time tracking
and payroll related work.

“With this system in place, we are now able to restrict employee
access to only their workstations. Once you have the data for all the
employees fed in, the system accurately records the time when an
employee entered and left the office premises.

“We have noticed quite a few benefits since the system was installed,
foremost amongst them being savings on stationary items. Apart from
that, the ability to accurately track employee working hours and payroll
is an added benefit.

“W e’ve installed a fingerprint access
control system which also keeps
employee time. This ensures that

employee access to the office is
compartmentalised while attendance records are
kept up to date automatically.

“We have noticed that after installing this
biometric system, we save approximately four man-
hours every month on recording and maintaining
the attendance records. Our efficiency is also
improved since all data is available instantly. The
fingerprint access control system ensures that
bookkeeping is eliminated and access to important
areas of factory such as the warehouse is restricted
to only authorised personnel. The biometric
scanners themselves are very efficient and work
only when they detect a fingerprint pattern. This
decreases battery and electrical consumption too.”

“The Bombay Stock Exchange has installed the NAC2500 series of
biometric fingerprint scanners for use in its premises. These
installations are networked to a central server over LAN.

“Apart from securing our premises, these systems give us the
ability to streamline the procedure of attendance, leave records, and
allow us to retrieve this data immediately when required. We also rely
on this system to generate various reports such as attendance, leave
status and compensatory offs.

“Since its installation, we find that the system is able to provide very
robust security measures apart from streamlining the attendance
procedure. We have seen cost savings in terms of manpower, man-hours
and stationery cost.”

Sachin Shah
CEO, Avadat Apparel Pvt. Ltd.

Vinay C. Dhopavkar,
AGM—Human Resources,
Bombay Stock Exchange

Jayesh Pancholi
CEO, Jet Pharma.

Bhavaniprasad Chaurasiya,
Deputy Manager—IT, Reliance Capital
Asset Management Limited.

“Since installing this system, we have found reduced
absenteeism amongst our Class IV employees, counter staff
and technicians. We were also able to stop proxy punching of

attendance cards. This has resulted in time saved, as we don’t have to
physically verify the presence of our employees. Apart from this, the
system is updated in real time so attendance records are always up to
date with the most relevant information.

“We found that the two most important cost savings we made with
this system were the man-hours saved and the reduced stationery
expense since there are no punching cards or ledgers involved.”

Manish Ved,
Manager,
Information Technology, 
Bombay Hospital.

“In the Business Process Outsourcing and Knowledge Process
Outsourcing business, we have to use the latest technologies to help
us save time, and the biometric scanners installed at all our

facilities help us do so. 
“The biometric installation at our premises is a multi-functional

personal identification device that takes a three-dimensional scan of a
person’s finger and compares it against a previously enrolled record.
Security guards are immediately alerted to unmatched prints. The scanners
are networked via our Intranet, and once a record is enrolled, it can be
accessible across all our sites if needed. The biometric installation also
allows for alternate methods of identification like entering a numerical
password on the number pad or using an RFID-enabled security access
card. The system allows us to create groups with different access levels, and
users can be quickly added to those groups.

“Since the installation is networked via the intranet, employees can
check their attendance stats themselves. Their attendance is automatically
recorded in the main attendance database even if they log in from a
different facility. The cost benefits with stationery expenses are hard to
ignore too. Since its installation, we have found that there is a marked
reduction in proxy punching and employee punctuality has increased.”

Krishan Moorjani,
Asst. General Manager,
Datamatics Technologies Ltd.
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As told to Asfaq Tapia (asfaq_tapia@thinkdigit.com)

“At our company, we have installed the ADF500 Biometric
Reader, which allows us to secure the premises with
various forms of security. Apart from being a fingerprint

scanner, the device has a number pad, which allows you to assign
numerical passwords. The system also works with RFID cards,
which can be carried in-person to authorise access to any area of
the company. 

These systems have been more reliable in granting conditional
access to employees than the earlier methods we adopted and
personnel authorisation at entry and exit points is as good as
personal verification. This system has helped us save cost on issuing
new punch cards to all employees every month and reduced our
expenses considerably. These biometric readers are installed in most
of our offices, since they also provide up to date information on
attendance and this helps us calculate payroll efficiently.”

Biometrics for
With a spate of companies employing Biometric tools to safeguard their businesses, we asked a few
if it really made a difference.

Security 
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User Sessions: This is the metric used for
determining the number of visitors that actu-
ally spend time on your site—it is usually
recorded for 30 minutes of users’ activity. It
accounts for both IP addresses, and the
number of users logged in, if applicable. User
sessions are great for understanding the behav-
iour of viewers, as data about which links the
viewer visited and how much time the visitor
has spent on each link.. This raises a few prob-
lems, for example the activity of the users who
might have remained inactive for 30 minutes
and then started clicking would be neglected.
Like Hits, this metric should not be taken at
face value either.

Unique visitors: This metric determines
the number of persons who has visited the
Website within a definite interval of time.
Unique visitors are determined by the combi-
nation of user agent (usually browsers, though
other programs like search engine spiders and
screen readers are included) and IP address.
The time interval can be a day or a week or a
month- it depends on the type of Website. So if
the time interval is one week and a visitor visits
it twice in two consecutive days, it would be
counted as one visit.

Bounce rate: This is a metric which indi-
cates the percentage of visitors who have left
immediately after visiting the site—usually five
seconds. For a site with multiple pages, bounce

Bhaskar Sarma

C
ustomers are the lifeblood of any
business. For businesses that depend
on Web visibility for their growth,
customers mean visitors on their
Web sites—those who come once

should be interested, and visit more often.
Whether you’re a business Web site, blog,
forum, hobbyist site or news site—any site that
earns money, in fact—you should care about
visitors. And before caring about them, you
must know about them, where they come
from, and what they want. This, and a variety
of other answers, can come from the wonder-
ful art of Web analytics.

Why Analyse?
As you might have already guessed, Web ana-
lytics means number-crunching. It means
using tools to collect data on the server side,
and then analysing that data to understand
where you, as an investor, are getting your
expected ROI (Return On Investment). At the
more basic level, the data will let you know
whether you have succeeded in reaching out
to your intended audience.

Consider this: you’re running a business
selling diapers, and it’s not a brick-and-mortar
business in that you have no outlets—just the
Web site. Being a new business, you don’t have
a widespread distribution network and for now
aim to cater to local needs. As a businessper-
son, you are necessarily interested in how
many people are visiting your online shop. You
run a Web analysis where you find that there
is only a minority of your visitors come from
your city, or neighbouring areas. And what’s
worse, there are very few who click on the cart
and make a purchase, which in Web analytics

jargon is called goal conversion. Your business is
obviously not becoming profitable, and you
need to do something about it. With Web
analytics, you get to know about this in
advance and hopefully do something before
the bills start arriving and the creditors start
queuing outside your doors. Without Web
Analytics, you would be in for a rude shock.

(Don’t) Bluff Your Way Through
And now, time for the customary round of
jargon-busting. Web analytics being a subject
which uses maths, most of these terms
describe percentages and numbers which most
tools use: 

Hits: This is one of the most widely used
terms when any talk regarding the popularity,
or otherwise of a Website comes up. However,
it is also the most widely misused. While hits
in general parlance means the number of visi-
tors, the technical definition of hits is any
request for a file from a file server. For exam-
ple, if a page has three images and there are
requests for them, this is considered as three
hits. Depending on the page elements like CSS
and JavaScript, a single viewer can generate
multiple hits, so remember that this figure is
never as high as it seems.

Page views: This is what people mean when
they are talking about hits. A page view is the
successful loading of a document on a server,
and doesn’t include visits by search robots or
error messages, requests for sound and video
files, or even CSS and images. Page views don’t
denote the number of people visiting the site,
because a single visitor can visit multiple pages
and request a number of documents.

AMEG
rate can also be measured as the percentage of
people who visit only one page, or do not click
on any links; this definition depends on the
tool you are using. If the number is high, it
means that something is seriously wrong with
your site, and you need to fix it. For most Web
sites, bounce rates between 20 and 35 per cent
are acceptable, and rates higher than 50 per
cent are worrisome. However, in case of blogs,
high bounce rates may not indicate that some-
thing is rotten—most people visit a blog to read
a single post, or check if there are updates. 

Conversion: This is a complex metric which
indicates how many visitors to your Web site
did what you wanted them to do.  Consider a
Web site that has a Donate button, Register
link or shopping cart. You want your readers
to click on these types of links, which are
called Goals in anlyticspeak. When a reader
clicks on such goals, that’s considered a
conversion. High conversion rates (the percent-
age of visitors that actually click on the goals)
indicate that all’s well. If this percentage disap-
points, then it’s back to the drawing board.
However conversion rate is entirely user deter-
mined, depending on the goals. 

Traffic sources: Traffic sources are the
places from which visitors come to a site. Tools
usually divide traffic sources for a Web site into
four types—direct traffic (by keying in URLs),
referring sites (other sites which have link to

Websites are only effective if they’re attracting the right visitors. Web
analytics helps you know them better

Digital Business l Smart Business

THE

NUMBERS
How well you know
what your users are
looking for, and how
quickly you can act on
it—is one of the most
important parameters
that contributes to
any online portal’s
success”

Suvomoy Sarkar
Head of Analytics

Info-edge

Shrikrishna Patkar
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widely used. It is suitable for small
sites and is integrated with AdWords.
However, the free account has certain
limitations: it can be used only if your
site has less than five million page
views per month: if page views exceed
five million then it has to be linked to
an active AdWords account that has a
minimum budget of $1 (or equiva-
lent). Another commonly used tool to

track user statistics—especially on
blogs—is StatCounter. This provides

rudimentary data like number of visitors over
a certain interval: nothing as detailed, or as
intimidating as Google Analytics. Microsoft is
launching its own analytics package called
Gatineau (still in private beta), which will
incorporate several new metrics like gender
patterns as well. How exactly they plan on find-
ing out visitors’ genders, they aren’t telling. If
you don’t mind shelling out the cash, you can
use ClickTracks, WebTrends, Omniture, Mint
or WebSitStory. All these come in different
versions and have a wide range of uses. These
tools are more suitable if you host your own
site, or have a need of getting customised
reports. Mint, for example, provides an
installer which has to be downloaded and
installed on the server. 

At a basic level, the data generated by these
tools is self explanatory, but to make sense of
that data and make appropriate changes to
your site, it takes a professional. Companies
who maintain big Web sites have dedicated
teams of analysts to monitor the latest trends
of visitor behaviour, and help businesses target
audiences better. Suvomoy Sarkar, Head of
Analytics at Info-edge (which is in charge of
Naukri.com’s traffic analysis) feels that
analysing the search histories of users can tell
companies what customers are looking for,
while also identifying the most important
keywords you should optimise your site for, or
the Ad-words you need to buy. “Web Analytics
has impacted a many-fold increase in profit
from our online marketing efforts, and nearly
two-fold increment in the user experience for
our search,” says Sarkar.  

The Bottom Line
Though Web analytics seems to be a forbidden
domain with an extremely high learning
curve, it’s not very difficult to apply some
small insights to optimise a Web site.  Avinash
Kaushik, Google Analytics Evangelist and
author of Web Analytics: An Hour A Day, opines
that even without going deep into technicali-
ties or bellyaching about low unique visitors or
hits, there are plenty of things that can be
fixed by a cursory look at an analytics report.
“Look at the bounce rate for your [promotional]
campaigns…and understand which of these
campaigns stink. Or look at the bounce rates
for your top entry pages…. you’ll immediately
know which pages are not even engaging
enough to get your visitors to make one click.”
Fix the obvious, is the message, and we could-
n’t agree more with that. 

bhaskar_sarma@thinkdigit.com
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your Web site), search engines (visits coming
from search engines) and Other (online
campaigns, newsletters, etc). 

Using This Data
Now that the definitions are out of the way, how
do you use that data harvested from your tool
for your advantage? From the data about page
views, visits, pages per visit, bounce rate, aver-
age time on site and percentage new visits over
a period of time, you can get a picture of
whether your site is delivering the goods. For
example, if your site has a total of 20 pages, and
the pages per visit is something 5.6, this means
that less than half of your site gets visited. In
relation to this, you can make use of another
statistic which indicates the number of visits per
page. This combination will show you which
sections of your site aren’t giving you the desired
results. With this information, you can now
decide what corrective steps need to be taken. It
might also mean that you need to tweak the
site’s design to make sure that the areas you
want people to go to are easily accessible. Google
Website Optimizer, a free tool which predicts the
change of user data depending on design
elements is very useful in this scenario. 

This brings us to keywords and traffic
sources. Face it: unless your site is very well
known, most of your visits are going to come
either through search engines or referrals from
other sites. Web analytics tools show which
keywords have generated the maximum
number of visits—this is a very good indicator
of what people expect from your site. Add this
information to the traffic from other sites, and
you have a fair idea of what your visitors come
looking for. Accordingly, you have a number of
strategies for improving the visibility of your
site, starting from SEO and SEM (check out Get
Noticed, Get Clicked, November 2007) as well as
patronising your referral sites. Conversely, if
you have invested considerably in a referral site
and you find that very few visitors have come
through that door, you can terminate the
agreement before you spend too much. You
might have also launched other Internet
publicity campaigns like paid advertising and
email newsletters -traffic source statistics are a
great way to measure the effectiveness of your
campaigns. No matter how insignificant these
numbers are, they help provide an insight into
customer behaviour. 

Tools Of The Trade
Google Analytics, the analytics tool from
Google is one of the most well known, and is

Answer the question
why your Web site
exists, then identify
the two or three 
metrics that are 
critical to goal 
conversion.”

Avinash Kaushik
Google Analytics Evangelist

Some of the many metrics in a typical analytics report
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Nimish Chandiramani

We’ve got a Core 2 Duo rig with an
NVIDIA 8800 Ultra and 4 GB of RAM
for our game reviews, and we’re quite

happy with the situation. Then comes Crysis,
which knocks the wind out of it with everything
set to Very High. Suddenly, our world is plunged
into darkness—we didn’t spend all that time
harassing the Powers That Be for a gaming rig
only to find out that we’ll have to settle for...
ugh... lower settings. Do we go SLI? How do we
explain the dunking of another Rs 30,000 (or
thereabouts) to the Führ... er... boss?

That’s beside the point, actually. While our
professional lives are brightened by the ray of
sunshine that is the corporate budget, most of
us game at home on fairly modest machines—a
mid-range AMD64 (Socket 939 at that), an 8600
GT and 2 GB of RAM. Yes, we are content, and yes,
we still call ourselves gamers. Our secret? Noth-
ing complicated, just the realisation of a few
simple truths...

The Early Adopter’s Caveat
This happens to us too often to laugh about—on
day 1, we go out to our local electronics hub and
blow a good portion of our salaries on an
upgrade, and on day 3, prices plummet and we
feel like complete asses. You don’t realise it, but
we can see you nodding your head.

Now consider the plight of someone who
sprung for an NVIDIA 8800GTX back when it
was Rs 40,000—the newly-released 8800GT is
only slightly behind it in performance, but
costs half that much. If you spend the same
amount today, you can use two 8800GTs in SLI
and elicit a performance that surpasses even
the 8800Ultra! The situation is the same in the
ATI camp.

Our point is this: early adopters adopt early
mostly because they can, not because they need
to—they are fully aware of the fact that prices are
going to fall soon; they just don’t care. With
graphics cards today, jumping the gun comes at
a price, so hang tight and buy a new card only
when there’s nothing you can do to improve
your gaming experience, or till your old card
goes poof.

Until then...

Ugly Is Beautiful
The most obvious—don’t lose heart if you have
to play games at lower settings on your current
PC. A good case in point is Crysis itself—even
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with all the effects turned down, it looks better
than Far Cry, and that’s not bad at all. Turns
out we won’t have to spring for that extra card
after all—and even at home, we’ll get ourselves
some visual joy.

Then there are the times when we just have to
turn on all the special effects. To offset that, the
strategy that’s worked beautifully—more on CRTs
than LCDs—is to turn down the resolution, all
the way down to 640 x 480 if need be (and if the
game supports it, of course). In fact, if you turn
down the resolution to 512 x 384, graphics even
acquire an interlaced effect—reminiscent of
cutscenes in old-school games. 

Recent games won’t let you go below 1024 x
768, unfortunately; but why must we always talk
about the latest games, anyway?

They’re Not Going Away
Just recently, this writer completed Max Payne 1
and 2 on his modest rig—which, incidentally,
runs the game at 1280 x 1024 (probably more, if
it weren’t for the monitor) with all the bells and
whistles—and enjoyed it thoroughly. Today’s
hardware lets yesterday’s games look much better
than they did back then...

If you’re upgrading now and don’t have the
budget for a high-end gaming machine, just
invest in the best your budget gets you and take
a trip back in time. Buy games that wouldn’t
have had a prayer on your older PC and play
them—it’s gameplay that makes a game enjoy-
able, so what was good then is still good now.
The cherry on the cake is that these games are
even cheaper now! 

As for the latest lot, they’ll still be there when
you’re ready for your next upgrade. For less
money. If you wait for hardware prices to fall
before buying, who’s to say you can’t wait for
game prices to drop, too?

And then there are some things that you
shouldn’t even consider buying...

The “Professional” Gamer
One of the biggest ploys that budding gamers
succumb to is the “Made for professional
gamers” tag on products. “Well”, they think, “if
the professionals use it, maybe it’ll help my
game too!”

It won’t—specifically in the gaming mice
department. If you can’t strike fear in the
hearts of your opponents with a run-of-the-
mill mouse, forget about being able to do so
with a 5000-rupee mouse and a 2000-rupee
mousepad (yes, you get those). Sure, gaming
mice are more precise and you can’t beat on-
the-fly sensitivity adjustment, but nothing
makes up for solid skill. The usual victors of
our Quake III sessions are people who have
some of the most awful mice in the office. 

If you must get yourself a gaming mouse,
get a Logitech MX518—it’ll cost you around
Rs 1,300, and it’s a good mouse for general
Windows productivity to boot. As for the
mousepad, pick up one that’s preferably got 
a fabric finish and is a single solid colour—
it’ll cost around Rs 20. To hack up your 
own gaming mousepad, check out our 
June 2007 issue. 

But wait...

Consoul Curry
All this while, we’ve been talking about PC
gaming—but the best way to save money as a
gamer is to shift platforms altogether. The PS2
has been a viable gaming solution for nigh on
ten years, so while we’ve been running to
upgrade our PCs every time a new game comes
out, PS2 owners have been pointing at us 
and laughing. 

From the looks of it, the Xbox 360 and the
PS3 do have the potential to last another ten
years—games haven’t even begun to fully exploit
the hardware—but we wouldn’t be surprised at
a new console in five years, for marketing
reasons if nothing else. Even so, you’ll be paying
only once in these five years, and the cost of a
next-gen (or current-gen, now that they’ve been
around a while) console is less than what you’d
pay for a killer PC (not counting the cost of an
HDTV, though). The games are a bit expensive,
but the wait-for-prices-to-drop approach will
work here too.

Even the PS2 still has plenty of steam, and if
you’re new to the platform, this is the best time
to buy. You can get your hands on it for as little
as Rs 7,000, and titles are finally going below the
Rs 1,000 mark too. You’ll have a huge collection
of legendary games—the God Of War duo, the
Burnout titles, and many more—to keep you busy
for a long time, and new releases are lined up till
July this year at the very least. 

If you’re a first-person shooter (FPS) or real-
time strategy (RTS) fan, though, don’t go the
console way even in a moment of weakness—
such games are best enjoyed with a keyboard
and mouse. 

Cheat Code
If all else fails—if you’ve already spent your life
doing the same things we’re telling you to do
here and can’t take it anymore, get those
books out and brush up on your grammar.
Then apply for a job here at Digit and start
reviewing the latest games as soon as (and
sometimes before) they release—that’s what we
did, anyway.

nimish_chandiramani@thinkdigit.com

Games like Katamari Damacy are still a big argument in favour PS2
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Freedom philosophy. Today, Mane is a free soft-
ware developer, teacher, and activist who
works with Dr Nagarjuna, computer head at
Homi Bhabha Centre for Science Education,
Mumbai. Mane is currently co-developing Orca,
a free screen-reading software for GNU/Linux
meant for the visually-challenged.

Jyotindra Mehta is known amongst his
peers for his proficiency in IBM Mainframe
technology. He currently works with IBM
Global Services India as Advisory Software
Engineer. Born blind, Mehta is India’s first soft-
ware programmer to have been awarded the
Shell Helen Keller Award (in 2004) by the
National Centre for Promotion of Employment
of Disabled Persons.

Raghavan goes on to say—with no mention
of names, though—“A shy group of three people
with limited knowledge of the world are now
working in the challenging field of medical
transcription. It requires perfection—being
very careful with spelling—which they mas-
tered in the face of several challenges.”

There are many other visually-challenged
individuals who have learnt to earn their living
with the help of technology. The dynamism of
their talent has taken them beyond basic data
entry work or writing code to software devel-
opment and even troubleshooting.

Getting Them Up To Speed
Screen readers, text-to-speech software, and
other things which we’ll soon mention, are cru-
cial aids: they enable differently-abled people
to perform various tasks, by helping them
learn how to use technology for education,
their main occupation, and of course, enter-
tainment. They are, in short, intended to make
them independent.

In the last decade and a half, screen readers,
screen magnifiers, text-to-speech software, and
Optical Character Recognition (OCR) software
has evolved to a great degree. These aids, along
with text-to-speech software, audio / MP3
players, audio book readers,
and more have fuelled the
hunger for knowledge in
visually-impaired people.

A number of cyber-cafés,
Government-supported
training centres, and NGOs

Technology now
helps the
visually-
challenged hear
things they can’t
see

Samir Makwana

Today, if you ask a visually-challenged
person conversant with computers about
Braille or Talking Libraries, don’t be sur-

prised if he says “They’re so last decade!” Tech-
nology has broadened their horizons. What
follows is about what it’s like right now...
what’s happening in India, and what people
are doing.

They Aren’t Sitting Idle
Shanti Raghavan, founder and managing
trustee, Enable India (a charitable trust that
helps people with disabilities), avers, “Tech-
nology has proved to be a boon for visually-
challenged people. It’s due to technology that
these individuals are now able to pursue edu-
cation, entertainment, and, most importantly,
employment, to make their lives better and
more meaningful.”

(The term “visually-
challenged” refers to
those who have
entirely lost their sight
as well as those with
very poor vision.)

In 2002-03, Krish-
nakant Mane became
India’s first visually-
challenged IT engi-
neer. Inspired by
friends with engi-

neering back-
grounds, he started

off on GNU /
Linux, and began

promoting the
Free as in

No Holds Barred
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This idea has hit Kerala state. Today, over 80
IT resource centres provide training facilities to
people in rural areas as well as to visually-chal-
lenged people on computers running open
source OSes with the Orca screen reader
installed for the benefit of the latter.

Future Expectations
Like J K Rowling wrote in Harry Potter and the
Order of the Phoenix, “It is not our abilities but our

choices which make us what we are.” Visually-
challenged people are ready to take up the chal-
lenges of life—now with technology at their side.
Many tech evangelists have predicted that the
future of computing is mobile; usage patterns
seem to indicate the truth of this.

Neha Trivedi, Project Officer, XRCVC, says,
“In the near future, a multifunction portable
gadget / device that can do nearly most func-
tions will increase the flexibility of performing
tasks like text-reading, scanning, and the use
of speech technology almost anywhere. This
could make the visually-challenged more inde-
pendent.”

Various aids, including software, audio
players, and multifunctional gadgets do exist
for the visually-challenged. But they’re expen-
sive for the most part, and quite unaffordable
for most of those who need them.

You can help. Donate old working PCs to IT
resource centres run by your state government,
or trusts for the visually challenged, or at NGOs
like Enable India and many more (take a look at
the Touched by Tech section in our July 2007
issue). At the Talking Libraries and resource cen-
tres—like XRCVC in Mumbai—you can volunteer
to scan printed material for conversion to audio-
books. A lot of people will be happy. 

samir_makwana@thinkdigit.com

Software and hardware aids widely used
by various NGOs and Resource Centres

SCREEN READERS 
JAWS: Job Access With Speech is a
proprietary screen reading software that
converts text to speech and reads it out
at an adjustable place, with options for
voice (male/female), tone, languages,
and speech engines. 
www.freedomscientific.com/fs_products/so
ftware_jaws.asp

ORCA: An open source application for the
visually challenged with many features,
including a speech synthesiser; it
supports Braille and also a text magnifier.
http://live.gnome.org/Orca

Emacspeak: An open source text-to-
speech interface meant for visually-
challenged users as an enabler to
browse the Web and use various
programs without assistance.
http://emacspeak.sourceforge.net

SAFA (Screen Access For All): A
cheaper alternative to the JAWS screen
reader, which uses an Indian-sounding
synthesiser for the speech engine.
http://safa.sourceforge.net

MOBILE PHONES
Mobilespeak: A screen reader
application with Braille support for

Symbian Series 60 Edition cell phones.
www.codefactory.es/en/products.asp?
id=24

TALKS: A screen reader that supports 20
languages on Symbian Series 60 phones.
www.nuance.com/talks

Call History: Software that allows
visually-impaired users to hear a
description of dialled, missed, and
received calls, along with voice-
prompt-based navigation.
www.tinfomobile.com/
Applications.html 

SCREEN / TEXT MAGNIFIERS
MAGic: Screen magnification software
with hotkeys different from those in
Windows.
www.freedomscientific.com/fs_products/so
ftware_magic.asp

ZoomText: A text magnifier and
reading software for low-vision users.
www.aisquared.com/index.cfm

TYPING
Talking Typing Teacher: Meant for
novices as well as advanced users, this
is a typing tutor with speech used for
every function
www.braillebookstore.com/talking-typing-
teacher.htm
Braille: Duxbury’s Braille Translator

Software that provides translation,
formatting, and word-processing
facilities to automate the process of
working from regular text to Braille
and vice-versa.
www.duxburysystems.com/dbt.asp

WinBraille: A Braille editor meant for
Index Braille embossers.
www.indexbrailleaccessibility.com/downlo
ads/winbraille.htm

Shree-Lipi Braille (Indian-language
Braille translation software):
Has support for Indian languages
including Hindi, Marathi, Sanskrit,
Gujarati, and others, with the main
function of enabling translation of text
to Braille. The file created can be used
with a Braille embosser to print out
content in Braille.
www.modular-infotech.com/html/
braille.html

PLAYBACK SOFTWARE
AMIS: (Adaptive Multimedia
Information System) for the DAISY
Book Reader
An open source book-reading software
for talking books saved in the DAISY
format, with support for South Asian
languages. 

This list represents software widely
used in India; it is not exhaustive.

Tools Currently Used In India

Mane himself is quite comfortable on his laptop

imparting computer courses to visually-chal-
lenged people are functional across India.
Resource centres at colleges, like Xavier’s
Resource Centre for the Visually Challenged
(XRCVC) at Mumbai, managed by Dr Sam Tara-
porewala, imparts computer training to the visu-
ally impaired using various technological aids
and state-of-the-art computers.

“Along with screen readers, screen magni-
fiers, and book players, we use other hardware-
based aids like Mountbatten MB Pro (a talking
/ typing Brailler), SARA (Scanning and Reading
Appliance), Prisma (a CCTV-based device for
low-vision users) and Zoom Ex (an instant
photo scanner),” says Prashant Naik, Training
and Development Officer, XRCVC. The Centre
also serves as a test-bench for upcoming Web
sites to check for accessibility features and soft-
ware meant to help the visually-challenged
cope with technology.

At these junctions, computer training
courses are offered to make the visually-chal-
lenged conversant with basic packages like
Microsoft Office and with the Internet. “Besides
computer-centric training, we at Enable India
provide training programmes that involve the
development of communication skills in Eng-
lish, analytical skills, and error-proofing tech-
niques to help the visually-challenged perform
well even in difficult situations—that is, those
where proper eyesight would be considered a
must,” says Raghavan.

We’re now seeing several instances where the
visually-challenged are employed for even chal-
lenging tasks. The IT industry has expressed
tremendous interest in employing such individ-
uals through NGOs like Enable India, as part of
their social responsibility. Enable India provides,
for the visually-challenged, workplace solutions
involving job identification, system configura-
tion, and troubleshooting. 

The Next Step
Three major areas where development is
taking place on a major scale in India in terms
of software are:

Indian-sounding text-to-speech synthesiser
engines for screen readers,
Tactile imaging embossers (embossers that
convert images to embossed dots), and
Screen readers for different browsers.
The Internet being the ocean of knowledge

that it is, a majority of the developments in
existing and upcoming software is taking place
for better Web accessibility.

Loads of screen readers, as well as tools like
Opera’s voice-commands feature are available,
but why aren’t Indian citizens being made aware
of them? Well, there is the accent problem with
us Indians, and not every Web page is designed
with a screen reader in mind.

Web pages scripted with different lan-
guages—for instance, AJAX carrying dynamic
JavaScript—make it difficult for screen reader
software like JAWS to cope. To combat the
browser issue, Mane, with other global devel-
opers, is working on the Accessibility functions
in the Firefox browser. He believes that Web

pages should be formatted using W3C-certified
scripting languages.

The cheaper and affordable Indian-version
screen reader called SAFA (Screen Access For
All) is under development, led by Dipendra
Manocha, director for IT and Services at the
National Association for the Blind (NAB).
Manocha also works as assistant project man-
ager for DAISY for All-India, a project of the
DAISY consortium; DAISY (Digital Accessible
Information System) is an open standard used
for developing tools such as digital 
talking books.

At XRCVC, e-Signs (banking software for the
visually-challenged) is being tested and devel-
oped by CMC Ltd; it was conceptualised by the
Centre. This software will help banks with
thumb-print recognition reach an expected accu-
racy closer to 100 per cent for thumb-prints by
the visually-challenged. Besides, the Centre
recently tested an open source screen reader
called AccesibilityWorks, developed by IBM,
which works with Firefox on Linux.

On the open source front, at LinuxAsia 2007,
Klaus Knopper with his wife Adriane (who is visu-

ally-impaired) announced the development of
Adriane Knoppix, a free operating system
(GNU/Linux) specially for the visually-challenged.

An IT student of Agra College recently devel-
oped E-Netra, a device using which the visually-
challenged will hear the text they can’t read; it’s
a gadget with a zoom lens and unique software.

“Go Open Source”
Mane reminds us that almost 80 per cent of Web
servers run on GNU/Linux-based operating sys-
tems. IT giants and many big multinationals now
use GNU/Linux-based OSes for their servers.

Now, though GNU/Linux-based OSes and pro-
grams are free, why is the common man still
unaware of their benefits? Mane laments, “Free-
of-cost programs are very costly, as the willing-
ness to share is rare. If the government and
people gain some awareness soon, they’ll realise
the benefits of viable and affordable open source
systems over the costly proprietary ones that lack
Indian speech synthesis and language support.”

The IT industry
has expressed
the interest in
employing
visually
challenged
individuals
through NGOs
like Enable India

Krishnakant Mane talks to software developers and students, helping them
understand what the visually challenged need from software
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W
hat, I must ask myself, do I expect in an NFS game? In

the time following Most Wanted, my standards have

risen considerably—I want the adrenaline rush of

driving really, really fast, the safety of just-realistic-

enough physics, and the sadistic joy of watching police cars crash.

What I don’t expect, however, is to be confounded. NFS: ProStreet

is easily the most befuddling title of the lot—it leaves the territory

of arcade racing to become a racing simulator, but not quite. I may

have driven a Volkswagen Golf for only an hour in my life, but it

didn’t feel like the truck I’m made to drive in this game. Strike one.

ProStreet also goes back to good old track-based racing—

while this would be good if the tracks were as wicked and

wonderful as the older games in the series, they’re really drab,

and if you fell asleep driving them in the lower-end cars, we’d

forgive you. There isn’t even much to gawk at outside the

tracks—all races take place in the middle of nowhere. Car

damage is back too, so you’ll have to drive (yuck) carefully.

Strike two. 

On the plus side, the game looks brilliant—especially the

cars—and the presentation is very stylish. The short races

ensure that the five-minute breaks you take from work actually

last five minutes, and if you turn on all the driver assists, you

can get back some of that old NFS feel. Car customisation is fun

too, and this time, even physical changes can affect your race

aerodynamics, and hence performance.

Alone, ProStreet is a decent game—perhaps a seven or eight

on ten, hence no strike three—but when you look at what’s come

out of EA’s garage before, you’ll be left cold, if not

actually ticked off.
nimish_chandiramani@thinkdigit.com
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XFX GeForce 8800 Ultra,
Intel Core 2 Duo E6600,

4 GB DDR2 RAM, Windows Vista
Ultimate x64

GAMING PC

Rating: 5/10
(7/10 if you’re new to the

series)
Developer: EA Black Box

Publisher: Electronic Arts
Distributor: Excel Interactive

Contact: customercare
@excelinteractive.co.in
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T
eam Fortress has returned riding on
the Source engine for its second
coming. It’s a strictly multiplayer game
where you can choose to play as one
of 9 classes. Each class has its own

strong and weak point. To give you an example
for kind of chaos that goes on in game—the
Heavy who is like the tank can be depended on
to take the battering while he is healed by a
Medic following him. Your Scouts and Soldiers
can sneak and take out the opponents. There
are flamethrowers and grenadiers that can
help fend off incoming attacks. There are spies
that can turn invisible and camouflage them-
selves into players of the opposite team.
Snipers can be found picking out unsuspecting
prey—weak medics and retreating heavy’s
from high sniping points.

Everything in the game has a cartoon
theme to it. This means the graphics are very
colourful and the maps and player models are
one brilliant visual treat—much like you’d
expect to see in Pixar movies. Each player type
is a work of art—each with their own identity
that comes out through their image and their
voices. If there’s something wrong with the
game then, it’s that there are only 6 maps but
more will be coming out pretty soon.

The sound acting for each of the char-
acters is just impressive and there are so
many of the voice commands for the most
joyful and painful of situations you may get
into. There are different kinds of emotions
and gestures that are shown by the models,
depending on the situation.

The performance doesn’t suffer a lot
either in Team Fortress—if you could run Half
Life 2 on your rig, you can run this pretty
nicely as well. Do remember that you’ll need
a better processor as you’re going to see any-
where upto 32 players running about the
place with all kinds of projectiles and parti-
cles flying everywhere—it is a chaotic game.

There are some 3 types of gameplay
which are linked to the type of map—capture
the flag, where you run straight into the
team’s base and grab their ‘intelligence’ and
run back to your own. The Control point cap-
turing map and territory capturing map are
similar, and involve capturing important
points in the map. The gameplay in all the
maps is fresh and it will make you laugh your
guts out. There’s voice chat in-game, so you
can plan out your rushes and ambush strate-
gies with your teammates.

What is the scenario for us here in
India? Well, there’s a buzzing Indian Team
Fortress 2 community on Steam that’s
growing stronger by the day and a few
Indian servers as well. More importantly
there are many servers in the east—Singa-
pore, Malaysia, Taiwan, etc. Ping times
range between 100 and 150 ms to servers in

Asia, and even in Europe. There’s the peace
of mind knowing that Valve has brilliant
Net-code in almost all their online games,
so don’t worry about not having single digit
pings to servers.

There’s no doubt that Team Fortress 2
has to be one of the most innovative and
most unique multiplayer games to come
along in a long time. You can buy Team
Fortress 2 as a standalone game through
Steam or you get it as a part of the Orange
Box, which is the cheaper option. The price
for the Orange Box is just Rs 999 for India—
a lot cheaper than what you’d pay online
(Rs. 2,100 or $49.95). Let’s put it this way,
for a maximum price of Rs. 999, you get Half
Life 2, Episode 1 and 2, Portal and Team
Fortress 2, which by itself is worth the entire
Rs. 999. Be warned though—many people
have had problems with discs in the Orange
Box here in India—they don’t work, so be
prepared to use backup plan of down-
loading the games through Steam. Team
Fortress alone will take a day on a 256kbps
connection but its well worth it.

We’re giving Team Fortress 2 a 9 out of
10 rating, and here’s why: brilliant addictive
gameplay, great maps (and more to come),
great netcode, good numbers of servers to
play on, cheap, and it make you makes you
wet your pants and your tummy explode
when you’re done laughing…isn’t that
reason enough?

rossi_fernandes@thinkdigit.com

Cartoon Capers
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Rating: 9/10
Developer: Valve Corporation
Publisher: Valve Corporation
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Digital Leisure l Game On

Mobile Games
Prince Of Persia

Classic

Confession: I’ve never played
through the original Prince of
Persia (PoP), and given the games

available today, it’s hardly likely that
I’ll ever play it on my PC again. This is,
however, one for the phone. The name
is self-explanatory: good old PoP,
brought back to life in your pocket. The
graphics have been updated to look
better, but the game controls exactly
as you’d remember it (or not, depend-
ing on your age). Your princess has
been captured by the evil wizard
Jaffar, who has given her an hour to
either marry him or die. You must res-
cue the princess within this hour, or deal with
the guilt of her blood on your clumsy hands.
Theoretically, this means that the game is only
an hour long, but it’s quite unlikely you’ll be fin-
ishing it in that time. The prisons are
labyrinthine, and if you don’t fall into a chasm
eventually, you’ll walk into spikes. Such is the
prince’s life. Whether you yearn for nostalgia or
you want to see what the big deal was with PoP,
this is one game worthy of your phone.

Super Cricket:
One Day Wonders

What Indian game maker can resist
making cricket games? Mauj’s Super
Cricket: One Day Wonders makes

for good company on long trips,
and is surprisingly fun even if
you’re not a cricket fan.

The controls are simple and
are workable with one hand:
while batting, use different num-
ber keys to play different strokes,
and play a little mini-game to
place the ball while bowling. You
can play a quick match, an ODI or
a knockout, depending on how
much time you have on your
hands. You get to choose your
country, but not your opponent.
The latter would have been nice,
even though it’s inconsequen-
tial—the only difference between
teams is the colour of their
clothes. If you find yourself fumbling too
much, you can sharpen you batting and / or
bowling skills in the nets.

Good stuff, this, and gets our seal of
approval. Just turn the music off—it’s awful.

8
10

Brain Challenge 2

Ever have one of those days when you’re
feeling unnaturally dumb? When even the
most mundane tasks seem like mountains

to your dulled brain? Now you can measure
that dullness!

Brain Challenge 2 puts you
through a bunch of challenges to
see how sharp you are today—all
mini-games that last a few seconds,
at the end of which you get statis-
tics like how much of your brain
you’re using, how much stress
you’re under and so on (we’re suf-
fering at 90 per cent stress right
now, incidentally). It’s perfect for
when you want to take short breaks
from work, and since your first
score is usually shameful, it’ll be a
long while before you decide to stop
competing with yourself. The result
is (so the developers claim) that you end up
stimulating your brain, which will lead to your
overall well-being, or something to that effect.

Our verdict: BC2 is easily one of the best
mobile games we’ve played so far—the only
thing that bothers us is that it gets hard if your
screen is too small.

9
10

8
10

Against All Odds

In Against All Odds, you play Malaika
Rudeski—a female Indiana Jones—whose
fascination for all things Egyptian leads

her right into a pyramid with all sorts of
cool ancient gadgetry. Obviously,
she trips on something she should-
n’t have, and unleashes the
Pyramid’s Curse.

This is your good old side-scroll-
ing platform game, and isn’t far
from what you’d expect—walk
around the pyramid, avoid obstacles
and fight scorpions, mummies and
other miscellaneous nasties. There
are some parts that can get irritat-
ing, though. Ms. Rudeski is quite del-
icate, and dies from the shortest
fall—which happens a lot, because
as soon as you ascend a platform,
there’s usually a mummy waiting
there to push her off.

Against All Odds isn’t an outstanding
game, but it’s still better than sitting and
doing nothing at all.

6
10

Site: www.mauj.com
Price: Free

(plus service
message costs)

Site: www.Mauj.com
Price: Free

(plus service 
message costs)

Site: www.gameloft.com
Price: $4 (Rs 160)

Site: www.gameloft.com
Price: $4 (Rs 160)
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USB 3.0 is beginning to
appear. Compared to the 480

Mbps of the 2.0 iteration, what is
the speed of the newer version?
(a) 960 Mbps (b) 1100 Mbps
(c) 4.7 Gbps  (d) 9.4 Gbps

Think about .af (Afghanistan)
domains. Which is true?

(a) You can register them, but there
aren’t any .af sites!
(b) We made this up! There’s no
Internet in Afghanistan! 
(c) You’ll be able to register for a .af
not before 2020!
(d) The names are there, but even
internet.af is available!

The longest legal domain
names can be…

(a) 127 characters, starting with a
letter or numeral 
(b) 63 characters, starting with a
letter or numeral
(c) 64 characters, starting with a
letter, numeral, hyphen, or
underscore 
(d) Any number of characters as
long as sets of 64 characters are
separated by a hyphen

Which is not true about
“YouPod” or “youPod”?

(a) It’s a social Web site (a .com)
(b) It is Mac-related software
(c) It’s the nick of a 23-year-old
single male in Wisconsin
(d) It’s a YouTube video that
features an iPod

Which company recently
shipped the “world’s most

capacious laptop hard drive,” and
what is the capacity?
(a) Seagate, 1 TB
(b) Western Digital, 750 GB
(c) Maxtor, 1 TB  (d) Hitachi, 500 GB

Which of the following is not
in the list of first ten

registered dot com domain
names?
(a) Think.com   
(b) Xerox.com
(c) HP.com   
(d) IBM.com

What did people in China
Google most in 2007?

(a)”QQ,”—according to Reuters, an
“instant message service and a
brand of car”
(b) “speak english” 
(c) “USA visa”
(d) “sex”

8

7

6

5

4

3

2

ACROSS
7. Using a web browser as the desktop interface in a client
machine (6)
8. To quit a programme (4)
9. Advanced Mobile Phone Service(abbr) (4)
10. Signaling code of dots and dashes (5)
11. GNU Network Object Model Environment
(abbr) (5)
13. Location of a web site (7)
16. Contributor to an online journal (7)
17. ------or free ware (5)
20. Delete (5)
21.----art—set of scanned images used for
illustrations (4)
22. Search-----—online programme to help
users find information on the Internet (6)
23. Display area of a computer monitor (6)

DOWN
1. An input/output device that allows you to
send commands to a computer (8)
2. Convergent Technologies Operating
System(abbr) (4)
3. Unsolicited commercial e-mails (5)
4. To make a new version of a product (7)
5. Conduct a systematic investigation on the
internet (8)
6. Round, read-only optical storage 
medium (4)
12.------effect-power to attract iron or steel
objects (8)
14.’S’ in ISP (7)

15. Discounts offered on shopping sites (7)
18. Buttons on an input device attached to the monitor (4)
19. Type and style of text letters and characters seen
in documents (4)
21. An essential function (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Think, Think!
What do Isaac Asimov’s
Three Laws of Robotics

talk about?
(a) The rate of
increase of robots’
computational powers
(b) What factors will
influence when they
will overtake us
(c) What they should
and shouldn’t do
(d) What they might or might 
not do

1

Here’s an interesting
list. The United

States, Canada, France,
Finland, Denmark, Iceland,
Norway, Sweden, The
Netherlands, and Mexico were
the first ten countries to have
Internet connectivity.

Did You
Know?

Answers

1.C
2.C
3.D
4.B

5.D
6.D
7.A
8.D

Crossword by Nitta Jaggi

January’s Winner
Yashodhara K
Mulki, Karnataka

Send in your entries to
TQ@thinkdigit.com on
or by 20th of this
month. One lucky
participant 
will win 
Photoshop CS3 Bible
By Fuller & Fuller
Published by

Win!

January’s Solution
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JOB GONE

Blog roll

The annual Consumer
Electronics Show (CES)
at Las Vegas is where

thousands of people from
all over the world gather
together to gawk at new
consumer electronics
products. We know that
part. Products like huge 150-
inch LCDs, sleek laptops,
booming music players—
about 20,000 products in
all, on the brink of flooding
the world’s stores in the
coming months. Naturally,
the people who visit this
Mecca of electronics are
pumped up, salivating over
the new electronics that are
likely to replace the same
products we bought a few
months ago. All right, so we
know that part too. 

CES being what it is,
companies try very hard to
sell their products. They go
to great lengths to tom-tom
the fabulous features, give
painstaking demonstrations
and generally try to make
everyone—especially the
media—believe that their
TV, MP3 player, or computer

is the best thing created
this side of the wheel. And
those slick salesmen do
manage to achieve what
they started out to do—in
most cases. TV displays play
an important role in this
shock-and-awe campaign,
and if in the middle of a
fabulous presentation your
display suddenly conks out,
you would be mighty ticked.
And if that happens not
once, but multiple times
without anything
apparently wrong with the
hardware, you would be
justified in thinking a
poltergeist was haunting
your system.

You’d never think that a
TV-B-Gone remote is behind
these blackouts, though—
nobody could be that
immature. TV-B-Gones,
incidentally, are used to
shut off annoying TV
screens when they’re
disturbing your meditations
on the great mysteries of
life. Okay, we made that up,
but everyone agrees that
idiot boxes can get very
annoying sometimes.
However, such a remote was
never intended to black out
screens in the middle of a
product demonstration—but

no one told the bloggers at
Gizmodo that. They went
around merrily clicking
their remotes and shutting
down whole walls of
displays, leaving the people
in charge with a what-the-
heck-happened expression
on their faces. The cheeky
bloggers also disrupted a
Motorola presentation
twice, leaving the presenter
with an undoubtedly bad
taste in the mouth. This was
then posted on
Gizmodo.com. And all hell
broke loose.

Ironically, most of the
brickbats came from other
bloggers, not the corporate
types. The blogging
community has been
fighting hard for passes that
are usually given out to
members of the fourth
estate, and it’s only recently
that they have managed to
get accreditation as “real”
journalists. They fear that
such antics from members
of their tribe would
endanger their reputation,
and they would be barred
from all future events. That,
or face strip searches. The
Gizmodo staffer who had his
finger on the remote has
already been banned for life
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FirstEscape

We’ve been talking
a lot about file
sharing in these

pages over the months, and
regular readers following
the script would know that
RIAA, the recording
industry body in US has
been doggedly pursuing
individuals who have
uploaded, or downloaded
pirated music. They’ve
slapped court cases, won
hefty fines and have
generally gone about
treating music fans like
criminals—guilty until
proven innocent. Readers
will also recall that while
RIAA swears it’s doing all
this dirty work for the
benefit of musicians and
artists, the supposedly
affected parties have said
that they are not happy
with RIAA’s tactics and
prefer that music
companies change their
business model and adapt
to the times.

Recently, the RIAA got
another bloody nose in its
ongoing slugfest with the
Common Man, when two of
its cases were shot down by

the courts. Both these are
unrelated, but they serve to
underscore the
underhanded and often
desperate tactics in this
campaign. In the first case
defendant Tanya Andersen,
a disabled single mother
had to face mafia-style
tactics like invasion of
privacy and attempts to
clandestinely contact her
eight-year-old daughter to
dig up files-haring
skeletons. After a long and
two year wait, the
concerned courts have
dismissed the allegations of
RIAA that Andersen was
pirating gangsta rap on the
P2P site KaZaA, and
awarded her the hefty
lawyer’s dues. Additionally,
it allowed a class action
lawsuit filed by her to go
through, which essentially
means that anyone who
was accused by RIAA of file-
sharing can join the
lawsuit and claim
compensation.

Which we recommend
the Howells to do. They
have been accused of
sharing music, again over

KaZaA. However, they have
not been accused of
uploading that particular
file. In case you want to
know how anyone could
share something which was
not uploaded, let us clear
things up. RIAA—in its
infinite wisdom—has
decreed that even if a song
is in a shared folder
named, say, “For KaZaA”,
from where it could be
theoretically shared this
would consist of
committing the heinous
crime of music piracy. If
you intend to illegally
distribute music, you
would be screwed: this is
RIAA’s view of the perfect
world. The Electronic
Frontier Foundation (EFF)—
the privacy watchdog in
the cyber world—has
thrown its hat in the ring
and has basically told the
judge that RIAA is spouting
bovine excreta. We hope
the judge agrees, and the
world remains imperfect.
And while we are at it, we
do hope the RIAA gets
kicked where it hurts for
their copyright Nazism.

His is one of
those names
you can’t
afford not to
be familiar
with: a multi-
faceted
“computer
genius,” Briton Donald
Davies invented Packet
Switching (we’re hoping
you aren’t wondering what
that is). In 1965, while at
the UK’s National Physical
Laboratory, he saw (it
wasn’t obvious to everyone
at the time) that
computers would be more
useful if they could talk to
each other. He went on to
develop a system that
allowed machines to send
“packets” of information
backward and forward
over public
telecommunications
networks. Small chunks
were sent separately so as
to minimise the risk of
congestion. The ARPA in
the US liked it so much
that they straightaway
incorporated it into the
ARPANET—and Packet
Switching remains the
basis of the Internet.

After graduating from
Imperial College London,
Davies joined a small team
led by Alan Turing (again,
we’re hoping you aren’t
wondering who that is!),
which was developing
computers. The group’s
work led to the Pilot ACE
computer; it was one of
the first few electronic
stored-program digital
computers in the world.
Davies had done much of
the detailed design and
development of the
machine, as well as that of
its full-fledged successor.

Davies was one of the
lucky few pioneers who
saw his work come into full
fruition: he died in 2000
when the Internet was up
and running, so to speak.

No Winner! 
Better luck next time!

People Who
Changed

Computing

Know Thy Phone
Do you need advice in understanding your phone, the way
you do when selecting a wine. If you are in Japan, the
answer is yes. Japanese handsets are getting so complicated
that they are considering licenses for experts who will walk
customers through their handset purchase. Phew! 

MUSIC MANIA

Sharing Blues

Talk!

My Desktop

Whatever 
Happened To…

“D
isusenet,” it might be
better called today.
It’s more probable

that you haven’t, but you might
just have heard about Usenet,
and thought it was an old-style
bulletin board system (BBS) or
possibly a Web site where
people posted things on
various topics. Actually, it’s not
a BBS (though it resembles
one); it is not an organisation,
nor a public utility, nor an
academic network, nor is it a
software. According to one
Web site, Usenet is “the set of
people who exchange articles
tagged with one or more
universally-recognised labels,
called ‘newsgroups.’”

For more than 20 years,
Usenet was considered the
best way to read and post
messages over the Internet.
The network grew into
thousands of discussion
groups; topics ranged from
Olive Ridley turtle
conservation to scuba diving in
the Thames.

So what’s happened to
Usenet? One is blogs: they’re
more user-friendly, and
prettier. Second, the majority
of Usenet newsgroups are now
populated by un-read-worthy
content, off-topic stuff, and
spam. In 2005, AOL stopped
access to Usenet.

Usenet is very old-style. A
certain site about Usenet
sternly tells you:
“Furthermore, the people who
run the news systems are
called news administrators,
not sysops. If you want to be
understood, be accurate.”
Today, no-one has the time for
(or can stand) this kind of
uppity, censorious attitude.

Jailbook
If you are displeased about something it might not be a
good idea to be frank about it, especially on Facebook.
Four Lebanese university students found it out the hard
way when they had to spend a week in the cooler for
ridiculing the singing talents of a young lady. 

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

3D Animation and
Filmmaking using 
Game Engines
by Paul Marino

Published by

Usenet

Don Davies

n RIAA Website wiped clean by hackers  n Microsoft says ODF can be supported, negating the case for its own OOXML format n Tech support call answered by Microsoft after 10 years n A federal agency in US without Net connection since 2001 due to bungled lawsuits

My t-shirt just hung!

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture with a tech angle to it.
The picture should have been shot by you, and should not have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal address, oonn oorr bbeeffoorree tthhee 2200tthh

ooff tthhiiss mmoonntthh to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Participate and 
win next month:

The Essential Guide to 
User Interface Design

by Wilbert O. Galitz

Published by

Last month’s winner:
Vaibhav Jayant Deshpande
Navi Mumbai
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becomes outdated. Maybe
there should be a special
school for these judges.
That would make such
bloopers redundant. 

WOOF

Dog Day

How do you know what
your pug is thinking
of when it is barking

madly at you? Some
ingenious gadget maker
from Japan had made a
similar device for cats, and
we had predicted that
similar things ought to be
out for man’s best friend.
We knew we were good, but
we didn’t know we were this
good. We also didn’t realise
that Digit had a readership
in Hungary.

Okay, about that
Hungarian readership
statistics part—we made it
up. But what we didn’t
make up is the human
understanding dog part.
Scientists at Budapest’s ELTE
University have designed
software that figures out
the emotional response of
dogs to different situations.
Fourteen canine volunteers
were exposed to different

situations guaranteed to
pique their interest—getting
a treat, playing with a ball,
meeting a stranger, fighting
with other dogs—situations
that usually make dogs bark
loud enough to wake the
dead. In the present case,
the dogs barked loud
enough, and with sufficient
emotion to make the code
in the software perform
function calls, execute
loops, and check boundary
conditions; basically go

through the motions which
produce results.

This dog-deciphering
software had a much
better strike rate than
human ears, as it could
understand the cause of
barks, yaps, howls and
growls more accurately
than humans could. The
inventors acknowledge
that they could do better,
and the software is no
where near perfect. A
possible use of such

software is in human-dog
interaction, though what
could be the possible use
of understanding whether
the dog is ecstatic or
simply happy escapes us.
Maybe it would promote
better understanding
between Homo sapiens and
Canis lupus familiaris—that
is always laudable. Maybe
it would enable an
invention that would make
dogs understand! Now
that’d be a gizmo to buy.

iGo
We never really expected it to happen.

Ram—our innocent, spaced out,
blissfully inebriated Ram—has quit smoking.
We don’t know what to make of this. Before,
if we saw no Ram at his desk, we’d naturally
assume he’s in the smoking bay. Now, when
we see no Ram at desk, we panic. 

Not that it matters any more, though.
You see, Ram has discovered that there’s a
Real World outside Digit (well, so they tell
us) and by the time you read this, he’ll
have set out to see what’s really out there.
Maybe he’ll meet a fire-breathing dragon,
and maybe it’ll light him a cigarette he
won’t smoke. We don’t know. We will miss
him, though, despite all the practise we’ve
got from his frequent disappearances.

In other news, we had
ourselves a late-night visit

from someone rather special—or rather,
someone attached to something rather
special—the iPhone. Picture a room full
women around a baby—pinching,
prodding, saying things like, “Aww, cho
chweeeet!”—only replace the women with
untidy male geeks, and the baby with the
iPhone, and change the words to
something more manly like, “The Force is
strong in this one”. That’s what it was like.

Zivalal’s bike got itself towed the other
day, and this has made him rather jumpy—
“Main Vashi nahin jayega!” (I won’t go to
Vashi!). You know how the office grapevine
is—the story was twisted, and as of this
writing, the women are worried he’s some
sort of sex offender (he’s not).

Ah, well. Another month,
another scandal...

n French researchers working on AI software that can declare fatwas n McAfee labels popular sites like ESPN and Friendster as risky

Steve Bralovich
Save Windows XP Petition
http://pdatoday.blogspot.com/2008/01/save-windows-
xp-petition.html (http://tinyurl.com/35rk8k)
Microsoft would like to end nearly all sales of Windows
XP on June 30th of this year, in spite of hesitance by
many businesses and individuals about moving to Vista.
Such a pricey, time-consuming shift with questionable
benefits should not be forced on Windows users, so
InfoWorld has decided to rally XP users to demand that
XP be kept available.

With 27 years of computer and tech experience, I
never make a change of operating systems until I buy a
new laptop or device. This assures me of the widest 3rd
party software support and zero compatibility issues.
Unless there’s a compelling MUST HAVE reason, I stay
away. This policy has served me well and I recommend
that others do the same.

Jme Solivas
Law and ICT
http://lawandict.blogspot.com/2008/01/xp-vs-vista-
forcibly-replacing-old-with.html
(http://tinyurl.com/2f8rgf)
…Personally, I’d choose Old School XP over New Age
Vista any day. Vista is just too darn slow, complicated,
and bug-ridden. For me, it boasts of alleged value-

added features, but which I find are not really user
friendly. Simply, there are still a lot of bugs to be fixed.
I’m all for change, but the change has got to be for the
better...

Mary Jo Foley
ZDNet Blogs
http://blogs.zdnet.com/microsoft/?p=1109&tag=nl.e6
22 (http://tinyurl.com/2uwads)
…There are a couple of problems here. First, Windows
XP is not being ‘discontinued’ on June 30. Instead, as
of that date—unless the software maker issues
another reprieve like it did in September 2007—
Microsoft will no longer make XP available to OEMs
for preloading and/or via retail sales.

Microsoft isn’t pulling the plug on XP support this
year. Mainstream (free) support for XP from Microsoft
ends in April 2009. Extended support (free for
security fixes and paid for other help) ends in 2014.

Infoworld is advocating for Microsoft to continue
to offer XP indefinitely. Fat chance. Why would
Microsoft give customers more incentives not to
upgrade to Vista—beyond the ones it has
inadvertently provided by delivering a first-
generation product that had driver and application
compatibility issues; performance problems; and
reliability glitches?

Microsoft plans to
discontinue sales of
Windows XP from
June 30, 2007 and
there is already an
online petition
against this move. We
track the blogosphere
to follow the
reactions.

WikiTrash!
There’s actually a Wikipedia
page—http://en.wikipedia.org/
wiki/Wikipedia:Unusual_article
s—that lists out weird articles
with links. Some are so weird,
you’d wonder why Wikipedia
doesn’t edit them out; you
could (and perhaps should)
spend a lazy Sunday
afternoon at this page,
clicking the links.

So well, to convince you
about that Sunday
afternoon, here’s a sampler
(article name followed by
description).

PPiigg WWaarr:: A war between
the United States and the
British Empire that almost
erupted over one dead pig.

SSiisstteerrss ooff PPeerrppeettuuaall
IInndduullggeennccee:: An organization of

mostly gay men who dress as
nuns, often on rollerskates.

GGuuiillttyy nnoott pprroovveenn:: A
controversial Scots law
verdict for those neither
guilty nor innocent.

VVrriill:: A belief that aliens
controlled Nazi Germany and
helped Hitler and others to
escape to the South Pole when
the war was lost.

The Significance Of Six
We swear on our paychecks
the following was on a real
MIT Web page a little while
ago. The author now has it up
on a Geocities page
(www.geocities.com/tagonist/
britneyanalysis/index.html),
after complaints that the
page was too frivolous for
MIT, no doubt. Well, it’s about

the lyrics in Britney Spears’
songs, with commentary.
Here’s about the first stanza
of Oops:
Yeah yeah yeah yeah yeah yeah
Yeah yeah yeah yeah yeah yeah
“Critical Analysis”: “The 12
‘yeah’s set an affirmative tone
for the rest of the song, which,
as we shall see, actually sets up
the pivotal irony, which is that
the message of the song is
actually one of negation and
rejection. This ironic structure
parallels the theme of the song
in that its initial tone of
acceptance and joy are actually
false pretences, which will later
be revealed as a miscomm-
unication. The significance of
the 12 is unclear; the 12
months, disciples, and signs of
the zodiac are some theories.”

from participating in future
CES events, and it’s likely
that when it comes to
handing out press passes,
organisers wouldn’t want to
touch Gizmodo with a barge
pole. Talk about shooting
yourself in the foot. 

LEGAL SPAM

Blind Justice

They say the law is an
ass. Well, we do,
anyway. While you

normally don’t expect
courts to understand the
technicalities of all the cases
that come for decision, they
are expected to follow some
common sense while
delivering the judgements.
Or is it that common sense
as defined by the law and
common sense which is
understood by us folks are
two different things? 

David Ritz was an anti-
spam researcher who had
suspicions that Sierra
Corporate Designs, a Web
hosting company was
hosting spammers, or was
actually involved in
spamming. So what he did
was routine: check the origin
of the spam and attempt to
trace it back. Several

commands were used for
this tracing—all ordinary
tools that your average
system administrator would
use in such a scenario.
Among them were Unix
commands like “host -l”
which causes the execution
of zone transfer. In plain
English, this means
accessing information that is
stored on a DNS server for
public viewing. When Sierra
found out that Ritz was
accessing this information
which could be used against
it, they filed a court case to
prohibit Ritz to access this
(publicly available!)
information.  And surprise,
surprise, it won.

Most of the case
documents have been sealed
under court orders, but
from what is available on
the Net, it seems that the
unfortunate Ritz was
convicted and fined
$60,000 (Rs 24,00,000),
because he performed the
online analogy of looking
up information available in
a public document and
using that information to
nail a crime. Anyone
would agree that this
cannot be considered
unauthorized access.
Anyone with sense,
anyway. What’s giving

security professionals the
heebeejeebies, is that the
judge in North Dakota
seems to view at using
perfectly ordinary
commands and methods
illegal. By this judgement’s
standards, all anti-spam
analysts are a bunch of
hackers, and what they do
every day is criminal.
Enough to scare the living
daylights out of anybody.

In a perfect world,
courts are supposed to keep
in touch with latest
technology. In real life, the
law takes its own sweet
time to update itself, and by
the time they get around to
acknowledging one
technology it already
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Web 2.0 Technologies
Ah, so you’ve mastered the
jargon, but how much can you
spew about the important stuff?
AJAX: This technology allows
Webmasters to reload or
process only specific sections
of the Web page. This means
that content on a page can be
updated without the reloading
the entire page. 
Widget: A piece of code that
allows you to add dynamic
functionality to Web pages. For
example, a status widget on
your blog that lets readers know
when you’re online.
XML: The Extensible Markup
Language allows Webmasters
to define their own elements
when creating a Web page. This
allows for sharing of data
across multiple sources linked
together with the same
element names on the Internet.
FOAF: An acronym for Friend
of a Friend, this is the
structure used by social
networking sites to describe
people’s profiles—name,
country and how you are
related to another person.
Computers use these
structures to find matching
elements when running a
search, like for users staying
in Hyderabad.
XFN: The XHTML Friends
Network is an attribute, which
you can use in a blog or Web
page to define a relationship
when linking to another
person. E.g. <a href=
“www.thinkdigit.com” rel=
“colleague digit”>  
Web APIs: These are
interfaces for letting Web
developers interact with
other Web applications and
allow them to extract and
present data across Web
pages on the Internet.

Usage
I use XFN on all my blog links.
This is picked up by the XML
elements in FOAF profiles of
Social networking sites and
that gives me a better search
ranking on Google. I also use
AJAX to run all the Widgets on
my blog and I hope to learn
the use of Web APIs soon.

Wild Wild Web

n Hacker Safe labelled Web site suffers security breach n MPAA admits that it is using false data to bolster its case about movie piracy
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interesting I find your magazine to be.
But please, try not to make it any
better, or I’m going to fail! 

The January issue was great, especially
the Fast Track. This was perfect for people
like me, who have no IT background.
Thanks to the Fast Track to Tech Jargon, I
can hold conversations about technology
with my engineering friends with
confidence! Thank you so much for that.

Bhushan Thombre
Nagpur

Unfortunately, Bhushan, although we love our
doctors, we think it’s time you switched
professions. Sadly, we’ve already promised
everyone that we’re going to get even better,
even if it means causing one of our beloved
readers to fail his exams! Still, we hope you
pass with flying colours, and wish you best of
luck for your exams.

Team Digit

Open Up That Source
I have been purchasing Digit every month
since January 2000, (when it was called
Chip). The couriers refuse to deliver to my
remote location, which is why I cannot
subscribe, and have to buy it from the
stalls. Wars of The Future (January 2008)
was a really interesting read. I actually
believed that it was a true story written
by a hacker himself, until I noticed the
January 2013 date! Also, the tip about
using the GreaseMonkey script was great,
and I have been looking for such a plug-
in for a long time. 

I also appreciate your drive to increase
awareness against piracy. The best way to
do that is promote Linux and OSS. The
inclusion of a Linux distro in the DVD is a
positive step, but there is still a part you
are overlooking—making the CD and DVD
user friendly to Linux users like me. I
really hate to boot into Windows just to
browse the disks. I do love the disk UI
though, and the cool background music. I
have a suggestion though, why not put an
SWF version of the UI on the discs as well,
so at least us Linux users can browse the
disk and use the UI—even if we cannot
install the software. 

Nirupam Biswas
Ranchi, Jharkhand

We’ve been pondering the same points you’re
making for a while now, and are working on a
solution for our Linux-based readers. Hopefully
we’ll have something concrete rolled out in a few

Inbox

International Flavours?
Don’t you guys entertain mails from
outside India? I have written several times
to you and you haven’t published my
mails. I am from Nepal, and in our friends
circle, I am the only one to read Digit—the
others borrow from me. Thanks to you I
have become the tech geek amongst my
friends. They consult me for any problems
they face, and I consult the magazine. The
archives you gave in December have really
helped in that regard. Please put more
software for Linux on your DVDs. You
guys do a great job.

Nitesh Rijal
Ranchi

Thanks for being a loyal reader, and yes we are
planning to increase the Linux content in the
DVDs, so keep an eye open for that.

Team Digit

A Faster Track
I bought Digit for the first time this
month and I must say that the free Fast
Track booklet was amazing. I have
decided to buy Digit every month from
now on, as long as you continue the
Fast Track series. Is there some way in
which I can buy all the previous Fast
Track books? 

A Nithianandam

Due to the popularity of the Fast Track series,
we’ve received a lot of queries like yours. We’ll
look into finding a way that will allow you to get
your hands on all the Fast Track books in one
shot. Currently, however, we only provide PDF
versions on a regular basis in the DVDs of
special issues. In order to help us understand
exactly how popular this feeling is, we request
all readers who would like to purchase

something like a “Fast Track Compendium” to
write to editor@thinkdigit.com and express
their desire to do so.

Team Digit
A Sad Farewell
I thought that the magazine would
improve with 9.9 media buying it... but it
has not. The magazine contents are not
that good: a review of only flash drives? I
have got used to two sets of shootouts /
reviews in each magazine, and I refuse to
accept only one, even if you have the
Zero1 Awards to print, which is just copy-
pasting from previous reviews anyway.

Personally I feel the Zero1 Awards is a
waste of pages. We buy the magazine the
whole year anyway, so we already know
what’s good from the reviews, and the
contenders in most of the sections of the
Zero1 Awards were the previous tests
runner-ups! Come on, you can do better
than this. The Zero1 Awards should be a 2
or 3 page article—just name the winners
and runner-ups with a little description.

Last but not least, the Fast Track was
hopeless this month. Most of us already
know all this stuff just by reading your
magazine itself!

The first time I bought Digit in June
2001 it had in-depth reviews of firewalls,
antivirus etc... It was much more
technical... Digit is getting boring for me,
and you have stepped down a level on the
technical part to appeal to a broader
audience. The number of pages and
articles keep decreasing, and it’s just 128
pages now! I won’t complain about the
Ads, because I know a magazine needs
them to keep costs down, but don’t
decrease the number of pages and
articles. Personally I buy the magazine for
the articles and not for the stuff you give
on the DVD, I can download those myself!

I am sorry to say, but I am switching
to a different mag. In the end I would
like to thank Digit for converting me into
an open source and free software junkie,
and moving me away from piracy. It was
a nice journey, and I have been loyal to
you for 7 years. My favourite article in
Digit last year was the G80 vs R600. Give
me more articles like that and I will buy
Digit again.

Shashank Shekhar Katyayan
Ranchi

We understand the sentiment you have. However,
we urge our readers to understand the rationale
behind the Zero1 Awards. Let’s look at this issue

of Digit, where we’ve tested cell phones and DVD
writers. Now, in December 2008 or January
2009, when we announce our Zero1 Awards, for
the “Best Product” award for these categories for
2008, is it fair to just give the award to the
current test’s winners? With technology changing
almost overnight, it wouldn’t be fair to either our
readers or the manufacturers of cell phones and
DVD writers now would it? 

We know for a fact that if we awarded a
product that is almost a year old with a Zero1
Award, and there was a more deserving product
already available, passionate readers like you
would not fail to remind us of our errors. Also,
all of our tests involve telling you exactly why
we choose one product over another, so doing
the Zero1 awards in 3 pages is as good as us
telling you, forget the other cell phones, just go
out and buy a network hacked iPhone! Instead
of just telling you what to buy, we justify it with
hard facts and reviews, to help you make a
better judgement for yourself.

Now, getting to the second part of your
mail, it’s always a sad moment for all of us
when we hear readers telling us that they’re
moving on. The majority of our team consists of
people who were Digit readers, and we
understand what you’re saying. Digit became
India’s top selling and most respected
technology magazine because of its innovations
and because it filled a rather large void in our
lives. It can take you from being bored in front
of the PC playing Solitaire and make you so
passionate about technology that you soon find
yourself employed as a technology professional! 

We’re not going to try and kid ourselves,
we can’t please everyone, but we will try our
level best to get you interested in Digit again,
and soon. We’re also very happy to hear that
you’ve gone off piracy, and are glad to have
been the catalyst for that. Thanks for the
loyalty, we truly appreciate it, and hope to soon
see a mail from you like the one that follows... 

Team Digit

You Will Make Me Fail
I am an MBBS student, and just another
fan of Digit, the greatest IT magazine in
India. I have to tell you that Digit is
becoming more and more informative
and interesting every month. When I
bring it home at the beginning of every
month, I can’t stop reading it—sometimes
I read it all through the night! Then the
next day I just read it all over again. Now
you can imagine what happens... 

Like I said, I’m an MBBS student, so
what am I doing reading a tech
magazine, and not  touching a single
text book. I guess you can see how

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@jasubhai.com
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months. We’re glad you like the UI for the
discs, as some of us slaved day and night for
over two months creating it. 

Team Digit

Warriors Of The Future?
I am a regular reader, and I must say
the January issue is wonderful. The
Wars Of The Future article was very
interesting and informative. After
reading this article I have found a
strange desire within myself to become
a hacker and protect Indian servers.
Please tell me, are there any courses
that will help me become a hacker? 

I’d also like to suggest that you
increase the frequency of mobile
content in your magazine—such as
mobile accessories and the latest
software for mobiles and PDAs. 

Raju Kumar
Bihar

We thank you for the positive feedback, and
are glad it appealed to your patriotic nature.
There are no courses that will teach you “hack-
ing”, which is often considered an art form of
sorts. Every “hacker”, ethical or otherwise, is a
programmer and does immense amounts of
research and learning. You need tremendous
networking knowledge and know everything
there is to know about the C (C, C++, etc.) lan-
guages. You can aspire to work for Indian secu-
rity specialist firms and become an “ethical
hacker”, which is basically testing and fixing
the security of Indian servers and sites.

Team Digit

I Love You Digit
Everyone in Team Digit is like the drops
of water that make the sea. I am proud
of your all. I really love the Digit Diary
section. Please keep injecting tech fuel
into me. I was really sad to bid Deepak
Ajwani adieu, and though I have never
met him, I actually cried. I guess I love
Digit that much.

Pankaj Kumar
Rourkela, Orissa

That’s the most emotional letter we’ve
received. Just when we thought we’d heard
it all you come along proclaiming your
undying love. All we can say is, whether our
other readers share your feelings or not, we
love all our readers unconditionally as well!

Team Digit

Whoops!
I was reading through your
article about Pen drives,
and unfortunately find
that the article is very
badly put up. There are a
lot of comments that have
gone haywire at different
points of time. 

To quote some: On Page 68, in the
Slightly Overweight 2GB features, it
was mentioned about the Kingston
Data Traveler Reader, that “It’s not built
very well though.”, but in the table on
page 71, in the comments row, the plus
point says “+ Well built”. Now this is
really a contrast. Either one of the
statements is not true. 

In the 8 GB section, the Buffalo Turbo
with a price of Rs 5,220 has a minus
point of “- Costly”, but at the same time,
the Sandisk Cruzer with a price of
Rs 7,990 is said to be “- None in particular”.
This seems that the additional Rs 2,500
that you pay for Sandisk is justified—
how? Their speeds don’t really show any
difference, and in fact the Sandisk is
slower than the Buffalo. 

I don’t mean to demean what you
have written, but when a person looks
at these tables, or what’s written in a
magazine as revered as Digit, it’s taken
as the words of the Gods of technology.
We rate your magazine very highly, and
errors like this don’t look good. 

It looks like the proof reader was
half-asleep as well: the contact sheet on
page 75 is totally out of order. 

Anyways, the tests are really helpful to
me. I own a 1 GB Transcend V10, which I
bought three years ago. And thankfully,
it’s still working great. I am impressed
with the performance tests of the V10, as
it outperforms the V30 and V60! 

Overall, I would still like to thank
Michael Browne for a great article.

Vincent Thomas
Bangalore

Sorry about the contact sheet, it’s obvious
something went horribly wrong there.

As for your first comment, I think you're
getting mixed up with the Kingston
DataTraveler and the Kingston DataTraveler
Reader 2GB, which is right next to it in the
table. No errors there as far as we can see.

The second error you’ve caught is spot
on, and we've goofed up. It’s readers like you
who keep us on our toes, and we’ll try our
level best to not give you cause for
complaints  in the future.

Team Digit

Letter 
of the
Month

January 2008
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People And Events That Grabbed The Headlines—For Better Or For Worse

...Loves gaming, too.
Well, we don’t in
any way encourage

or condone the viewing of
pornographic material,
whether in print or audio-
visual form, but we must give
you the full picture.

If a real Queen—as in
Queen Elizabeth II—can love
video games, so can a porn
queen (that’s slang for a
pornographic actress who is
popular among those who are
regular consumers of
pornographic material).

A certain Jenna, whose last
name rhymes with “ways,”
loves video games too, as
gaming site GameDaily found
out. (Actually, it seems
everyone loves computer

games these days.) At an expo
of some sort (something like a
CES with pornography
involved, or so we hear) the
organisers asked several
actresses of the adult
persuasion about their take on
video games, and here’s what
Jenna had to say: “Do I like
nerds? I am a nerd. I have
shelves full of books at home
about vampires and
werewolves. And I always have
my PSP with me. Right now I’m
playing Jeanne D’Arc, which is
just awesome. Also, I’ve got a
PS3 and I’m dying for the new
Final Fantasy to come out. See? I
told you I was a total nerd.”

Well, this is just to remind
you they’re regular human
beings too...

Never mind that she taps
people on the shoulder
with a sword and all

after which they become
Knights. Queen Elizabeth II is
very much a modern person,
just like you and I. Some
Britons might like the idea of a
monarch writing letters with a
quill and having her Royal
Butler collect it and despatch it
via a Royal Messenger on the
back of a Right Royal Horse, but
it doesn’t happen. The Queen
uses e-mail; in fact, she’s had an
e-mail account for decades now.

Then in 2001, she got her
first mobile phone, and sources
say she’s been regularly
upgrading to one with the latest
features. In 2005, she bought an
iPod, though we don’t know
what version; and in June of
2007, she added a trendy
BlackBerry to her tech collection.

Now comes even more news
that she’s human, all too

human. Prince William was
gifted a Wii by his girlfriend,
and—gasp!—instead of trying it
out and ordering one for
herself, HM shares it with her
grandson. A source at
Buckingham Palace told The
People—a newspaper—that when
she saw William playing a
game, “she thought the
Nintendo looked tremendous
fun and begged to join in.”

“She played a simple ten-
pin bowling game and by all
accounts was a natural.

“It was hilarious. William
was in fits of laughter. He was
enormously impressed at
having such a cool gran.

“And although she is 81 the
Queen’s hand-eye co-ordination
was as good as somebody half
her age.”

So what’ll she be called
now—“Qwiin Elizabeth”? Sorry
your majesty, but we couldn’t
resist that poke!

That’s called an “Attention-
grabbing headline,” but it
isn’t true. Actually,

Osbourne got a cell phone.
Which is news, because he’s 59,
and we’re wondering what
someone who eats rabbits on
stage would do with a phone
except to throw it at the head of
someone in his deluded
audience. (Officially, he’s
known as a Black Sabbath rocker,
not as a stage-rabbit-eater and
former slaughterhouse
apprentice.) In any case, he got
the phone as a gift, and though
we know the model, we’d
rather not tell you because of
the uncalled-for negative
publicity.

O. O. apparently loves his
new gadget, and his primary
use for it seems to be to call his
daughter Kelly. The news is that
he recently phoned her to say
he’s a fan of her album Sleeping
In The Nothing. (Oh well, this is
Tabloid Tech after all.)

Kelly says about her
natively bloodthirsty father’s
calling that it can be annoying.
(She didn’t call him “natively
bloodthirsty”; we are.)

According to the daughter
of the man who once allegedly
encouraged suicide among the
members of the audience, “He
never had a mobile before and
I f***ing hate it. He calls me all

the time. I was out having
dinner with my friends the
other night and he called me...
I spent half the night talking
to him instead of my friends.”
Is there a lesson here for
near-60-year-olds with new cell
phones?

Ozzy Osbourne Kills
Bear On Stage

A Different Type Of
Queen...

124 DIGIT FEBRUARY 2008

HM Wii
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